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SIM Extended MR Workspace R2.6.3.1

Table 1 Steps to repair/upgrade to an EWS R2.6.3.1
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Steps 1 up to 10 are preparation steps before you go to the
Hospital.
Schedule a meeting with the Customer to discuss Remote Service
1 1o Network (RSN) support via Philips Service Agent.
For background information see:
http://pww.healthcare.philips.com/service/prs/pages/service
Get from:
http://pww.wiskey.ms.philips.com/Wiskey/techNetLicenseFilesSea
rch.do
2. o!| o | VF Licensefile i
and put on USB-stick. (Use MAC-address Hospital LAN NIC as
fingerprint, ask for value on Reference sheets).
MR software key(s)
(Use System Reference Number (SRN) as fingerprint).
Check http://incenter.medical.philips.com/:
e  Service Packs for EWS R2.6.3.1 and R2.6.3.x MR-Host.
3.]0l 0|l ol 0| o0 |* SecurityFixes for EWS R2.6.3.1 and R2.6.3.x MR-Host. )
(Service 2 Products & Solutions » Magnetic Resolution 2>
Magnetic Resonance - MR Download Area = Service
Packs/Security Fixes)
Check http://incenter.medical.philips.com/:
4./]0]0|0O0|0O0]|O _ -
Latest FCO'’s, Newsletters with respect to EWS.
! When Customer purchased new options.
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Check Knova:
http://pww.eureka.aai.ms.philips.com/KanisaSupportCenter/php/h
ome.do
510101010710 e  Product: Magnetic Resonance - -
e Document Types: Factory Tips
Search string: R2.6.3.1
6. o | ol o| o |AskHospital to archive all Patientdata from EWS or ViewForum i )
to PACS.
7.1 0 Print Reference sheets 6 163
Ask the Hospital Network Administrator:
e Toregister the new EWS on all applicable Remote Dicom
nodes.
e For DICOM Local System settings of EWS and register them
on the Reference sheets.
e  For a Computer name and register them on the Reference
sheets.
e For fixed IP-address and networkmask setting
“Hospital Connection” or for availability DHCP-server and
sl o DNS-server(s). Register them on the Reference sheets.

e |P-address(es) Gateway(s) to other subnets and register
them on the Reference sheets.

e If applicable IP-address + portnumber Hospital Proxy Server
to access NetForum and McAfee update site and register
them on the Reference sheets.

e If DNS suffix is in use by the Hospital, register them on the
Reference sheets.

e Is Enhanced MR image storage on other PACS and Viewing
Stations supported?

e Availability Network connection with Hospital Network.
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Administer the EWS for Remote Support (RSN) (step 9) (see step
%10 1 for values) 5.1.13 126
Ask the Hospital Network Administrator:
e  For presence network printer (XP64), connected to EWS. Be
10l O o aware that you need 64 bits driver for this printer.
Obtain driver from printer Manufacturer (e.g. download via } B
Internet).
e Availability Direct-Link Network connection with MR-Host.
Steps 11 up to 75 take place at the Hospital.
11/ o O | Ask for passwords XP-users and Application-users and register i )
them on the Reference sheets.
Ask for passwords XP-users and Application-users when they are
12 O|O0|O . - -
not registered on the Reference sheets.
13 O O | Identify Dell Service Tag & Express Service Code (step 13) 5.2 127
14) O O | Perform Dell Service transfer to country of destination (step 14). 5.3 127
Create a back-up of the VF Configuration: Release
15 O | Start > All Programs -> ViewForum - Maintenance -> Backup Bulletin -
Application Configuration. VF
16 O|l0]|O Export EWS Configuration settings (steps 16, 75). 4.2.1 69
17 o' Export EWS License file (step 17, 75). 422 70
If Patientdata is not saved (see step 6):
Archive Patientdata from EWS or ViewForum on a PACS, } -
or
18 O|lO0O|O|O Back-up Patient Database (step 18). 4.2.8 74

! EWS License file is not saved during R2.5.3 EWS Export Configuration.
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19 o On R2.6.3.x MR-Host: remove ViewForum Workstation from Host- )
Remote DICOM node database. SIM
20 O | Check / upgrade Bios software (step 20) 3.1.1 33
Verify/Register Reference sheets data:
Identify Computername 3.34 |46
Identify networksettings and MAC-address:
Open command window. (Start > Run...~> enter CMD >
21 60/0|0]0 OK) Enter: - -
ipconfig /all
Update/Register on printed Reference sheets. - -
On R2.6.3.x MR-Host: Add EWS as Remote DICOM node via
Direct Link (use EWS-template, see SIM MR-Host R2.6.3.1 and Host- | Host
22, O O | WinMRI DICOM Section 13, both available via SIM -SIM
http://incenter.medical.philips.com/)
See also step 8 for value.
23] O | O | O | O | O | Fulfill Prerequisites OS-Image Installation EWS R2.6.3.1 (step 23) 3.2.1 34
24 O | O | O | O | Perform Image-Installation EWS (step 24) 3.2.2 35
25| O | O | O | O | O |PostImage-Installation steps (step 25) 3.3 38
26 O | O | O | O | O |AdjustDisplay settings (step 26) 3.3.1 38
Iflocal country keyboard isused: 0 0 |
27| O O|l0|O0 Adjust Local country keyboard settings (step 27). 3.3.3 43
28/ O | O | O | O | O |Check System's date and time settings (step 28) 3.35 a7
\fInternet Time Serverisused: 4 b |
29 O|lO0O|O|O Configure Internet Time Server (step 29) 3.3.6 a7
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If VP1000 option:
30 O|l0]|O Update drivers on EWS (step 30) 3.3.7 48
31/ O | O | O| O | O |Change Volume name of C: (step 31) 3.3.8 49
32] O o | ldentify DVD driveletters (step 32) and register them on the 3.3.9 49
Reference sheets.
33 O | O | O | Initialize 2-nd Disk (step 33) 3.3.10 50
34 (0] Initialize partitions on 2-nd Disk (step 34) 3.3.11 52
35l 0| 0| 0| o] o |Check Power settings adapter connected with Hospital Network 3.3.13 55
(step 35)
36 0| 0| 0| o] o |Change IP address adapter connected with Hospital Network 3.3.14 56
(step 36) according the Reference sheets
377 0| O | O | O | O |Check Power settings Direct Link adapter (step 37) 3.3.15 57
38l 0| 0| 0| o| o |Change IP address Direct-link with MR-Host adapter (step 38) 3.3.16 57
according the Reference sheets
39/ 0| O | O| O | O |Disable Spare network link (step 39) 3.3.17 58
40 ol ol ol o |Change Computer name (step 40) according the Reference 3.3.4 46
sheets (see also step 8 or 21 for values).
41] O Change Hostname (Step 41) 5431 | 134
42 O | O | O | O |Perform Installation VF Application Software (step 42) 3.4.1 63
43 O | O | O | O | Perform Installation MR Application Software (step 43) 3.4.2 64
If EWS has reporting functionality: | ]
44,010 |0|0]|O MS WORD Installation (step 44) 3.6 65
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If Security fixes or Service Packs are available (see step 3)
Install:
Security Patch on EWS R2.6.3.1 (4522 170 12841)
45 olololo Service Pack(s) on EWS R2.6.3.1 and MR-Host - -
For troubleshooting, see section 3.3.12 Re-
initialize Backup partition (Step 45) p. 54
If additional languages are used:
46] O O|l0|O0 Perform Installation of Additional Languages (step 46) 3.3.2 41
47 O O | O | O | Perform CBT installation (step 47) 35 65
48 O' | O | Import VF License file (step 48) 4.2.4 71
49 O | Import ViewForum Configuration settings (step 49)
50 O|l0]|O Import EWS Configuration settings (step 50) 4.2.6 73
510l 0| 0o o | o |Stat EWS Configuration (VF) (step 51) 4311 | 76
(see section 4.3.1.2 p. 77 for explanations)
52| O ViewForum configuration settings on EWS (step 52) 4.3.1.3 78
Adjust Image Database Location and Allocation (step 53) size
53y 0| 0O|0O0|0O0|O from 100 GB to 80 GB 43.138| 85
Add R2.6.3.x MR-Host as Remote DICOM node via Direct Link or
54/ O O | Hospital LAN.
See 3.3.18 Configuration Remote DICOM Node(s) (step 55) p. 59. 4.3.2 87
55/ O Configuration Remote DICOM Node(s) (step 55). 4.3.2 87
56/ O | O | O | O | O | Execute EWS Configuration (VF) (step 56) 4.3.3 90
57/ 0| O | O | O | O | Start MR Configuration (step 57). 4.3.4 90

! EWS License file is not saved during R2.5.3 EWS Export Configuration.
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58] O O | MR System Reference Number (step 58) 4.3.4.1 91
59| O O | MR Institution Details (step 59) 4.3.4.2 91
60 O | O | O | O | O | MR Philips Service Agent — PSA (step 60) 4.3.4.3 92
61 O 0" | O | MR Permanent Key (step 61) 4.3.4.4 93
62| O° 0% | 0% | MR Temporary Keys (step 62) 4345 | 93
63] O | O | O | O | O |Disable Windows CD Recording (step 63) 45.2 96
If <MR User> Ul language must be changed: | | |
6l ololololo Language setup <EWS User> (step 64), see also 45.1 94
Installation of Additional Languages (step 46) 3.3.2 41
65/ 0| 0 | 0| O | O |Optional: _ 453 | 97
Set Files and Folders view (step 65).
\frequested: ]
66| O | O | O0O|0O|O Remove password expiry for (XP64) MRUser (step 66) 4.5.4 98
67/ O | O | O | O | O |Setpassword user Remote (XP64) (step 67). 4.5.6 99
68l Ol 0| 0| o | o |Adjust password XP-users and Application Users according the - -
information on the Reference sheets
If application user MRUser is not used:
69 0|0 | O Hide/unhide example application users (step 69). 4.5.7 99
70/ O | O | O | O | O |Adjust Check OpenGL support settings (step 70). 46.1 103
! When Customer has purchased new options.
% Most likely for a clinical site
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Create an Acronis Image (step 75) from Disk-0
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If Auto-push to PACS:
71 O Auto-push to PACS settings (step 71). 4.6.2 104
72/ O | O | O | O | O | Barco Monitor Calibration (step 72). 4.7.2 105
1f R2.6.3.x MR-Host has Service Pack level >3 | | |
Map Offlineshare for Examcard Offline Editor (ECOLE) 4.7.3 108
(step 73).
73o0lolololo Transfer of R2.6.3.4 MR-Host Configuration to EWS 4.7.4 109
R2.6.3.1 (step 73).
Transfer of R2.6.3.x MR-Host Examcard Database to 4.7.5 110
EWS R2.6.3.1 (step 73).
If Patientdatabase is saved on USB-device during step 18:
74 ololo Restore Patient Database (step 74) 4.2.9 75
e Export EWS Configuration settings (steps 16, 75). 42.1 69
e Export EWS License file (step 17, 75) 4.2.2 70
75 010)01010 o 5.7.3 141
]

Save results in a safe location.
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1 INTRODUCTION

1.11 About this Document

This SIM contains technical information about the Extended MR Workspace R2.6.3.1 (EWS) System &
Application Software.

NOTE

This SIM is available on InCenter. Always check InCenter for updates.

The information in this SIM can be used for:
e Configuration of R2.6.3.1 Factory Preinstalled EWS
e R2.6.3.1to R2.6.3.1 Re-installation
e R2.6.3.0/R2.6.1to R2.6.3.1 Retrofit
e R2.5.3t0R2.6.3.1 Upgrade
e ViewForum 5.x/6.x/7.x to R2.6.3.1 Upgrade
e SW re-installation on an upgraded EWS:
e Restore backup Acronis Image.

e Restore OS+3-rd party SW Acronis Image or install OS and 3-rd party SW from scratch - Install
ViewForum SW - Install MR Software.

e Configuring and Customizing Extended MR Workspace R2.6.3.1

The intended reader is the Field Service Engineer.

A brief outline of the sections is given below:

Section 1 Introduction

Describes the new features of this release, compatibility regarding modalities and
peripherals and the software license procedure.

Section 2 Getting Started

Describes the procedure for on-site HW installation of an initial factory delivered
system.

Section 3 Software Installation

Describes the procedure to install Dell T5500/T7400/690/670 Image and Application
SW.

Section 4 Configuration and Customization
Describes the procedure to configure and customize EWS and DICOM nodes.

Section 5 Service and Maintenance
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Describes the Service and Maintenance activities.

Reference Sheets
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1.1.2 IMPORTANT: Filing instructions

For future reference, the Reference Sheet (Section 6) should be completed with the hospitals’ specific
settings, printed and stored in a secure place.

This Reference Sheets contains secure information, like passwords, which gives people full control over the
system. That is why it is of great importance that this document is stored in a secure place e.g. closet that
can be locked or even a safe.

1.1.3 Abbreviations

ASW Application Software

CT Computed Tomography

DCI Digital Cardio Imaging

DICOM Digital Imaging and Communications in Medicine

DOR Digital Optical Recordable

DSl Digital Spot Imaging

DSL Direct SCSI Link

EV EasyVision

EV-Classic EasyVision Classic: Release <= 5.X

EVIM EasyVision Information Model, i.e. the internal model for EasyVision R5.1
EVIIM EasyVision Imaging Information Model, i.e. the internal model for ViewForum
EWS Extended MR Workspace R2.6.3.1

GCOM Gyroscan Communications (protocol), also called "Gyrocom"
HCU HardCopy Unit (Printer)

HSDII High Speed DICOM Image Interface

IP Internet Protocol

IVE Integrated Viewing Environment

MIT Medical IT

MIP Medical Imaging Platform

MR Magnetic Resonance

OD(R) Optical Disk (Recordable)

(O] Operating System

PACS Picture Archiving and Communication System

PMSNet Philips Medical Systems Network protocol

PPP Point-to-Point Protocol

RIS Radiology Information System

SCP Service Class Provider

SCU Service Class User

SOP Service Object Pair

SSD Sales & Service District

TCP/IP Transmission Control Protocol / Internet Protocol

VF ViewForum

VISUB Viewing Sub-system (for Integris V3000 or H3000 systems)
WMRM Write Many Read Many

WW/WL Window Width / Window Level
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Section 1

1.2

RELEASE INFORMATION

CAUTION

The EWS provides temporary storage for images. The system does not provide backup mechanisms and will
periodically clean up its database by removing images. Therefore the EWS should not be used as a system

to back up patient data. For this purpose a PACS should be used.

e Examcard offline editor is made compatible with R2.6.3 MR-configuration. R2.6.1. examcards can be

read

e Animproved MR viewing environment, identical to R2.6.3. MR-console.

e Russian MR viewing environment.

1.2.1

The FPR’s that are solved in this release

MR ID

Headline

MR00067893

FPR Save avi on breast dynamic images doesn't work

MR00067896

FPR Reference line in review folder

MR00069781

FPR in T1, T2, bold analysis, morphologic sequences

MR00070251

FPR MR BRIGHT REALISTIC 2" LOOKS VERY DIFFERENT FROM

MR00070252

FPR CAN ONLY CHANGE CONTRAST (WINDOWING LEVEL) ON

MR00071843

FPR Merge View shows up, but not buyed by the

MR00072095

FPR Zoom not given over even when apply to all is

MR00073810

FPR STIR Sequenz not be shown correct in Q- Flow

MR00074282

FPR MPR with Multistack sequence failed

MR00075422

FPR LACK OF BUTTON

MR00075426

FPR | can't turn curve MPR

MR00075428

FPR Export PNG into removable disk (G

MR00075493

FPR Status "completed "not correct in Background

MR00075523

FPR English - German translation wrong

MR00075554

FPR Norton Ghost Service Partition required or DB

MR00076074

FPR Save as "original"

MR00076412

FPR Shutdown of the EWS during Spectro using

MR00076943

FPR no procedure to clear passwords from users

MR00076998

FPR Could not start server processes

MR00077192

FPR DISTORSION OF VRT IN PRINTING

MR00077394

FPR Boston Childrens, VR of multi dynamic dataset

MRO00077395

FPR Boston Childrens, Zoom and rotation in images

MRO00077396

FPR Boston Childrens, update of Worklist is not

MR00077874

FPR Cannot import from shared data folder (e.g. USB)

MR00078393

MIP51:FPR DICOM Image transfer from CT Brilliance 40 to

MR00078702

FPR Missing Institution Name

MR00079050

FPR Strange windo level&wjdth

MR00079924

FPR STIR Sequences aren't shown correctly in Quantitative Analysis

MR00080264

FPR Patient Database corrupted

MR00080805

FPR Problem of EWS: Database cleanup

MR00081374

FPR Series order of capture images are different since upgrading from VF
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Section 1 Introduction SIM EWS R2.6.3.1

MRO00081387 | FPR EWS button greyed out

MR00081389 | FPR DICOM Modality tag is filled with Other on EWS

MRO00082277 | FPR CD-/DVD-Burning Problems under ASW Error Mssg "There's no media inside”
MRO00083265 | FPR EVServer Memory Leakage Problem still exists

MR00083370 | FPR Study Instance UID was changed to the oledest data's

1.3 COMPATIBILITY AND INTEROPERABILITY

1.3.1 DICOM Conformance Statement

The DICOM Conformance Statement can be found at:

http://www.medical.philips.com/main/company/connectivity/mri/ (MR acquisition modalities)

1.3.2 Interoperability with Extended MR Workspace R2.6.3.1

1321 DICOM Connectivity with different Philips MR Systems.

Next figure shows the DICOM connectivity between different Philips MR scanners and Extended MR
Workspace R2.6.3.1.
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4 gcom P EasyVision52 &= DICOMEVIIM) = MR +SC
MR R7-9 | ———— » MR +SC+PS
DICOM(PIIM v1.09) EWS R2.6.3
< al MR +SC + PS + Private MR Spectrum +
DICOM(PIIM v2.0) | Private MR Series Data
MR R10
MR R11
Achieva R1.2 ¢ DICOM(PIIM v3.x) » MR +SC + PS + Private MR Spectrum +
Panorama 1.0 Private MR Series Data
MR R12.1.x MR + PS + SC + Enhanced MR Image +
Achieva R2.1.x D DICOM(PIIM v4.2) » RAW Data (Series Data) + MR Spectroscopy +
Private MR Spectrum + Private MR Series Data
Achieva R2.5.x MR + PS + SC + Enhanced MR Image +
Achieva R2.6.x <4 D|COM(PIIM v4.2) »| RAW Data (Series Data or Examcards) +
MR Spectroscopy + Private MR Spectrum +
MR R12.6.x Private MR Series Data + Private MR Examcard
HP(Q)
Vista 1.0T
Edge 1.5T
Asset 05T — Z“:e D_'Cto"" »| MRESC _
Polaris 1.0T otprivate (Basic Viewing,No Advanced Image processing)
Eclipse 1.5T
Infinion 1.5T
Outlook
Openview — Pure DICOM »| MR +SC (Basic Viewing,No Advanced Image
Proview Not private processing)
Panorama 0.23/0.6
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SIM EWS R2.6.3.1

1322

DICOM connectivity with different modalities

System release

DICOM/DICOM
(direct, poor info
model)

DICOM/EVIM
(direct)

DICOM/PIIM
(direct, rich
info model)

DICOM/EVIM
(via EV-
classic)

MR2.6.x \/
Achieva/Panorama
Achieva

MR2.5.x Intera/ \
Achieva/Panorama
MR R12.1.x Intera/
Achieva N
MR2.1.x Intera/
Achieva/Panorama
MR R11.1.x Intera/
Achieva N
R1.x Intera/
Achieva/Panorama
MR R10

MR R9

MR R8

MR R7

DI 1.0 IPANEMA
DIR1

DSI Pro 2.0 \
DSI Pro 1.0 \
DSI R5.2
DSIR5.1

DSI R4.4
Brilliance CT 40
slice

Brilliance
Workspace
MX8000-IDT
CT-Vision

MX 8000

MX View
HMC-AV/SR
M/EG
PQ-series

DCI

ViSUB

ViSUB + VF N
interface
3DRA \
IBIS

Allura Xper FD10
Allura Xper FD10/10
Allura Xper FD20
Allura Xper FD20/10
ThoraVision N
Digital Diagnost \
EV-RAD \
PCR Eleva N

Pl P P P P pa
<]

<2< (=2 < {<2] <|{ 2 < [ <{<]

<2< < [<2]

El P P P P
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System release DICOM/DICOM DICOM/EVIM DICOM/PIIM DICOM/EVIM
(direct, poor info (direct) (direct, rich (via EV-
model) info model) classic)

HDI 3500

HDI 4000

HDI 5000

HDI 5000 CV

HDI 5000 Sono CT

iU22

Envisor

SONOS

HD 3

HD 11

Odyssey

Pegasus

Pl P P P P P P P P P P P

JETStream

*

MDC

<=2 |
*

iSite

Xcelera \*

Easy Access \*

Table 2 Overview of the modalities supported via a network connection (via a direct connection or via

EV-classic).

* Can contain images from all scanners, also from unknown scanners.

Notes:

Extended MR Workspace R2.6.3.1 supports MR R9/8/7 via a direct DICOM connection with the PIIM
information model; hence a connection via an EV-classic is not needed. However, these systems have
been used in combination with an EV-classic, and this EV-classic may have written MR images with
ACR-NEMA attributes to a PACS. Hence Extended MR Workspace R2.6.3.1 shall also support these
modalities via EV-classic (see the shaded rows).

DSI Pro R1.0/2.0 and CT-Vision contain an embedded EV-classic. Although these systems may have
been used in combination with another (stand-alone) EV-classic, it is not useful to include this in the
table since for Extended MR Workspace R2.6.3.1 this does not make a difference.

Any DICOM modality may have been used in combination with an EV-classic. However, these
combinations are not included in the table because they do not require special measures (Extended MR
Workspace R2.6.3.1 uses the standard DICOM attributes of these modalities).

The transport mechanism between EV-classic and Extended MR Workspace R2.6.3.1 will normally be a
DICOM network connection but may also be a DICOM CD.

In addition to a network connection to the modality, the modality may also have written data to medium. The
system shall be able to read from the media as listed in Table “Overview of systems supported via
media” (Table 3). Note that the EDI R1 contains an embedded ViewForum, and therefore offers DICOM CD.
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system release medium type information model

EV-classic DICOM CD evim

CT-Vision DICOM CD evim

MX View R4 DICOM CD dicom

DSl Pro 1.0/2.0 DICOM CD evim (processed
images)

EDI R1 DICOM CD eviim

EV-RAD DICOM CD dicom (or evim?)

ViewForum DICOM CD eviim

MR 10.x DICOM DVD PIIM

MR R11.x / R1.x DICOM DVD PIIM

MR R12.1.x / R2.1.X DICOM DVD PIIM

MR R2.5.x DICOM DVD PIIM

MR R2.6.x DICOM DVD PIIM

Table 3 Overview of systems supported via media.

1.3.3

Hardcopy Compatibility

Extended MR Workspace R2.6.3.1 supports printing via DICOM protocol.

The following DICOM printers are supported:

Printer

3M-HQ969
Agfa-DryStar2000
Agfa-DryStar3000
Agfa-DryStar3000logo
Agfa-DryStar4500
Agfa-DryStar4500-Mammo
Agfa-DryStar5300
Agfa-DryStar5500
Agfa-LR3300
Agfa-LR5200
Codonics-Horizon
Codonics-NP1660MD
Fuji-DryPix-DPL
Fuji-DryPix1000
Fuji-DryPix3000
Fuji-DryPix4000
Fuji-DryPix5000
Fuji-DryPix7000

Printer
Kodak-DryView-8100
Kodak-DryView-8150
Kodak-DryView-8200
Kodak-DryView-8300-Portrait
Kodak-DryView-8500
Kodak-DryView-8610
Kodak-DryView-8700
Kodak-DryView-8900-HiRes
Kodak-DryView-8900-STD
Kodak-KELI-160
Kodak-KELP1120
Kodak-KELP2180
Kodak-MLP-190
Konica-DryPro-722-752
Konica-DryPro-771
Konica-DryPro-793
Sony-FilmStation-UP-DF500
Sterling-S13400

SIM EWS R2.6.3.1

The latest validated property files of supported printers can be found on via Interoperability Knowledge Base:

http://iotool.ms.philips.com/
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Select

Select

Select

Product Overview - Printing:

Product Overview = Site Info Seat

all
|Healthcare IT
Imaging

Ultrasound

ions (2

=Ite

Printertype - All Releases:

\.fﬂ Printing
\.rd AGFA
\‘;1 CODONICS
\.;1 FLII
\.fd KODAK
\.; ZMI 1000

5 Dryview

“E all Releases

Tab “Product Info” = TestReport(s) > Test report:

R Product Info Problems & Solutions Tips & Tricks Success Stories Site Ini

Dry¥iew 5800 All Releases

Link to ¥endors Website : KODAK
More links :

This Product has been @ Tested 0 Not Tested
Test Date : 03/05/2008
See Also :

I print PTP
Additional Printer Information |
Upload,
LUT TestReport(s)
Ptp ‘ Test report

Download TestReport

134

CD/DVD Compatibility

A standard CD/DVD R/W drive will be delivered with the DELL system.

The DVD writer in the EWS can write on different media (DVD, CD, writable, rewritable). However, Philips
MR only supports Philips DVD +RW media.

1.3.5 File Export

Extended MR Workspace R2.6.3.1 supports export of images to hard disk or CD/DVD-Recordable in PNG
format.
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WARNING

File export is intended for presentation purposes only. These images are not intended for diagnostic viewing
or further processing. Image quality may be limited due to reductions in image size or pixel range, or due to
the use of compression techniques.

The lossless transfer syntax is not supported in Extended MR Workspace R2.6.3.1. (Internet access can be
done via EasyWeb, which does support lossy compression).

1.3.6 Movie export

Extended MR Workspace R2.6.3.1 supports the export of movies to hard disk, removable media and
network locations where Windows has read/write access. A movie file can be saved as an AVI or WMV file.
With movie export it is possible to save series from one View to an AVI or WMV format.
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Section 2 Getting Started
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2 GETTING STARTED

When following the workflow, you will be guided through all steps in chronological order from unpacking until
handing over to the customer.

This manual assumes the good working of the hardware (the system was factory assembled and tested).
Contact your local DELL service centre in case hardware support is needed.

NOTE
If problems are encountered during installation you may refer to the Extended MR Workspace R2.6.3.1

Knowledge Database. This Database also contains a list of known issues in the product. The Extended MR
Workspace R2.6.3.1 Knowledge Database is available the intranet site.

Please write down the results of your actions for further reference on the Reference sheet supplied in
Section 6 of this manual.

For an initial Extended MR Workspace R2.6.3.1, delivered from the factory, this is the section to start with. If
you are not installing an initial factory system, proceed with 2.7: How to Proceed.

2.1 INSTALLATION TIME

The total installation of a stand-alone Extended MR Workspace R2.6.3.1 system can be done within 4 hours.
The installation of a small network (more systems close to each other) can be completed within 8 hours.

2.2 WHAT IS DELIVERED
Base System Dell PC Workstation

Keyboard + mouse
DVD-Drive & DVD-Recordable drive
23 inch LCD colour monitor

Floppy drive
Power Distribution Unit
Cabling
Application Software On DVD'’s
Security Patches On DVD
License files On CD
System Image On DVD
Dell reinstallation software On CD
Dell drivers and utilities On CD
Acronis Backup / Restore SW
Nero CD/DVD burning SW
Service documentation Via InCenter
Instructions for Use On DVD
Quick Reference card & guide On paper
Optional Local Country keyboard
MS Word When reporting functionality is
ordered
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2.3 QUICK ROOM CHECK

Before starting an Extended MR Workspace R2.6.3.1 installation verify items below (if relevant):
e Physical location for Extended MR Workspace R2.6.3.1 o.k. (hospital furniture)

e Power outlets present

e Network connection(s) present
- Hospital Network connection
- Direct Link cable present from MR-Host.

e Distance Extended MR Workspace R2.6.3.1 to network connection and power outlets within limits
e Network configuration parameters of all systems to be configured known

e Printer(s) to be connected known / present including cabling (64bit printer driver/support)

e Light conditions o.k.

e Air condition needed / present

e UPS needed / present

e RSN Router

Remote Service Network (RSN) connection is needed to use the Extended MR Workspace R2.6.3.1 Remote
Service Agent. For more information on RSN, see http://incenter.medical.philips.com/ - RSN (under Tools
and Recourses).

2.4 TRANSPORTATION

There are NO transport locks for disk-, CD-REC, DVD-REC, DVD and CD-ROM drive(s).

2.5 UNPACKING

Unpack the DELL computer, monitor(s), cables, etc.
Don't overlook small stuff like UTP terminators, etc.!

2.6 HARDWARE INSTALLATION

The factory installs the Extended MR Workspace R2.6.3.1 software, burning tooling, remote service tooling,
calibration tooling and Acronis True Image. For re-installation this software is supplied with the system

NOTE

Please take care that before connecting external cables and switching power-on all internal Dell PC
connectors and PCBs are properly seated!

CAUTION

To avoid dust problems place computers and peripheral cabinets on a table or trolley, but not on the floor!
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Monitor and Video Cables
Connect the video cable(s) from the monitor(s) to the DELL Workstation video connector(s).

Keyboard and Mouse Cabling
Connect the keyboard cable to the keyboard connector. In case of a USB connector, connect the cable to
the USB connector at the back of the system.

NOTE

In case a Local country keyboard is delivered with the system, the local keyboard must be installed!

NOTE

Do not throw away the standard keyboard, because this must be used to do an initial installation in the
future. During the initial installation the local country keyboard layout is not recognized, which results in a
mismatch between the keys and the actual characters on screen!

Connect the mouse cable to the PC mouse connector. In case of a USB connector, connect the cable to the
USB connector at the back of the system.

Network Connections
Per Ethernet connection on Extended MR Workspace R2.6.3.1 a 5m Twisted Pair cable is delivered.

Connect the twisted pair cable between the on-board Ethernet controller and the twisted pair hub or wall
connection of the 'Modality network'.
With the MR-Host a 25 meter Direct-Link network cable is delivered.

Printers
Desktop Printer

If a desktop printer is available, connect the desktop printer to the parallel or USB port of the PC System.
Configure this printer as the windows default printer according to the manufacturers’ guidelines.

Power Cables
Connect the monitor(s), the printer(s) and the Dell computer to the Power Distribution Unit with the delivered
power cables.

Main Voltage Selection
Verify if mains voltage must be set. If yes, set it to the correct voltage!

Power on

Switch on the Power Distribution Unit.
Switch on all devices:

Monitor(s)

Printer(s)

DELL computer

The system will boot.

Wait until the windows login screen appears.
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Section 2

2.7 How TO PROCEED

Factory pre-installed EWS system

UPGRADE VIEWFORUM TO EWS R2.6.3.1 or
UPGRADE EWS R2.5.3 TO EWS R2.6.3.1 or
Re-install EWS Software (in case of release synchronisation with
MR-Host or absence of system backup)

CONFIGURING AND CUSTOMIZING EWS

Continue with:

Configuration and Customization

Service and Maintenance

Continue with:

SW Installation

Configuration and Customization

Service and Maintenance

Continue with:

Configuration and Customization

SERVICE AND MAINTENANCE

Continue with:

Service and Maintenance
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Section 3 SW Installation
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SIM EWS R2.6.3.1 SW Installation Section 3

3 SW INSTALLATION

This section contains the procedure for:

Check/upgrade BIOS software.

. SW-installation on a ViewForum R5.x/6.x to upgrade to an EWS.

. SW-installation on an EWS, to synchronise with SW-Level MR-Host.
Re-installation of EWS R2.6.3.1 Software.

PN PRE

3.1 B10S VERSION AND SETTINGS

3.1.1 Check / upgrade Bios software (step 20)

The minimal BIOS software version required

for Dell T7400 is version A04

for Dell 690 this is version A06.

for Dell 670 this is version A07.

The Dell T5500 has the correct BIOS version installed.

Check the correct version of the BIOS software as follows:

Restart your system:
Select: Start 2 Shut Down =2 Restart

During start-up:
Press: F2 key to enter the BIOS

Check the BIOS version. If the correct version of the BIOS software is installed, continue to check/set the
BIOS settings as described in 3.1.2.

Upgrade the BIOS by double clicking the .exe file.
Follow the instructions on screen.

Return to step 20

3.1.2 Check/set Bios settings

When hardware has changed e.g. system battery / motherboard has been replaced, check/change the BIOS
settings.
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Section 3 SW Installation SIM EWS R2.6.3.1

Make sure the following BIOS settings are set:

BIOS Setting Dell T5500 Value

General -> Boot Sequence [OOnboard or USB Floppy Drive

M #8200 IDO0 LUNO Fujitsu MBA3147RC
MOnboard or USB CD-ROM drive
OOnboard Network Controller

0 #8200 IDO1 LUNO Fujitsu MBA3300RC
[0 USB Device

- Onboard or USB CD-ROM Drive
- 00 IDO0 LUNO Fujitsu MBA3147R

Drives -> SATA Operation RAID Autodetect/AHCI

Table 4 Dell T5500

BIOS Setting Dell 690 /T7400 Value

System -> Boot Sequence Onboard or USB CD-ROM drive
Onboard Hard Drive 1

Onboard Hard Drive 2

Onboard or USB Floppy Drive

Drives -> SAS Controller On

Drives -> SATA Operation ATA

Table 5 Dell T7400/690

BIOS Setting Dell 670 Value

System -> Boot Sequence Onboard or USB CD-ROM drive
Onboard Hard Drive IDO
Onboard Hard Drive ID1
Onboard or USB Floppy Drive

Drives -> SAS Controller On

Drives -> SATA Operation RAID Off

Table 6 Dell 670

3.2 IMAGE DELL T5500/T7400/690/670 INSTALLATION

3.2.1 Prerequisites OS-Image Installation EWS R2.6.3.1 (step 23)
e Hospital connection Ethernet adapter is connected.
e CD: Acronis boot CD (4522 170 12971)

e DVD: EWS Installation Image Dell T7400 (4522 170 12961) or
DVD: EWS Installation Image Dell 690 (4522 170 12961) or
DVD: EWS Installation Image Dell 670 (4522 170 12941) or
DVD: System Image as delivered

e DVD: EWS R2.6.3.1 Application Software (VF7.2V5L1). 4522 170 12821
e DVD: EWS R2.6.3.1 Application Software (MR) 4522 170 12831

e CD:EWSR2.6.3.1 CBT (4522 170 12881)

e DVD: EWS R2.6.3.1 Security Patches 4522 170 12841
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SIM EWS R2.6.3.1 SW Installation Section 3

e CD: Drivers Dell 670 Dell 690 Dell T7400 (4522 170 12931)

e CD: WIN XP X64 Resource CD (4522 170 10701)

e DVD: EWS R2.6.3.1 User Documentation (4522 170 12861)

e DVD: EWS Clinical Demo Cases (4522 170 12871)

e CD: MS Word Edition 2007 (optionally, only when reporting functionality was purchased)

Return to step 23
3.2.2 Image-Installation EWS (step 24)

WARNING

This procedure will restore the C:\System partition.
Any changes made on this partition since the latest Acronis System Image was made will be LOST.

Make sure all applications are closed.

Insert: into DVD-ROM:

Acronis Boot CD (Delivered with system) 4522 170 12971
into DVD-writer:
EWS Installation Image Dell T7400 (4522 170 12961) or
EWS Installation Image Dell 690 (4522 170 12941) or
EWS Installation Image Dell 670 (4522 170 12941) or
System Image as delivered.
Click Start > Shutdown - Restart

Acronis True Image Server OEM Edition
Select: Recovery - Next >:

% Acronks Trise Image Server OEM Edition

Pick o Category
B Backg Ahives
G Haed Dk Managunare
2] Tk schediegy
Tools
B fotivabn Acronn Startin
Rceremry Maciages
8. Creste Boctable flas Meda
] showie

@ How o back up our dats

O rewtoreserevowdstn [ B

@ Hom ho schedus bachug

o Fgilurn anel Validaln Rackug 5 Activabe Acronis Stantugp
= hathives B Recovery Manager
- Manage Hard Disks Fr Hanoge System Restore

7 Create Bootabls Rescoe
r pedin

Raady

Backup Archive Selection Panel
Expand: both CD drives, to see where the system image is located.
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Section 3 SW Installation

SIM EWS R2.6.3.1

Select: File EWS2009-T5500.tib, EWS2009-T7400.tib, EWS2009-690.tib, or EWS2009-670.tib >

Next >

Restore Data Wizard

Backup Archive Selection

backup archive
& peskon ) EWSZ2009-T7400.tib
FTP Connections
’i* This is the image backup archive.
®I) My Documents EW/S2009-T7400
= :’2 Iy Computer
@ 3 Floppy (A0 Creation Date: 06{04/2009
B S system (C) Date: Monday, April 06, 2009 11:13:41 AM

Sizer 3,117 GB

[ % BOOTUSB2048 (G
] I shared Documents T I

@‘:} MMy Network Places ‘{‘:ﬁ 1 Fvstem i

136.7 Gp | |136.6 GB NTFS

File name: |E:\EWS2009-T7400.tb v
~|

Files of bype: |Backup Archives (*.tib)

@ﬂalp [ < Back q[ Mexk > D Cancel ]

Figure 3-1 Example Backup Archive Selection panel

Restoration Type Selection Panel:
Select: Restore disks or partitions
Click: Next

Partitions or Disk to Restore Panel:
Check: NTFS (C:) or System (C:)
WARNING

Do NOT select MBR and Track O

Click: Next >

Restore Data Wizard

Partition or Disk to Restore

3 partition or a hard di

Please select a partition or & whole hard disk drive to restare.

o W
Partition Flags Caparity Free Space Type
Disk 1
Dk system () P, ek, 136.6 56 129,58 GB NTFS
] =eMER and TrackD MEBR. and Track 0

q)ﬂ\?'D [ <§ack( ” ﬂextw Cancel ]

Figure 3-2 Partition or Disk to Restore panel
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SIM EWS R2.6.3.1 SW Installation Section 3

Restored Partition Resizing Panel:
Select: No, | do not want to resize partitions
NOTE

System (C:) is only present when a partition is restored. With a clean (new) system disk there
will only be
Unallocated Space. Use this Unallocated Space.

NOTE

If System (C:) is grayed out, it means that the partition needs to be resized. To do so, click
Back. This will return to the Restored Partitions Resizing panel. Select Yes, | want to resize
partitions. Then select Next. At this point, System (C:) can be selected.

Click: Next >

Restored Partition Location Panel:
Select: System (C:)
Click: Next >

Restore Data Wizard

Restored Partition Location

t & karget partition of unalocated space for the ¢

Please select a karget partition or unallocated space ta restore the partition image. The partitions
already restored are checked off and disabled. The locations without enough space For restoring the

image are disabled as well,
Y

Parkition Flags Capacity Free Space Type
Disk 1

Pri,&ck,

Disk 2
EDATA (D) Pri 136.7 GB 127.4 GB MTFS
Disk 3
=
Ql Help [ < Eat( ” Mext m Cancel ]

Figure 3-3 Restored Partition Location panel

Restored Partition Type Panel:
Select: Active
Click: Next >

Restored Partition Size Panel:
Click: Next >

Next Selection Panel:
Select: No, | do not
Click: Next >

Choose Restore Options Panel:
Check: Validate backup archive before restoration
Click Next >

Overview Panel:
Click Proceed
The Acronis System Image will be restored, which will take +/-15 minutes
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Section 3 SW Installation SIM EWS R2.6.3.1

Information Panel (“the data was successfully restored”):
Click OK

Remove: CD containing the Acronis boot CD
Remove: DVD containing the Acronis System Image

Acronis True Image Server OEM Edition Panel:
Click Operations 2> Exit
System will restart automatically

NOTE
When the system stops responding and does NOT restart automatically:

Press Power button until EWS is powered off, wait 10 seconds and press Power button to
switch the system on again

Return to step 24

3.3 POST IMAGE-INSTALLATION STEPS (STEP 25)

Caution
when system is up and running wait a couple of minutes for HW identification:
(mouse and keyboard may not respond!)

Login as: Administrator (password is password or Password1*)

3.3.1 Adjust Display settings (step 26)

If the EWS system has two monitors, then

; The NVIDEA Display Setup Wizard pops up

LR |

Click: Cancel
NVIDIA Display Setup Wizard ﬁ‘

- Welcome to the NVIDIA Display
\ S -
= Setup Wizard
The wizard will help you enable and customize pour
rulti-display settings.

To continue, click Newt.

Lia

1 [ Concel

Figure 3-4 NVIDIA Display Setup Wizard panel

If the EWS system has one monitor, then
Right-click On Desktop

! Factory Image installed EWS
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SIM EWS R2.6.3.1 SW Installation Section 3

Select: Properties

arrange Icaons By k
Refresh

Paske
Paste Shaorkcouk
Unda Copey Chrl+Z

Save As Scheme. ..
Graphics Options
Display Modes r

Mew 2

Propetties

Select Settings tab
Adjust:  Screen Resolution = 1280 by 1024 pixels or 1920 by 1200 pixels
Click: Apply = Yes
T < |

}) m-‘-_hmhﬂlmk-

Remteng 11 smnle. *
Click OK

« Return to step 26

If the EWS system has two monitors and the application must be extended to Monitor 2:

Right-click On NVIDIA icon in notification area (see section 3.3.1.1 Enable nVidia icon in notification
area p. 41, when icon is missing).
Select: nView Display Settings = Dualview = Monitor 1 + Monitor 2

A n¥iew Desktop Manager nYiew Desktop Manager 4

I Screen Resolution
| Screen Refresh Rate
I Color Qua

n¥iew Display Settings Dualview & Phlllps 240BW + Philips 2308
Vertical Span * Performance & Quality Settings Vertical Span * =

Horizontal Spart |2 Rotation Settings Horizontal Spar®
Clone * 1@ Color Correction Clone D
¥ Single display * v Single display *

j Screen Resolution
Screen Refresh Rate

= Color Correction

“* NVIDIA Control Panel

About NVIDIA settings...
Exit

I NVIDIA Control Panel

About NVIDIA settings...
Exit

Click: Yes:
T |

}) m-‘-_hmhﬂlmk-

Nevurun 1 it *

Right-click On NVIDIA icon in notification area
Select: Display 1 = Screen Resolut|on —) 1920 by 1200 pixels or 1280 by 1024 pixels

1920 by 1200 pixels I
30 by 1050 ‘55|0nal x64 H

© Screen Resolution
—| Screen Refresh Rate 4
5 Color Quality Le
4 nView Display Settings ~~ *

W Color Qllﬂlf * 1600 by 1200 pixels
“d nVlew Display Settings L 1600 by 900 pixels
1"} Performance & Quality Senir@ 1440 by 900 pixels
i1 Rotation Settings 1280 by 960 pixels
2 Color Correction 1280 by 720 pixels
1152 by 864 pixels
1024 by 768 pixels
800 by 600 pixels

LY

* NVIDIA Control Panel

About NVIDIA settings...
Exit
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Section 3 SW Installation SIM EWS R2.6.3.1

2 Click: Yes:
J [cosion Doy Sctigs 1}
2 0
3 BN ) = =
= Right-click On NVIDIA icon in notification area
4 Select: Display 2 = Screen Resolution = 1920 by 1200 pixels or 1280 by 1024 pixels
2 1 Color Qualiy 1600 by 900 pixels
5 “d nView Display Settings * #1280 by 1024 pixels
5 W1l performance & Quality Settind: 1280 by 960 pixels
> ‘2] Rotation Settings L2 1024 by 768 pixels
? 2 Color Correction 800 by 600 pixels CTITRANITIENT]
2 Quadro FX Display 1- Digital ) *
“ NVIDIA Centrol Panel
z About NVIDIA settings...
: Exit

Click: Yes:

[cosion Doy Sctigs 1}

bt b g D e 1 e

e e N ) ==

Return to step 26

If the EWS system has two monitors and the second monitor must be an exact copy of the first

monitor:

Right-click On NVIDIA icon in notification area (see section 3.3.1.1 Enable nVidia icon in notification

Select:

Click:

Right-click
Select:

area p. 41, when icon is missing)

nView Display Settings = Clone = Monitor 1 + Monitor 2

4 nView Desktop Manager

il Screen Resolution
_| Screen Refresh Rate

Exit

About NVIDIA settings...

Yes:
Cortim Dishan Setigs 3]

bt b g D e 1 e

e N ) ==

On NVIDIA icon in notification area
Screen Resolution = 1280 by 1024 pixels or 1920 by 1200 pixels

B nView Desklop Manager 4
e

7y els | | ETREtTE
B00 by 600 pixels 1™ Color Quality
“H nView Display Settings

U] perfarmance & Quality Settings
4] Rotation Settings

= Color Correction

“ NVIDIA Control Panel

About NVIDIA settings...
Exit

- w owor vl

—
‘(v 1970 by 1200 pixels | 1 Screen Resolution

1600 by 1200 pixels
1600 by 900 pixels
1280 by 1024 pixels
1280 by 960 pixels

1024 by 768 pixels
800 by 600 pixels

| Screen Refresh Rate

I Color Quality
Performance & Quality Settings
Rotation Settings

= Color Correction

' NVIDIA Control Panel

About NVIDIA settings...
Exit
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SIM EWS R2.6.3.1 SW Installation Section 3

Click: Yes:

Return to step 26

3.3.1.1 Enable nVidia icon in notification area

Right-click On desktop
Select “NVIDIA Control Panel” =2 “View”
Enable “Show notification Tray lcon”

Arrange Icons By | || NYIDIA Control Panel

Refresh File Edit @
Paste < Standard
Paste Shortcut Select a Task.,, * Advanced
B30 Settings  Custom
wJANENEEI el ~ EET pefine Custom View...
i -Manage
New > - :
—— D —
Properties

Close NVIDIA Control Panel

3.3.2 Installation of Additional Languages (step 46)

Login as: Administrator
Please ignore:

evLaunch.exe - Error message n

‘You are not autharized ko run this pragram, please contact your System Administrator,

Insert into DVD-ROM drive:
DVD: EWS R2.6.3.1 Application Software (MR) (4522 170 12831)
If Chinese and/or Japanese will be selected:
Insert CD: WIN XP X64 Resource CD (4522 170 10701) into 2-nd drive
Click Exit:
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Section 3 SW Installation SIM EWS R2.6.3.1

B Welcome to Microsoft Win

elcome to Microsoft(R) Windo

ﬁ What do you want to do?
[3] Install Windows XP
F-T| View setup Instructions and release notes
Fﬂ Install pptional Windows components
[3] Perform additional tasks

[3] Check system compatibility

Start Explorer
Browse to \IMAGES\MUI folder on DVD
Double-Click MUINSTALLER_WIN_CS Application:

B MUI [ [O]x
File Edit View Favorites Tools Help ‘ qr
@ Back w > | p Search ‘EE. Folders | v
Addres€() GUMAGESMUT D | B e
Folders X Name = Size | Type Date b+
Z|ovozHosT IKB WBScript Seript File 7iz0
B 5 IMAGES ==Y 13KB Test Document 41312
[0 DXMANAGED | [yt 27KB Setup Information 41302
15) FLASHPLAYER i BKB Setup Information 41312
1= INFOZIP d 52 KB Application BI23/2
5 TSHARP t —TS CAE CONFIG 1KB COMFIG Fils 1013
1) MR_BWS @ MUISETUP 129KE Application 41312
&= MUl .| EIRELNOTES S9KE HTML Dacument 4132
« | _r' « | oe|
Check Checkbox(es)
Click OK:
A R | E3 [ Microsoft Windows German User Interface Pac
Lingusger Ll e e
(Ot Peosies Raputcof Chioal PR
foiond b
I French Fancel e
[ Berman Femany]
™ Gopsh Bevecsl
1" oo sk
1™ Joganese apan]
1™ Morwegion Dokl Plorway
1™ Pusion Puaval
™ Spaich [San
™ Swedeh [Swederl
C o D oman |
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SIM EWS R2.6.3.1 SW Installation Section 3

If Chinese and/or Japanese is selected (here G:):
Change driveletter into the one, Windows XP X64 CD is inserted - OK 2x:

Files Needed [ x|

SR The file 'cplexe.exe’ on Service Pack 2 CO-ROM iz
S®  needed L

Type the path where the file iz located, and then click
Ok.

Copy files from:
( [mwoenians

Files Needed [ x|

- The file jiznls' on Windows =P Professional x64
<e#®  Edition CO-ROM is reedad.

Cancel

Type the path where the file iz lacated, and then click
Ok.

TT files from:
|G:\a d&4 j Browse. ..

Click OK (2x)

Reboot EWS:
Click: Start = Shutdown = Restart

Return to step 46

3.3.3 Local country keyboard settings (step 27)
Select: Windows Start = Control panel
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Section 3

SW Installation

SIM EWS R2.6.3.1

Click:
Select:
Select:

Click:

The Control Panel appears (see Figure 3-5).

B Control Panel

Eile Edit Vew Favorites Tools Help

Qo - @ - [F| O seach [T roklers | [T~

Address [} Control Panel

.ﬂ' Control Panel A Pick a category

& Switch to Classic Yiew
=

\ & Appeatance and Themes

See Also

@) Help and Support .}

=]
€3 Other Control Panel |
Options

Network and Internet Connections

9 Add or Remove Programs

= \ (;}J Sounds, Speech, and Audio Devices

1’( Performance and Maintenance

Printers and Other Hardware

. User Accounts

Date, Time, Language, and Regional
Options

Accessibility Dptions

»  Security Center

Figure 3-5 Control Panel Category View

Make sure “Category View” is selected.

Date, Time, Language, and Regional Options
Regional and Language Options

Tab: Languages

Details button
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SIM EWS R2.6.3.1 SW Installation Section 3
The following window appears (see Figure 3-6):
Text Services and Input Languages
Settings ! Advanced |
Default input language
Select one of the installed input languages to uze when you start your
computer.
Installed services
Select the services that you want for each input language shown in the
list. Uze the Add and Remove buttons to madify this list.
& English [United States)
K.epboard
- Us
Add
Preferences
[ Ok ] [ Cancel ] I8
Figure 3-6 Text Service and Input Languages panel
Select: Add to add the local keyboard
Select: The appropriate Input Language (see Figure 3-6)
Select: The appropriate Keyboard layout/IME (see Figure 3-7)
NOTE
The keyboard layout is usually the standard US-International QWERTY keyboard.
The Input Language is your local (native) language.
Click: OK
21
Input language:
IDulch [Metherlands) j
Eevboard layout/IME
[
Cancel |
Figure 3-7 Add Input Language panel
Choose: The added language from the Default input language
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Section 3 SW Installation SIM EWS R2.6.3.1

Choose: The created language as the default input language from the Text Service and Input
Languages panel (see Figure 3-8).

NOTE

There is no need to remove the other keyboard settings.

Text Services and Input Languages x|

Settings | Advanced |

r~ Default input language

Select one of the installed input languages ta use when you start pour
COMmpUter.

| I Esmfietnted States] - US

) e b Eor cackinpett mme

SETTI =
list. Use the Add and Remaowve buttons to modify this list

Dutch [Metherlands)
Keyboard

= Us
English (United States)
Kevboard Add |
* Us Bemove |
EBroperties... |
i~ Preferences
Language Bar... | Key Settings... |

C aK I) Cancel | Apply |

Figure 3-8 Default input language

Click: OK
Close: All panels
Return to step 27

3.34 Change Computer name (step 40)

See Reference sheets for value.

Start: Windows Explorer
Right click: My Computer
Select: Properties
Select: Computer Name
Select: Change

The EWS Computer Name can now be changed according the Reference sheets. The

Computer name must be unique in the Hospital network.
Click OK 3x

CAUTION

On MR-Host the EWS Remote Dicom node name must be the same as the
EWS computer name’.

! This is essential to map Offlineshare folder used by ExamCard Offline Editor
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SIM EWS R2.6.3.1 SW Installation Section 3
Click *“Yes” to reboot system now:
System Seitings Change ]
‘_:)- ou must restart wour computer befare the new setlings will take effect

Do youwant to restart your cormputer now?

Return to step 40

3.3.5

Check System’'s date and time settings (step 28)

NOTE

Enter the same time settings as on associated MR-Host

Double-click on the time at the notification area, right below
Enter: Correct settings
Select: Tab Time zone
Select correct Time Zone
Check: Automatically adjust clock for daylight savings is enabled
Click: OK

Return to step 28

3.3.6

Configure Internet Time Server (step 29)

When Audit Trail is required (see section 4.3.1.3.5 Audit Trail Settings p. 83) and the EWS is connected to
the Internet, it is advisable to synchronize the local time with an internet time server. By default this is

enabled.
Login as:
Double-click:
Select:
Enable/Disable:

Return to step 29

Administrator

on the time at the notification area, right below

tab: Internet Time

Automatically synchronize with an Internet time server:

Date and Time Properties E]

Date & Time | Time Zone | Internet Time

Automatically synchronize with an Internet time server
Server: | time-b.nist.gov v Update Now

The time has been successfully synchronized with time-b.nist.gov on
5/6/2002 at 4:43PM.

Next synchronization: 5/13/2002 at 4:43 PM

Synchronization can occur only when your computer is connected to the
Internet. Learn more about in Help and Support
Center.

[ OK H Cancel H Apply ]

Figure 3-9: Internet Time tab
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Section 3 SW Installation

SIM EWS R2.6.3.1

3.3.7 Update drivers on EWS (step 30)

NOTE

This paragraph can be skipped, in case of a Factory Image installed EWS

The driver folders are located in the corresponding directories on the CD: Drivers Dell 670 & Dell 690

When not logged in already:
Login as: Administrator
If not done already
Continue with section 3.3.7.1 p. 48

3.3.7.1 Update VP1000 driver®

Click: Start 2 Run...
Enter. Devmgmt.msc <Enter>
Click OK:
Run EE

Type the name of a program, folder, document, or
Internet resource, and Windows will open it For you,

=
oK [T | EierEn, ‘

Select: Sound, Video and Game controller

If VP1000 (Multimedia Controller) is not present: return to step 30
Insert: CD: Drivers Dell 670, Dell 690 & T7400 (4522 170 12931)
Right-click Multimedia Controller >
Click Update Driver...:

-l ultimedia Controller
@, sigmaTel High Definit T
@, Video Codecs Disable
% Storage volumes Uninstall

i) System devices
Universal Serial Bus conty 503 For hardware changes

g Generic USB Hub Properties
Standard Enhanced F

Select No, not this time
Click Next

! This procedure is only applicable when VP1000 video adapter is installed.
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SIM EWS R2.6.3.1 SW Installation Section 3

Select: Install from a list or specific location (Advanced)
Click: Next>
Select: Search for the best driver in these locations
Enable: Include this location in the search
Browse: to folder \670\\VP1000 or \690\VP1000
Click: Next>
Click: Continue Anyway*
Click: Finish

Pieasn chovse pous search and installstion optmns.

(O imarchter the bt chves S s
Lt e B ko I
pathe and imsrvabie meda T

o g B el narch, sbhuch rckudes kel
it direer fourd will be ritabed.

(23 fen snanch | vall chexie the dirers b nalal

[ e emenc b b gy, DR
[] Inchuds thes lpcahon in the sewch

E RS 00

M Hardware [etzliation

The softwase you are instaling for this hardwere:
VishsrmadPye 1000 [T 008 Divere 395 80, VL 335

i rao ] Wi L bl b veady s cormpuoliably veth
s vetsaon of Wirnkows: (Ll i vty e by o wigortodl]

Continuing your installation of this soltware may impain
os destabilize the comrect operation of your system
eithes immediately oo in the futwe. Microsolt stongly
recommends that pou slop this installation now and
contact the hadware vendor for software that hay
parsed Windows Logo testng.

Cheooe thin npion o select the device dives from a k. Windows does
2 .

Four hawchvwal
@E"‘""’W
Bock Cacl_|

Return to step 30

3.3.8 Change Volume name of C: (step 31)

Login as: Administrator
If not done already

Start:  Windows Explorer
Right click: C: drive
Select: Rename

Change name into: System

Return to step 31

3.3.9 Identify DVD driveletters (step 32)

The Driveletters are input for the configuration phase (see section 4.3.1.3.3 DVD Readers and Writers p. 80)
Click: Start = Run...
Enter: Diskmgmt.msc <Enter>

Maximize: @5”

Right-Click One of the CD-ROM drives

Select: Properties:
Z=cD-ROM 32 General | Properties | DWD Region | Volumes | Driver
DV E:) .
. £ ') HL-DT-5T VD +-Bw GSA-H73M
Ho Media Change Drive Letter and Paths. ., \‘@ -_
Eject
CD-ROM 5 . .

[ﬁ) iF) Device bype: OVDACD-ROM drives

Na Media " M arufacturer: [Standard CO-ROM drives)
i Location: 1]

Device shatus

Figure 3-10 DVD-drive type (here E: is DVD-RW)

! windows logo checking not passed.

4522 170 12901/level 1.2 CSIP Level 1 (09.0) Page 49 of 164

This document and the information contained in it is proprietary and confidential information of Philips Medical Systems ("Philips") and may not be reproduced,
copied in whole or in part, adapted, modified, disclosed to others, or disseminated without the prior written permission of the Philips Legal Department.

© 2009 Koninklijke Philips Electronics N.V.
ALL RIGHTS RESERVED




SIM EWS R2.6.3.1

SW Ins

tallation

Section 3

Write down results for both DVD-drives

Close: Computer Management panel

Return to step 32
3.3.10

on printed Reference sheets.

Initialize 2-nd Disk (step 33)
Start 2 Run... 2 type diskmgmt.msc - “OK")

Click:
Right-click Data-partition on 2-nd disk
Click *“Delete Partition...” > “Yes”:
= Disk Management Delete primary partition
Hie Action View Help {\  Alidata on s volume il be fast
- B EaBx i_ﬁ = ﬂ = 3 = 2 Do youwant io cansrus?
O SO ey MO O - P s | Wy —_
| S 0Data 0] Partii Bash 66.. 997
[ =3 5ystem (C) :wu:: :s::: Open 3. 749 h.’.°_
Explore
Mark Partitlon as Active
Change Drive Letter and Paths...
.+ X
= Disk 1 i
Basic
136,738
Online
= (0-ROM 0 >
W Urdexsiend [l Py postdem
;f’-'?!ar&i |25 Disk Management FEPM
Right-click “Unallocated” space 2-nd disk
Click “New Partition...”
= Disk Management
File Action View Help
B2E 0 . . . ol
| [Usot | Tipe | FlsSystem | Ststus | Caped | Freesp. | %
ELuT] Partition  Basic WIS ‘Heshhy  3251GB  1632GE 50%
=3 System (C) Partition Basic NTFS Heslthy (5., 41.99GB JIB0GE B0
.+ X
= Disk1 T
Basic
136,7368 136,73 GB |
Qnline Unallocated i
= CD-ROM 0 >
W Urlccoted @l Presary patis — Properties
e Hep
[ 5tart, | E5 Disk Management 49 AM
Click “Next >”
Enable “Primary partition”
Click “Next>":
riitlon Wizard ﬂ P 0
mfz';'am to the New Partition s*r‘n:;m;nm‘mum pomary. estenedt and logeal =]
d e base dek Seect the paHion you wani 1o cieate:
A baic ik iy @ ghyricel ik that conlains primey parions, (@ =]
sinnded partiions. and logeal dves. st paslion
:u:;udmao-mm«wm. o0 ME-D0S. 4
Partiiors cisated sn GUID Parttion Tatle (OFT) dicks con Dipchon "
1 om Lok m Iy B8 0l s o Wiendowrs ;’:;::E!!;m i b:&manw&eguw
Ta contirus, cick Mt e v & i
= = G
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SIM EWS R2.6.3.1 SW Installation

Section 3

Enter
Click

Select:
Click:
Enter

Check
Click

Click
Right-click
Select

“100000” MB for Data partition size (97,6 GB)
“Next>"

New Partition Wizard

Specily Partition Size
Chaosn 4 par

Masam desk Epace n magabying MBT Temn1

Mirmrm ik spoce m Wl ]

B sze i ME:

i

Driveletter D

“Next>"

“Data” for Volume label
“Perform a quick format”

“ ”
Next>
New Partitlon Wizard New Partitlon Wizard
Aasign Diive Letter o Path Ve Format Partition
For samier aceess, you a0 arsgn a dim et o dinen path 1o pour parthon gﬁ Tz shove claty on i partiion, wou must fommal @ frst

s vl s et b bl s b, et 4 s, vl s s oo by i

= g the bobng v lbar] Dyt o e s
" Mot it lon sty TFS fldr P Tt i

| Fle ystem: InTFs -
10 ok ssion & hive e cn chive st R L Defouk 2l
Vokama lbet °
 qpack ool
Enatis fle and loldes ¢oncestion

= e | L L Do |
“Finish”

Remaining Unallocated space 2-nd HD
“New Partition...”

N il

== Disk Management

Completing the MNew Partition Fie Aclion View Help
Wizard mRE DS
| Volume _ [two  |Typs | FlaSystem |Status | Capacky | Freesp. | fn
|SData 09 Panifion  Basic  NTFS Healty  G7.66GE G7E0GE 993
You TP E) Fartition  Basic NTF5 Healthry 325168 163268 S0%
e —Ta | = Systerm (C) Farition ~ Basic NTFS Healthy (8- 41.99GB 33J0GR BOY

| Dk soociet Dk 1
| Paston s 100000 M&
v emed of 13

4
b S —
Basic Data (D)
1367368 97.66 GBNTFS 39,0768
Online Healthy Unallocated
<ok s || New Partition.
| = CD-ROM 0 >
Wl Ursboxcobend [l Proiay pesbbrs Properties
Help
|#:stant |55 Disk Management 1 untited-Fant | F53AM
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Section 3 SW Installation SIM EWS R2.6.3.1

Click “Next>" 3x
Select driveletter “I”
Click “Next>":

= Disk Management P (=] £
File Action View Help

New Partition Wizard

Specily Patition Size
Choa

VD Assign Dirve Lolles ar Path :_i Frae Sp. I %Fn
=l Ff edaier bece1a. you £an SEHDN & dive letier o dhive: path 10 yus partbion. " o7E0GE 993
= 163268 509
Musam dsk =nace nmegabyies (M} A0S = 339068 80%
M sk space nME 8
Batiioe: size i Ml - = s the foloweg deve lefies
> | Mo =l folwrng gty HTFS fukden
it et L L AL
8 Do s o dhive et v st
]
L
a
.aom Cocdl | |
| = =|
[ ]
| P t
| start | 28 Disk Management 1 uniitied - Painlz 58 AM

Enter “Backup” for Volume label
Enable “Perform a quick format”
Click “Next>" - “Finish”

ard

Formst Partition Completing the MNew Partition
Tz shove claty on i partition, you must lomal @ frst

Wizard

(Chexm vt s o o bt uabien, aead d s, whal smiengs pous vaard e

1~ Eianst kit e pasion '(mwbd“:l‘llmhl\n;:::‘lw -
2 Fw-dn-m&m-n-l-m.lu—-n-hv B:“‘m"‘g:“g;:‘m il
Fle rystem: INTFS 7 ‘rr'.‘:: o ot | ‘
Vosmctine_lpins 2 e .
@-hmov-dlamd T chose this wizard, chck Finshy

1™ Enable fle and fokdes compeison

chock | News Corenl | -ea Corenl |
Close “Window”

= Disk Management
Eie Action Yiew Help
BEfE &8
|tayout | Type | FileSysteen | Smaews
Partition Basic NTFS Hasizny
Partition Basic NTFS Heuaithy 97.66 GB 9760GE 993
| = Syt () Pattiton  Basic NTFS Hualtlry (8., 136.59 G 10133, 743

i | 3l

= Disk 1 I R
fasic |

Data (D) Backup (I}
1367360 q?.u»g:l\me; 300768 Fms |
Online Healthy Healthy
| = CD-ROM 0 =

| I Uraocated [l Prnary pasbtion

Figure 3-11 2-nd HD partitioning scheme
Return to step 33

3.3.11 Initialize partitions on 2-nd Disk (step 34)
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SIM EWS R2.6.3.1 SW Installation

Section 3

If you have a System backup on the Backup-partition and want to save it:
1. Connect USB-HDD

2.  Open Windows Explorer
3. Select on Backup-partition software_backup folder
4

Drag folder to USB-HDD:

Address ‘Q Edsoftware_backup

Folders | =
- ; = BackupFarl.tib
I < Backup (E) & BackupForZ.tib

15 RECYCLER

15 Systeri Volume Information
& DVD-RWwDrive (F)
4 DD Driga (G2
e 1_OSGE KEES (Hy)

< 72GB U Kees (1) -l <
Click: Start = Run... = type diskmgmt.msc - “OK”
Right-click Backup-partition on 2-nd disk

Change Driveletters and Paths... > Change... 2 “I” > OK - Yes:

Select:
Changs Drive Latter and Pathe for - [Mackup) E;EI
File Action View Help loww Acenes 1n hes vk By Leung e Inlowang diten iner and Pk
B RE DxFEFaE =73
Vol [Laos  [Typs [ Filesp
< Patition Basic NTFS
=173 Open
9 Explore
Aark Partition as Actiy [Cast o TH Remove
 Change Drive Letter and Paths... [ o [ T ]
Entes 2 now v el ox path or £: (Backun) '-"’/ Charging the drive bebter of & volkame might cause Brogrms oo konger run, Are you s you vk o changs this drive letter?
(=) rign the following deve letter
&P w
M
H
o
"
a
A
5
T
L
ke
Right-click Backup-partition on 2-nd disk
Select: Format...
e Disk Management Format I: EHE
File Action View Help Yohume labet Backup
B XS o Fosem wes =l
M% [l [ Type  [FleSystem | i [oofet -
Partition Basic MTFS
= $ystem (0 Qpxa o 2 auick fomak
Explore [~ Enable file and folder compression
Mark Partition as Active ..‘ ol
Change Drive Letter and Paths... — Q
4
Check: Perform a quick Format
Click: OK (2x)
' WARNING: Formatting will erase all data on this wolume
L3 To format the volume, click OK. To quit click Cancel
Cli oK 1) Cancel |
Right-click Data-partition on 2-nd disk
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Section 3 SW Installation SIM EWS R2.6.3.1

Select: Format...

r= Disk Management Format D: [7]x]
fFile Action View Help Volume label Dala
2 File spstenn ’ﬁ‘
Yolume ‘ Layout | Type | File Sys ’—L|
< z Fartition Baslc NTFS Allocation unit size: Default
== e Partition Basic NTFS @i‘ul‘r‘ﬁ.a.ahwék e
I Enable file and folder compression
Explore
Mark Partition as Active L D come
. Change Drive Letter and Paths...
=1 Delete Partiti
Basit elete Partition...
136. i
Properties
onir P
Help
Check: Perform a quick Format
Click: OK (2x)
Format D: [x]
() WARNING: Formatting will erase all data on this volume.
L3 To format the wolume, click OK. To quit click Cancel

Cli oK 1) Cancel |

Click: Close Window

Return to step 34

3.3.12 Re-initialize Backup partition (Step 45)

NOTE
In case the Service Pack/Security fix installation fails,
this section takes care, when the Backup partition has not got driveleter “I”, according section

3.3.11p. 52
Click: Start = Run... = type diskmgmt.msc - “OK”
Right-click  Backup-partition on 2-nd disk
Select: Change Driveletters and Paths... > Change... 2> “I” > OK - Yes:
m Changs Drive Lattar and Paths for F- [ackup FE
File Action View Help -‘.lmxrre‘lnlﬂtmlﬁ!ummwldwmﬂl“ht
B RE DXEEaE ET
vowna __ [lwos  [Tgr  [riesy
RN  Fotton  Basc WS
=l Oum
= Explore
Airk Pactition a5 Act [Cas qhwos TP menowe
q Change Drive Letter and Paths... | e [ gy

Enier & nesws cirvn leler or path for £ [Bacioup]
(5 g the fobowing dive letter

'."H Changingthe ciiwe letter of & volume ight cause programs £ no fonger run, e you s You veurk b chenge this drive letber?

G P w

Click: Start > Service Tools ©> Re-create backup partitions
Close All applications.
Reboot EWS
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SIM EWS R2.6.3.1 SW Installation Section 3

Return to step 45

3.3.13 Check Power settings adapter connected with Hospital Network
(step 35)

Start Windows Explorer (if not already active)
Right click: My Network Places
Select: Properties
Right click: Local Area Connection® (Link with Hospital network)
Select: Properties
The “Local Area Connection” properties panel appears
Click Configure:

-L- Local Area Connection Properties

General | Advanced

Connect using:
B2 Broadcom Net<treme 57:x Gigabit

This cannention uses the fallawing items
[~ ICient for Microsoft Metworks
3 File and Printer Sharing for Microsaft Networks
421005 Packet Scheduler
5 Intemet Protasal [TCRAP)

[ instal ] [ uninstal ] [ Fioperties |
Description
Allawes your computer to access resources on a Microsaft
rietwark.

] Show icon in notification area when connected
Matify me when this connection has limited or no connectivity

Figure 3-12 Local Area Connection Properties panel

Select: Tab: Power Management

Uncheck: all checkboxes:
: Glgablt Controller Pr... EHEY

Gieneinl | Attvanced | Durves | Aesousces  Powsr Hanagement

[ oo Mot 5 Gl e

o) e thandby iy

frlemy wate,
ottt i)
e bamery,

=5

Figure 3-13 Power management NIC disabled (example Dell 690)
Press: OK

Return to step 35

1 If numbered, you have to select the lowest number.
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Section 3 SW Installation SIM EWS R2.6.3.1

3.3.14 Change IP address adapter connected with Hospital Network
(step 36)

Continue from step 35

Right click: Local Area Connection® (Link with Hospital network)
Select: Properties

Select: Internet Protocol (TCP/IP) < Properties:

-4 Local Area Connection Properties

General | Advanced

Cornect using:
ES Broadcom MNetktreme 57xx Gigabit ©

This connection uses the folowing items:
=" Clent for
=l File and P
=} 105 Packet Scheduler

1 % Intemet Pratocol [TCP/IP

icrosoft Networks

l Install.. ] [ Unirstall d.b
Description
Allows your computer to access resources on a Microsoft
rietwork.

[] Show icon in notification area when connected
Notify me when this connection has limited or no connectivity

On the next panel (Figure 3-14) the IP address, Netmask and default Gateway can be changed.

Enable Radiobutton “Use the following IP address”
Enter IP address, Subnet mask and Default gateway.
f 2ix|

Internet Protocol {TCP/IP) Properties
General |
“r'ou can get IP settings assigned automatically if your network. supports

thiz capability. Othenwize, you need to ask your netwark administrator far
the appropriate IF zettings.

£~ Obtain an IP address automatically

—1% Use the following IP address:

1P address: 192 .0 o 2
Subnet mask: I 2h5 285 .285. 0
Default gateway: 192. 0 .0 .4

£ btain DHE senver address automaticall

—1% Use the following DMNS server addiesses:

Preferred DNS server: I
Alternate DMS server: I . . .

Advanced...
Cancel |

Figure 3-14: Internet Protocol (TCP/IP) Properties panel (Example)

NOTE

The Extended MR Workspace R2.6.3.1 system is standard configured in a Workgroup. Extended MR
Workspace R2.6.3.1 in a Domain is not supported.

1 If numbered, you have to select the lowest number.
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SIM EWS R2.6.3.1

SW Installation Section 3

The Extended MR Workspace R2.6.3.1 will only function when fixed IP-address is used, due to the fact that
the Extended MR Workspace R2.6.3.1 configuration cannot handle dynamic IP-address.

Click OK to confirm the settings
Click Close to close Properties Window.

Return to step 36

3.3.15 Check Power settings Direct Link adapter (step 37)

Continue from step 36

Right click: Local Area Connection 4" (Direct link between EWS and MR-Host, must be connected)

Select: Properties
Press: Configure...

Select: Tab: Power Management

Uncheck: all checkboxes:

. Local Area Connection 2 Properties K E3 (I 1ntel (R) PRO/1000 PT Dual Port Server Adapter P... JEIE3

General ] Advanced I

Connect using:

General] Advanced] Driver I Resources  Power Management ]

"{é‘ﬁﬁ IntellR] PRO/A 000 PT Dual Port Server Adapter

| B8 IrtellR] PRO/1000 MT Dual Port 3 ) """
[ Allow the computer to turn off this device to save power

This connection uzes the following items:

~

fgl Client for Microsoft Networks

J% File and Printer Sharing for Microsoft Metworks

@GDS Packet Scheduler
L |ntemnet Protocol [TCR/P)

Install.. |

-

Warning: Allawing this device to bring the computer out of standby may
cauze this computer ta peniodically wakeup ta refresh its network state. IF
you triavel with thiz computer or un it on a battery, vou should not tum on

Properties this feature as the machine mayp awaken at inoppartune times or cansume

Description

Tranzmission Control ProtocolAntemet Protocol. The default
wide area network. pratocal that provides communication
acrose diverse interconnected networks.

™ Show icon in notification area when connected
¥ Maotify me when this connection has limited or no connectivity

the battery

ok Cancel Cancel ‘

Press: OK

Return to step 37

3.3.16 Change IP address Direct-link with MR-Host adapter (step 38)
See Reference sheets for values.

Continue from step 37

Select: Internet Protocol (TCP/IP)

Press: Properties

Enable Radiobutton “Use the following IP address”

Enter/Check  IP address 192.168.73.11

Press: TAB

Enter/Check  SubnetMask

Click Ok - Close

Return to step 38

! This number varies. You have to select the number in between.
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Section 3 SW Installation SIM EWS R2.6.3.1

3.3.17 Disable Spare network link (step 39)

Continue from step 38
Right click: Local Area Connection 5*
Select Disable:

LAN or High-Speed Internet

B8 | ocal drea Conne 3
<% Local &rea Connection

Close Window

Return to step 39

! This number varies. You have to select the highest number
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| SIM EWS R2.6.3.1 SW Installation Section 3

3.3.18 Network Configuration Example
Hospital LAN
R2.6.3 MR-Host - R2.6.3.1 S
Hospital Connection 7 ~ N Hospital Connection
IP Hostname: MR1 ~~ Only one link ,( IP Hostname EWS1-MR1
IP Address: 130.144.240.10 I is defined: IP Address: 130.144.240.11
V|a LAN
via Dlrect Link
— X5
S —= N X5
I 2 &
¢ (= — z
™ é R2.6.3 MR-Host Direct Link R2.6.3.1 EWS g —
© = X50 Extension Connection Extension Connection X50 = g
=| . G— . — = <
& = IP Hostname: MR1 IP Hostname: EWSI1-MR1 = o
14 2 PAddress:  192.168.73.10 IP Address: ~ 192.168.73.11 L =-°‘
R2.6.3 MR-Host Windows R2.6.3.1 EWS Windows
Computer name MR1 Computer name EWS1-MR1
Workgroup PHILIPSMR Workgroup PHILIPSMR
DICOM Local System DICOM Local System
AE_Title: MR1 AE_Title: EWS1-MR1
Port number: 104 or 3010 Port number: 3010
IP Address 127.0.0.1
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Section 3 SW Installation

SIM EWS R2.6.3.1

DICOM Remote Node database settings when MR-Host and EWS communicate via Direct Link.

8 __— /“ *
I = = =
021 — R2.6.3.1 EWS — i
P = DICOM Remote Node database N
© =l - - . " —, Ul Name: MR1 via Direct Link ﬁ = $
& =r. T =~ . — [ AE_Title: MR1 N [ = &i
1 = IP Hostname | MR1 . "{\ \ﬂ
——ly IP Address NIC | 192.168.73.10 .
: R2.6.3 MR-Host 7
/ DICOM Remote Node database P *
‘ Ul Name: EWS1 via Direct Link -
14 AE_Title: EWS1-MR1 -
. Template EWS e —
IP Hostname | EWS1-MR1 . : ) )
IP Addl’eSS 192.168.73.11 Direct L|nk
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SIM EWS R2.6.3.1

SW Installation

Section 3

DICOM Remote Node database settings when MR-Host and EWS communicate via Hospital LAN.

(This network configuarion is an alternative, when Direct Link is not available!)

P
/
/
/
] R2.6.3 MR-Host
I DICOM Remote Node database
Ul Name: EWS1 via Hospital LAN
I AE_Title: EWS1-MR1
| P =] Template EWS or
ViewForum
N IP Hostname | EWSI-MR1
= IP Address 130.144.240.11
—

R2.6.3 MR-Host

[
&\\lllll

R2.6.3.1 EWS

DICOM Remote Node database

Ul Name:

MR1 via Hospital LAN e

AE_Title:

MR1

IP Hosthame | MR1

IP Address 130.144.240.10

R2.6.3.1 EWS

Hospital Network
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Section 3 SW Installation SIM EWS R2.6.3.1

3.3.19 Unified back/depth buffer setting

For the nVidia Quadro FX video cards, the Unified back/depth buffer setting must be turned off. When this
option is not turned off, the 3D renders will not work with the GPU option activated (Video board settings in
ViewForum Application -> System Options), see also section 4.6.1 Check OpenGL support settings p. 103.

nVidia Control Panel:
Right-Click: in the notification area on the nVidia icon (see section 3.3.1.1 Enable nVidia icon in naotification
area p. 41, when icon is missing) = NVIDIA Control Panel > Advanced settings > OK:

! Screen Resolution NVIDIA Control Fanel View Selection
| Screen Refresh Rate T | Chessie L viow thak i most approgeiate for you.
W Color Quality |

"1 Performance & Quality Settings
2 Custom Color Settings

1 Rotation Settings

= Color Correction

Sandard Sattngs
1 ot e o o sl e, et Stanclard Setiangs. This view vl
sy marty of the sireers you wil see,

@ o

rrrr ooy

= NVIDIA Control Panel Tvou are ey . This
Mwl NUIUm sewngs—_ phas ol of the advanced Feabures.
bit o . Ta leart hawe

¥ hodo this, ek here,

Select: On left panel: Manage 3D Settings
Make sure “Base profile” is selected as Global Preset
Select: From settings box:
Unified Back/Depth buffer -> Off:

File Edit View Help

O Back J El Advanced Settings +

Select a Task...
[=1+ 30 Setting

Manage 3D Settings

15 with preview

‘Yo can change the global 30 settings and create overrides for specific pragrams. The overides wil be uze
o levels automatically each time the specified programs are launched.

[=)- Display
un display optimization wizard 1 would like to use the following 3D settings:
hange resalution
hange flat panel scaling -
djust desktop calor settings Global Settings | program Settings
otate displa
b Global presets:
-~ Manage custom resolutions
: *set up mulkiple displays Base profile j
FJ Video & Television
- Adjust video calor settings Settings:
I Workstation
et emts Feature Setting B
Extension limit Off
Force steran shuttering OFf
Maximize kexture memary OFf
Multi-display/mixed-GPU acceleration Multiple display performance mode
Stereo - Display mode Use on-board DIM connector -
Stereo - Enable OfF
Skereo - Swap eyes OFf
Threaded optimization
Triple buffering
Unified back/depth buffer
-
[l | 3

(& System Information Apply Cancel

Press: Apply to confirm modification(s).
Close panel

! Default
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SIM EWS R2.6.3.1 SW Installation Section 3

3.4 INSTALLATION OF EWS APPLICATION SOFTWARE

Installation of the complete EWS consists of installation of the VF Application software part and the MR
application software part.

3.4.1 Installation VF Application Software (step 42)
When not logged on already:

Login as: Administrator

Insert: into DVD-ROM drive:
DVD: EWS R2.6.3.1 Application Software (VF7.2V5L1) (4522 170 12821)

The CD will automatically start up.
NOTE

In case the DVD for some reason does not auto start; the installer must be started by hand:
Open Windows Explorer open the content of the DVD-ROM - double click the file: "setup.exe".

PHILIPS

Philips Medical Systems
ViewForum Release 7.2 Level 1

¥ use SOLExpress 2005

Copyrights and all other propritary rights in
any software and relsted documentation ("Software")
mate avaiable to you rest exclusively with Philips or its licensors
Mo title or ovwenership in the Software is conferred to you
Use of the Software is subject to the end user license conditions
as are available on request

Install Extended MR Workspace >

Exit installation

Figure 3-15: Example Product Installation panel

Press: Install Extended MR Workspace to start the installation of the Application Software

Follow the on-screen instructions. The installation will take about 20 minutes.

During the installation the following questions will pop-up

Click No
M | icense file option
Figure 3-16: License file option panel
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Section 3 SW Installation SIM EWS R2.6.3.1

The installation has ended when the reboot alert panel appears:

PHILIPS

Philips Medical Systems

Installation of Extended MR Workspace is completed

Please REBOOT to activate system changes]

0K

Figure 3-17: Reboot alert panel

Click “OK”
Remove: DVD: EWS R2.6.3.1 Application Software (VF7.2V5L1) (4522 170 12821)

The installation of the VF application software has been completed.

Reboot the EWS
Click Start > Shutdown - Restart

Return to step 42

3.4.2 Installation MR Application Software (step 43)
Login as: Administrator (CTRL-ALT-DEL)

Insert: into DVD-ROM drive:
DVD: EWS R2.6.3.1 MR Application Software (4522 170 12831)

Start Windows Explorer
Browse to DVD-drive with media inserted.

Double-Click INSTALL_EWS_1.CMD

B FWS-MR (E)
file [dit View favorites Tools Help iy
DBk > 3 - T sk || Foldes [Tw
Address | 1 + oo
Folders x  MName « | Size | Type | Dats Modied
_Jimages e Fodder :
Jf‘f'f'":al‘:' G frial_svs, Lomd | THE E’nn?‘wdx{lomamﬁ(fm ;gggg: ;333{1”
41 Images -
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SIM EWS R2.6.3.1 SW Installation Section 3

Installing... Will take about 10 minutes.
v CAWINDOWS\system32\cmd. exe
Executing the MR EWS DUD #1 installation =

Infnrmatlnn about each installation can bhe found in D::log.
:35 : Installing OpenS§
- Du not forget to configure OpenSSH after the installation proces?
See OpenSSH documentation for more info.

— 14 :35 Installing PERL.
- 11 :36 Installing Windows Nerlla Encoder.
— 11 :37 : Installing DotMet 1.
— 11 :37 = Installing J#.
— 11 :38 = Installing Directy managed DLL’s
— 11 :38 : Installing InfoZIP.
— 11 :38 : Installing Flash Player
- 11 =38 : Installing UGC++ 2085 redlstrlhutahle...
— 11 _:38 = Installing PMS_MR_Extended_Workspace...

. This can take about 15 min.
— 11 :43 : Installing UserDocs.
— 11 :44 : Installing Uu-usscanner
Installation of the EWS DUD #1 is flnls}mrl check D:\logninstall ews_sw.log.
land Reboot EWS.
[Press any key to continue . . .

Figure 3-18 Command window during MR-SW installation

As final step McAfee virusscanner is installed.
Press <any key> to continue

When Command window (see Figure 3-18 Command window during MR-SW installation)
is closed:
Remove DVD('s) from the drives
reboot EWS:
Click Start > Shutdown - Restart

Return to step 43

3.5 CBT INSTALLATION (STEP 47)

When not logged on already:
Login as: Administrator
Please ignore:

eviaunch.exe - Error message n

‘You are not authorized to run this program, please contack wour Syskem Administrator,

Insert: into CD-ROM drive:
CD: EWS R2.6.3.1 CBT (4522 170 12881)

The CD will automatically start up in the webbrowser. The browser can be closed.

Start: Windows Explorer

Open: CD drive

Select: Ctrl-A to select all content of the CD drive

Select: Copy the content of the CD to C:\Program Files (x86)\PMS\ViewForum\Training

When the content has been copied, remove the CD from the drive

3.6 MS WORD INSTALLATION (STEP 44)

The EWS Reporting functionality requires that MS Word is installed. When this EWS option is ordered, MS
Word is also delivered.

3.6.1 Prerequisites
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Section 3 SW Installation SIM EWS R2.6.3.1
® CD-ROM: MS Word Edition 2007 or 2003

® Must be logged on as Administrator (Windows XP)

3.6.2 Installation

Close: all programs
Insert: into DVD-ROM drive:
CD-ROM: MS Word Edition 2007 or 2003 (9896 050 90671)

If not logged on already:
Login as: Administrator

Follow the instructions on screen (use the default settings).
Remove: CD-ROM

Return to step 44
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Section 4 Configuration and Customization
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4 CONFIGURATION AND CUSTOMIZATION

During configuration, some hospital or system specific details must be entered. The exact details must be
noted down on the Reference Sheet of Section 6.

For future reference, print this Reference Sheet with the hospital and system specific settings and store it in
a save place.

If the EWS is an initial factory delivery, many configuration items of the EWS itself will be correct. Check it
according the following pages.

4.1 WINDOWS XP64 USER ID’S

Windows XP x64 UserID | Initial Role
Password’

Administrator password or | Windows XP x64 administrator User
Password1?

MRUser MRUser EWS Application user

HospitalAdmin ViewAdminl | To manage Hosp. Admin, monitor calibration

MRService ViewForuml | Configuration/Installation EWS

Remote ViewForuml | Remote Service

The initial passwords must be changed after the first login and noted down on the Reference
Sheet of Section 6 (and safely stored).

Table 7 Initial Windows x64 passwords

4.1.1 Password policy

A secret password must be used for user authentication.

A password, which must be non-trivial and kept secret, is the minimum means to uniquely identify a user and
to verify whether an attempt to access protected resources is legal. Passwords must be changed regularly,
e.g. every 90 days.

Note that a password in fact has the same importance as your passport. It represents your identity and
therefore should be selected with care. For the EWS, it is your only way to enter the system securely. It also
guarantees that nobody else can change your data, since that person is not authorized to do so.

Any password must satisfy all of the following rules:
Passwords must be changed at least every 90 days.
Password length must be at least 7 characters.

These rules apply to both personal user accounts and functional accounts.

4.2 Ex/IMPORT CONFIGURATION & DATABASE

42.1 Export EWS Configuration settings (steps 16, 75)

Login as: MRService

! See also section 6 Reference sheets
2 Factory Image installed EWS
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Section 4 Configuration and Customization

SIM EWS R2.6.3.1

Insert USB-flash disk or USB-HD
If applicable: wait until USB-device is ready to use.
Select: Start - Philips—> Installation Tools=> Export EWS Configuration
Browse to: Location where the back-up should be saved to (e.g. USB)

It is recommended to keep the backup file separate from the Extended MR Workspace

R2.6.3.1 system
Press: Save
Confirm: OK
Remove USB-Key or USB HD via “Safely Remove Hardware” icon:

SafelyBamove Hardware
] | 12:16 P

A ZIP-file of the Configuration settings is created and saved on the selected backup location.

Return to step 16 or 75
4.2.2 Export EWS License file (step 17, 75)

Login as: MRService
Select: Start > Philips—> Installation Tools—> Inspect License File:

FE Philips 7 (] Configuration Tools 4 _
g ] Diagnostic Tools 4

Ly Cearuest (I 5 Change Host Name

Report_test_system_problem.cmd &® Enable Remote Access = Export EWS configuration
StartInstallation.cmd & Examcards Offline Editor  [Z] Fixup Firewall Settings

@) Extended MR Workspace = Import EWS configuration
[z Programs ' i&] NetForum jewForurm Configur
% Documents y |&4 Inspect License File
i
[}' Settings 4 : mse File
[#53 Printer Calibration

j) Search 4

@) Help and Support
=7 Run...

Windows XP Professional x64 Edition

@ Shut Down...

Select Save As...:

File Edit Format View Help

New Crl+N 3c3des. DAT
Open... Ctrl+0 RUM_FOR MR

MR TESTSYSTEM
Save Cirl+5

-2007 13:45:02
Page Setup... MUNSTErS
Print... Ctrl+P 28
Exit

#[CTient 1]
INCREMENT 3dAdvProjections easylicd 8.1 19-sep-2008 1 %

Browse to: USB-stick
Select Save:

File name: |I|c:ense.dat ﬂ | Save
Save as bype: | Text Documents [* k) j Cancel
Encoding: |AN5| ﬂ
Close Windows
Return to step 17 or 75
4.2.3 Export EWS Examcard Database(s)
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SIM EWS R2.6.3.1 Configuration and Customization Section 4

Login as: MRService
Insert USB-Key
Start Examcards Offline Editor by
Double-click e

Offline Editor
Right-Click: Tab with Hospital Examcards
Select: Select Examcard Database
Select: <EC Database>

Wait until:  “Database is open for editing”:
xamiCards Offline Editor ( MRO1 15T Z64.bin)
File Help
Sl | o s
& Philips Hospital | & Philips Hospital |
lesplla_ Export ExamCard Database As.. ) =
amCard Database 'r =

13:53 Database is open for editing.

Right-Click Tab with Hospital Examcards
Select Export Examcard Database As...

MROL_15T_261_ECD |
11_15T 261 ECD Export ExamCard Database As...
Impert ExamCard Database L]
Select ExamCard Database '

ard Restore Dutabase
Browse to Location where Examcard database must be saved (Offlineshare folder, USB-key)
Enter <Filename for EC-database>

Click Save
Wait for “Export of Database completed” message.
Tlx |13:5? Preparing for export of database. Please wait.
Savejnq_)\EEE_Q x| o« @k Er

y [LIMROL_15T 261 _ECD
J |13:5? Export of Database Completed

g
File name: EWS06_15T_261_ECD) | [ Ewe

Save a3 bype: |Dalahase Archive Files (* Zip] j Cancel

Repeat this procedure for other EC-databases.
Remove USB-key via “Safely Remove Hardware” tray icon
Click: File > Exit (to close Examcard editor)

4.2.4 Import VF License file (step 48)

To install a license file do the following:
Login as: MRService
Insert: License file carrier (CD 4522 170 03451/Floppy/USB stick)
Select: Start - Philips = Installation Tools - Install License File
Press: Continue:
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Section 4

Configuration and Customization

SIM EWS R2.6.3.1

ViewForum License File Inst... Eal=} 3

License |0 for selecting WiewF orum License file
License 1D 1=0015172E0083 IP address: 0.0.0.0
License 1D 2 = 02004C4F4FS0IP address: 192.168.70.10
License 1D 3 = 0019B93C30ES P addiess: 192.168.40.105
Licenge 1D 4 = 0015172ED0B2 P addiess: 0.0.0.0

ContinLe | Cancel |
Browse to:

J—_— e
Location of the license file that must be installed and select file
Press: Open:

Serwvice Application 2
SIM_pict
File name: ‘Ilcense.dat j Dpen |
Files of type: ‘ViewFolum License file [* dat) j Cancel
Press Install License File:

ViewForum License File [nstaller [ i=1E3

Verify ViewForum Licenze file selection

Install License File Wiew Lizense File | Back |

F:/license.dat

Figure 4-1 EWS R2.6.3.1 License File Installer Panel
The ViewForum License File Installer is started:

Progress Bar [_ O] x]

Stopping System Monitar

Press OK:

5Success message !EE

Lizense file F:/license. dat installed.

o]

Figure 4-2 Extended MR Workspace R2.6.3.1 Success message panel

NOTE

During installation of the license file, the new file will be copied to the
C:/Program Files (x86)/PMS/ViewForum/ License directory and re-named to license.dat. The old license file

will be re-named to license.org and saved in the same directory.

WARNING

When a new license file has been installed as described above with changed import/export license options:
always check the extended DICOM settings in Extended MR Workspace R2.6.3.1 Configuration and execute
Configuration in order to effectuate the changes in the import/export options.

The content of the license file can simply be viewed by selecting:

Select: Start - Philips = Installation Tools = Inspect License file
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SIM EWS R2.6.3.1 Configuration and Customization Section 4

Return to step 48
4.2.5 Import ViewForum Configuration settings (step 49)

Logon MRService user, password = ViewForum1' (see Reference sheets)
Select: Start > Philips—> Installation Tools

Select: Import ViewForum configuration
Browse to: Location where the back-up file is saved (e.g. USB-stick)
Select: Configuration settings backup file
Click Open > OK
The backup files are being restored now, a progress information bar appears.
Reboot EWS:
Click: Start = Shutdown - Restart

Return to step 49

4.2.6 Import EWS Configuration settings (step 50)

Logon MRService user, password = ViewForum1', or see Reference sheets.
Select: Start > Philips—> Installation Tools

Select: Import EWS configuration
Browse to: Location where the back-up file is saved (e.g. USB-stick)
Select: Configuration settings backup file
Click Open > OK
The backup files are being restored now, a progress information bar appears.

Import EWS Configuration EAE3 [ Import EwS Configuration E
Look. l - & cf
oo | Sl J & e B~ ! } Flease stop all applications before proceeding!!l
| ecdatabase

J |tempZip_2
E8] Configura

008071
[ I

File name: |Confiquration_sws03_2D08071 5025030 - Open

{)

Files of type: |2ip fles |.2in) - Cancel

When Import EWS Configuration:
Click *“Yes”, or “NO” when the SRN needs to be adapted (Default: Yes):

Import SRN E

R?/" Shauld the SR be imported?

Mo ‘

The restore is complete when success message pops-up.
Confirm: OK:

! Change password when this is 1-st logon
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Section 4

Configuration and Customization

SIM EWS R2.6.3.1

Import EWS Configuration [ X |

\l‘) The import of configuration of EWS was successfull

Reboot EWS:

Click: Start = Shutdown = Restart

Return to step 50

4.2.7

Insert
Start
Double-click

Right-Click
Select

Browse to
Click

Wait

Import EWS Examcard Database(s)

USB-Key
Exacrds Offline Editor

Tab with Hospital Examcards
Import Examcard Database - “non-grayed position”

ExamCards Olfline Editor { MRO1_151_261.hin )
file  Help
el |

& Philips Hospiral | # Philios Hospital |

Location where Examcard is located (USB-key, or Offlineshare folder)
Open:

Look (| I ECOLE ; X +® e m
»

Filo pame: |MRO1_15T_261_ECD - | "
———

Fimscllypm [ Dalabane Archive Fils [ Zel =] Deed |
Until “Importing Database” is ready
o5 & Philips

13:47 Importing Database. Please wait.

Repeat this procedure for other EC-databases.

Remove

4.2.8

USB-key via “Safely Remove Hardware” tray icon

Back-up Patient Database (step 18)

The Patientdatabase of Extended MR Workspace R2.6.3.1 can be backed-up to another (network) location
(e.g. a PACS system) or to an (external) disk. Creating a backup may take 2 — 3 hours.
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SIM EWS R2.6.3.1 Configuration and Customization Section 4

If the backup must be stored on a removable storage medium (USB stick, external Hard disc), make sure it is
connected.

Loginas MRUser (if not the case)
Start: Extended MR Workspace application
Login as: MRUser or as administrator
Select: Data management
Select: Split View
Select the images to back-up.

In one of the views:
Select: function: Copy to
Select: Location to store the backup of the image data (it will be listed as: “Backup Repository”)
Press: Backup Repository to start the backup

Return to step 18

4.2.9 Restore Patient Database (step 74)

Restoring a database may take 2 — 3 hours. A backup of the Patientdatabase of Extended MR Workspace
R2.6.3.1 can be restored as follows.

Loginas: MRUser
Start: Extended MR Workspace Application
Login as: MRUser or as administrator
Select: Data management
Select:  Split View

In one of the views:
Select: function: Copy to
Select: Location of the database back-up (is listed as Backup Repository)
Press: OK to start the restore job
NOTE

It is only possible to perform a complete restore. It is not possible to restore only a part of the
backed-up images.

Return to step 74
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Section 4 Configuration and Customization

SIM EWS R2.6.3.1

4.3 VF & MR CONFIGURATION STEPS
43.1 Configure EWS (VF settings)
43.1.1 Start EWS Configuration (VF) (step 51)

To start Configuration:
Loginas: MRService
Click Start &> Philips = Configuration Tools - EWS Configuration:

T Philips
Diagnostic Tools
@ Set Program Access and Defaults .
Installation Tools
&> Windows Catalog £R Enable Remote Access

4 Examcards Offline Editor

TS () Extended MR Workspace
< Documents * &] NetForum

Settings 4

Search ’

) Help and Support

Run...

Windows XP Professional x64 Edi

Shut Down...

]IStart

The Configuration main panel appears:
Select: Node Type “VF”
Select: Edit

fi@ Configuration Tools 4 @] EW'S Configuration

* 7] MR Configuration
» ) Set Logging Level
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SIM EWS R2.6.3.1 Configuration and Customization Section 4

@ Execute... Import DICOM nodes Help...

Configured nodes

Hode IP 1P System
type node name address name
YF EAS1-HR1 127.0.0.1 EWS1-HMR1 for SIM

(™. ViewsForum configuration

ViewForum system name | EWST-MR1 for SIM ﬂﬂ
MAC address | 001aanc1b7af

IP node name | Ews1-MR1 ]
IP adress | 127.0.0.1

Memory size in Mh ’W Automatic Configuration

Memory tuning @ Standard

Monitor type E LCD color

Multi Monitor Settings... |

Peripheral Settings... |

TSM Settings... Audit Trail Settings... | |

DICOM AE title ['EWS1-MR1  DICOM Settings...
Create teaching database [

Image database location E Local Image Datahase Allocation...
Image database name | Database on EWS1-MR1

Image database identification patientdh

3W license server location % Local

Proceed Cancel

Delem..! Edit ... ’ Hewr... E DICOM Hode

Figure 4-3 EWS Main Config Panel & VF node Config Panel (example)1

[[=]

43.1.2 EWS Configuration Main panel explained

Execute...
Select this option when configuration is complete. This option saves the configuration file to hard disk. See
chapter 4.3.3 of this section for details.

Help...
Tells you this manual is available on InCenter.

New...
With this button the local EWS and DICOM nodes (see chapter 4.3.2) can be configured.

Delete...
Select the node that you want to delete and then press the delete button.

Edit...
Select the node that you want to edit and press the edit button. It is also possible to edit the node by
selecting it and double click the left mouse button.

! |p-address 127.0.0.1 is not an example!
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Section 4 Configuration and Customization SIM EWS R2.6.3.1

Configured nodes

The EWS main Configuration panel is used to configure the local node type VF, as well as remote DICOM
nodes if present.

NOTE

The Node type VF must be configured first, before Configuration Remote DICOM Node p. 87 is done.

On the configuration main panel (Figure 4-3 EWS Main Config Panel & VF node Config Panel (example)):
Select: node type: VF
Press: New...

The EWS Configuration panel will be displayed see Figure 4-3 EWS Main Config Panel & VF node Config
Panel (example)

4.3.1.3 ViewForum configuration settings on EWS (step 52)

ViewForum system name
Check or enter a human readable name for this Extended MR Workspace R2.6.3.1.

MAC address
Check or enter the MAC address onboard NIC (for value see Reference sheets).

IP node name
Check or enter IP node name of the system. IP node name must be the same as the Computer Name setting
in Windows XP and unique on Hospital network (for value see Reference sheets)

NOTE

If IP node name is not correct:
Change “Computer Name” in Windows XP x64 (see paragraph 3.3.4 Change Computer name p. 46).

IP address
The IP address of the local node must be: 127.0.0.1

Memory size in Mb

The indicated value must be equal to the actual memory size of the Extended MR Workspace R2.6.3.1. The
correct value will be entered automatically when clicking the Automatic Configuration button.

Dell T5500: 6GB

Dell T7400: 8GB

Dell 690: 8GB

Dell 670: 6GB

Memory tuning
Selecting "Huge datasets" causes EWS memory to be tuned to a great amount of small images that are sent
by the MR-scanner ("Functional MR" facility on the MR scanner). In all other cases: Standard is fine.

Monitor type
Default the application expects a 75 Hz CRT, this must be changed into:
LCD color

Multi Monitor Settings
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SIM EWS R2.6.3.1 Configuration and Customization Section 4

Default: disabled

Enable this option when there are multiple monitors connected and one of the monitors must be dedicated to
Extended MR Workspace R2.6.3.1, while the other monitor(s) can be used for other applications. Also
specify which monitor must be used for the EWS application.

- Multi Monitor Settings

| Display ¥F on specified monitor

Monitor no. from left=1 to right-n 1

Exit |

Figure 4-4 Multi Monitor Settings

When there are two monitors connected to the Extended MR Workspace R2.6.3.1, the EWS application can
also be extended to the other monitor (Dual Monitor: Extended modus) or both monitors can be set-up as
exact copies of each other (Dual Monitor: Clone modus). How to do this is described in Section 2: Windows
XP x64 customise settings.

43131 Touch Screen Module (TSM) Settings

Not applicable for the EWS

43.1.32 Peripheral Settings

The Peripheral Settings panel Figure 4-5 Peripheral Settings panel is displayed when selecting the
Peripheral Settings.... button on the EWS node configuration panel ( Figure 4-3). In this panel all peripheral
units such as a DVD Recorder and printers can be configured.

See section 3.3 Post Image-Installation steps p. 38 for identified DVD-drive letters
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Section 4 Configuration and Customization SIM EWS R2.6.3.1

7. Petipheral Settings

Recordable drive [+ Present

Hame | Recordable drive on EWS
Drive letter 'E
Attribute filtering (store) % Allow all attributes
Attribute filtering (retreve) % Allow all attrbutes
| Don’t store Presentation State SOP

| Don’t store private SOPs

CD/DVYD Reader drive v Present

Name | CD/DVD-Rom drive on EWS

Drve letter F

Attribute filtering (retrieve) % Allow all attributes

Printer name IfF type  Type DevicelD Related AE title
DICOM DryWiew 8700 DICoM Kodak-Dry\Wiew-8700-DICOM ML

Drystar 5300 DICoM Agfa-Dry5tar5300-DICOM DRY33

Drystar 5302 DICOM Agfa-Drystar5302-DICOM D55302

DryPi= <4000 DICom Fuji-DryPix4000-DICOM DRYPIx

Delete | Edit ... New ... &| picom
Exit

Figure 4-5 Peripheral Settings panel

4.3.1.3.3 DVD Readers and Writers

On the Peripheral Settings panel (Figure 4-5 Peripheral Settings panel), enable the corresponding
checkboxes when media used for writing: Recordable drive and/or media used for reading: CD/DVD
Reader drive are present.

The name can be changed into a more meaningful name, so that it is recognizable in the EWS application.

Name

Enter a freely chosen name for the selected drive, this name will also be shown in the user interface.

It is recommended that when e.g. DVD is selected, this is mentioned in the name. This will help the end-user
to recognize the drive in the EWS application.
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SIM EWS R2.6.3.1 Configuration and Customization Section 4

Drive letter
Enter the correct drive letter for the selected drive (see identified driveletter values on Reference sheets)

Attribute filtering (store)
This configuration option is not available for CD/DVD Reader drive.
Select the attribute settings that must filtered out when writing data to the CD/DVD Recordable drive.

Select one of the following options:
Allow all attributes (=Default)
Allow only ViewForum attributes
Allow only PMS attributes
Allow only DICOM attributes

Attribute filtering (retrieve)
Select the attribute settings that must filtered out when reading data from the CD/DVD recordable drive or
CD/DVD Reader drive.

Select one of the following options:
Allow all attributes (=Default)
Allow only ViewForum attributes
Allow only PMS attributes
Allow only DICOM attributes

Don't store Presentation State SOP

Default: disabled

This option can be enabled when images need to be viewed in an external viewer (e.g. Xcelera viewer R1.x
/or EFILM R1.9.3), which doesn'’t support these Presentation State Sop classes.

Don’t store private Sops

Default: disabled

This option can be enabled when images need to be viewed in an external viewer (e.g. Xcelera viewer R1.x
/or EFILM R1.9.3), which doesn'’t support these private Sop classes.

43.1.34 Printers

Select New... on the Peripheral Settings panel (Figure 4-5) to add a printer connected to this Extended MR
Workspace R2.6.3.1. A printer can be defined as either a DICOM printer or a Paper printer. If one or more
printers have already been configured, highlight the printer and click Edit... to modify or click Delete to
remove the highlighted printer.

NOTE

If the SCP doesn’t support the DICOM Presentation LUT sop class (e.g. printing only blank papers). Disable
the checkbox “presentation LUT” of the SCP Extended settings.

The following panel will become visible when defining a new printer (example):
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Section 4 Configuration and Customization SIM EWS R2.6.3.1

. DICOM printer configuration

Printer type 2| 3M-8100DICOM

Printer name | DICOM Printer 1 e

Related DICOM Hode AE title % IMH_9410

Configure media list... |

Proceed | Cancel |

Figure 4-6 Printer configuration editor (example)

Printer type
Select a printer type from the list of supported printers for the selected interface type (DICOM or Paper).

When paper printer is selected, a list of the printers known in Windows is listed. From this list a printer can be
selected. So before a new paper printer can be defined in Config, it has to be defined in Windows first.

Printer name
The name of the printer as it is to be shown in the user interface. This name must be unique in the cluster.
Max. 30 characters including spaces, illegal characters: \ "

Related DICOM Node AE Title

This configuration option is only visible when defining a DICOM printer. The DICOM printer should already
be defined as a DICOM node.

Select a DICOM Node AE title from the list.

Configured media list...

This button starts the Media list editor. Depending on the selected printer, the film formats that are in actual
use at the site can be selected. The disabled formats are not shown and therefore not selectable in the
application.

=~ Media list configuration

Configured  Medium Size Medium Type Color Model Resolution Class

v | 14INK1PIN BLUE FILM | GREY_8 &| STANDARD

Exit

Figure 4-7 Media list configuration panel
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SIM EWS R2.6.3.1 Configuration and Customization Section 4

NOTE

The media list should never be empty!
At least one medium must stay selected (checkbox is enabled) otherwise it is not possible to print.

Exit
Saves the current selection closes panel to return to the printer configuration editor panel (Figure 4-6).

Proceed
Save all changes made after the last activation of the printer configuration editor and return to the Peripheral
Settings panel.

Cancel
Cancel all changes made after the last activation of the printer configuration editor.

Click Exit on the Peripheral Settings panel when all settings have been entered to return to EWS
Configuration main panel.

4.3.1.35 Audit Trail Settings

For logging of user and system behaviour (e.g. deletion/creation/modification of exams, login of users, etc)
the Audit Trail option is available on Extended MR Workspace R2.6.3.1. Audit Trail data can be logged via a
SYSLOG server running on another system or locally on EWS itself. SYSLOG servers are available on the
Internet, e.g. http://www.kiwisyslog.com/downloads.php. By default the Audit Trail option on EWS is
disabled.

Before enabling Audit trail Settings make sure that the time is synchronized! E.g. by using an Internet Time
Server (see section 3.3.6 Configure Internet Time Server p. 47)

The Audit Trail Settings panel ( Figure 4-8) is displayed when selecting the Audit Trail Settings.... button on
the EWS node configuration panel ( Figure 4-8).

To enable Audit Trail in combination with an external SYSLOG server:
— Tick mark Audit Trail enabled.
— Enter valid IP node name
— Enter valid IP address
—  Port number = 514 (Default UDP port)

To enable Audit Trail logging on EWS itself:
— Tick mark Audit Trail enabled.
— Enter anon-existing IP node name
— Enter a non-existing IP address
— Port number = 514 (Default UDP port)
On EWS the Audit Trail log files will be written in path:
C:\Documents and Settings\All Users\Application Data\PMS\ViewForum\Temp\AuditTrail\

Note that currently only a "UDP-connection” can be made to the system on which the SYSLOG server is
running.
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i Audit Trail Settings

[ Audit Trail enabled

IP node name | LocalTrail L

IP address | 192.0.0.2

Port number 514

Metwork Protocol E UDF

Exit

Figure 4-8: Audit Trail settings

4.3.1.3.6 DICOM AE title and DICOM Settings...

The DICOM settings panel for the EWS node as shown in ( Figure 4-9) is displayed when selecting DICOM
Settings... button on the EWS node configuration main panel ( Figure 4-3 p. 77)

CAUTION
When EWS Application entity title is modified all other “linked” modilaties need to be modified!

. DICOM Settings

Application entity title | WEMR1

Port humber 3010

Maximum PDU length @ Unlimited

Generate new SC UID@

SCU settings SCP settings
[v' Store as SCU [v' Store as SCP
[ Find as SCU [+ Find as SCP
[v Move as SCU [+ Move as SCP

[+ Printas SCU

Extended settings... | Extended settings...

Exit

Figure 4-9 DICOM Settings panel

The settings listed in this panel are the DICOM settings of the EWS system itself!

Application entity title
Enter the Application Entity title, (freely selectable, max. of 16 characters, case sensitive). It must be a
unique name in the cluster (network). For more general information about the AE title see also 4.8.1.
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Port number
Default value for EWS node: 3010 cannot be adjusted.

Maximum PDU length
Select the maximum number of bytes accepted by the system in each data transfer of a Protocol Data Unit.
Default: unlimited

Generate new SC UIDs
Default: enabled.

WARNING
Enabling this checkbox removes the presentation state of the SC images at export.

This is caused by changing all SC images UIDs during import.
Disabling this checkbox will result in a failure at import of series with a SC capture image in it.

SCU settings and SCP settings
In most cases the default values will be correct. See also 4.8.

Extended settings...
In most cases the default values will be correct.

When selecting one of the Extended settings... buttons the corresponding “Settings as SCU” or “Settings as
SCP” panel is displayed.
For more information see 4.8.

Click Exit on the DICOM Settings panel after all settings have been entered to return to EWS Configuration
main panel.

4.3.1.3.7 Create teaching Database
This checkbox enables the creation of a teaching database. (See also section 4.5.8 Teaching files p. 101)

Return to step 52

4.3.1.3.8 Image Database Location and Allocation (step 53)

On the EWS node configuration panel (Figure 4-10), the database settings can be defined:

Image Database Location and Image Database Allocation...

On the EWS system the Image Database Location is set to local.

The Image Database Allocation panel shows the partition settings of the system (Figure 4-10). Select

partition D and press Edit... to change the settings of the Image Database from 100.000Mb to 80.000 Mb or
make sure the size is 80.000 Mb.
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- Image Database Allocation

Partition name/Drive letter  Allocatable space (Mb)  Max. space to use (Mb)

; 28538 0
(o) B4732 20000
g 25763 0

I3 25300 1]

Edit...

Exit

¢ Image Database Parlition Settings

Partition name/Drive letter D: -
Allocatable space (Mh) 4732
Max. space to use (Mb) q aoong__D>

Proceed ) | Cancel |

Figure 4-10 Image Database Allocation and Partition settings panels

To prevent Windows XP x64 from automatically clean up the disk space,
select 80.000 MB (minimal: 1000 MB)

NOTE

The size of the Image Database may not be larger than 80 GB.

WARNING

Putting the database on another disk partition or creating a database of another size, results in loss of the
existing database. So when changing these settings on a configured system, make sure the image database
data is correctly backed-up.

Image database name
Enter a unigue name for the image database on this workstation; it will be used within the Application

program.
Max. 30 characters including spaces, illegal characters: \ " (See Figure 4-3 p. 77)

Image database identification
This is the MAC address of the system where the Image Database was located.
On an initial EWS “patientdb” is displayed.

SW license server location
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WARNING

On EWS R2.6.3.1 a remote SW license server location is NOT supported!

Proceed
When all configuration details are entered, press Proceed to return to the EWS configuration main panel.

Return to step 53

4.3.2 Configuration Remote DICOM Node(s) (step 55)

Besides the local EWS node and the MR-Host, other DICOM nodes present in the hospitals’ network can be
configured. Continue with this chapter to configure Remote DICOM nodes.

Check section 4.8 Extended DICOM Settings p. 112 for the correct settings of a PACS node.
CAUTION

Do not use the “Automatic Configuration...” button in case an iSite Pacs is configured
(see Figure 4-11 below)

On the configuration main panel ( Figure 4-3 p. 77):
Select: node type: DICOM node
Press: New...

The DICOM Node Configuration panel (Figure 4-11) will be displayed:
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- DICOM node configuration

DICOM node system name | di_client
IP node name | di_client Al
IP address [ 152.0.0.1
Application entity title | di_cli ent|
Fort nhumber IW
Maximum PDU length % Unlimited
[ Eleva EDI

Patient Administration Host ID |
[T Image archive

Storage commit system name % di_client

SCU settings SCP settings
Automatic configuration...

[v Store as SCU [+ Store as SCP
[v Find as SCU [+ Find as SCP
[v" Move as SCU [v' Move as SCP

[ Print as SCP

Extended settings... Extended settings...
Proceed | Cancel |

Figure 4-11 DICOM Node configuration panel

DICOM node system name

The name of the remote DICOM node as it is to be shown in the user interface. This name must be unique in
the cluster.

Max. 30 characters including spaces, illegal characters: \ "

IP node name
Enter a unique IP node name of the system.
When defining a MR-Host: Enter the MR-Host computer name.

IP address
Enter IP address of the system.
When defining a MR-Host: Enter IP address: 192.168.73.10.

Application entity title

Enter the Application Entity title, (freely selectable, max. of 10 char., case sensitive). It must be a unique
name in the cluster (network). For more general information about the AE title see also 4.8.1.

When defining a MR-Host: Enter the AE title as is defined in the Connectivity Configuration\Local system of
the MR-Host.

Port number
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Many different protocols (FTP, HTTP, Telnet and DICOM) can be using TCP at any time. By using port
numbers these applications are identified. The combination of TCP port number and IP nhumber is called the
Socket Address.

A TCP connection is defined by the combination of the local Socket Address and the remote Socket
Address. By keeping the IP numbers network wide unique and the TCP port number unique inside a system,
each TCP connection is uniquely identified by the combination. The TCP port of the partner called during a
connection initialisation must be known. This can be either an agreed port number between two applications.
Examples: The Extended MR Workspace R2.6.3.1 listens on port number 3010, Siemens has port number
104.

When defining a MR-Host: Enter port number 104 (default setting for initial MR-Hosts, since R2.6.3) or 3010

Maximum length

Select the maximum number of bytes accepted by the remote DICOM node in each data transfer of a
Protocol Data Unit. Unlimited is the default value. EWS will not send PDUs of greater size to this DICOM
node. For DICOM transfer with GE- systems, 65536 bytes is recommended. Do not select Unlimited if you
are not sure.

Eleva EDI
Default: disabled
This checkbox should only be activated if the EWS System is part of a DI configuration.

Patient Administration HostID.
When the checkbox “Eleva EDI" is enabled. The IP address of the patient administration system should be
entered.

Image Archive
Default: disabled
This checkbox should only be activated if the remote DICOM node is used as a DICOM archive (e.g. PACS).

To configure a PACS Worklist, the extended DICOM SCP settings have to be changed: the checkboxes of
the Patient Root Query must be disabled.

CAUTION

Make sure that only one node is marked as Image Archive (although it is possible to configure more
than one DICOM node marked as Image Archive, EWS can only handle one Image Archive).

Storage commit system name
Select a system name of the storage commit system. The system name can only be selected when the node
is already configured as a DICOM node and the Image Archive checkbox is activated.

SCU settings and SCP settings

In most cases the default values will be correct. See also 4.8.
Automatic configuration...

Press this button to check if the Dicom node is configured correct.

Extended settings...
When selecting one of the Extended settings... buttons the corresponding “Settings as SCU” or “Settings as
SCP” panel is displayed.

In most cases the default values will be correct, but there are two exceptions:
The default extended settings MUST be changed when configuring a PACS Worklist, a DSI as an external
DICOM node or when configuring an EasyVision Classic (as a DICOM node). See 4.8 for more information.
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Section 4 Configuration and Customization SIM EWS R2.6.3.1

When finished, select Proceed to confirm the settings and return to the configuration main panel. Select
Cancel to return to the configuration main panel without saving the settings.

Return to step 55
4.3.3 Execute EWS Configuration (VF) (step 56)

To avoid problems, close the EWS Application (when started) before executing Configuration.
On board network adapter is connected with Hospital LAN.

Click Execute.... on the configuration main panel (Figure 4-3 p. 77) to perform the actual configuration of this
Extended MR Workspace R2.6.3.1. A panel appears with the following text:
Keep existing local image database
Keep existing teaching database
These checkboxes can only be enabled if a correct and compatible (teaching) database exists.
WARNING

The image/teaching database will be deleted if this option is not activated!

Click the Proceed button to execute the configuration. This might take 5-15 minutes depending on the
database size.
When finished, click Exit (and Confirm) to exit the configuration application.

When executing the Configuration:

- the Config.cfg file is saved to directory:
C:\Documents and Settings\All Users\Application Data\PMS\ViewForum\ConfigRepository
and saved to dbadmin (Backup, mostly found on D:\ drive).

- the Winhostfile will be updated

- the Config Repository will be filled

- the new image database and teaching database are created (initial install only)

- the license file will be updated and saved in dbadmin folder.

- the Configuration.pf file will be created and saved in dbadmin folder

WARNING

Directory /dbadmin is NOT overwritten when you re-install the software.

Return to step 56

4.3.4 Start MR Configuration (step 57)

To start MR Configuration:
Loginas: MRService
Select: Start > Philips = Configuration Tools = MR Configuration:
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& Philips fa Configuration Tools 4 &5 EwS Configuration
Diagnostic Tools [Amm MR Configuration
@' Set Program Access and Defaults 0 N ] 2

. qﬂ Installation Tools > @) SetLogging Level
&~ Windows Catalog £R Enable Remote Access

Examcards Offline Editor
[ Extended MR Workspace
< Documents » &] NetForum

B) Settings 4
}) Search 3

@) Help and Support

[m Programs

Windows XP Professional x64 Edit]

=] Run... -
[r]
E B Hour | 2l nirom Nede
Return to step 57
43.4.1 MR System Reference Number (step 58)
Select System Reference Number
Systemn Configuration
=} Systemn
- & Systermn Reference Mumber
B Institution Details
- @ Philips Service Agent
=} Software Options
- & Register Permanent Key
& Edit Temporary Keys
- @ Edit Software Options
B Show Enabled Software Oplions
- & Show Keys
B Show Software Options
=5 Connectivity
DICOM Image MNumber Direction
Enter System Reference Number:
Swstem Reference Number
System Reference Number: ooooo
Set Syetemn Reference Murmber To: oooao
Click Apply - Ok
Return to step 58
4.3.4.2 MR Institution Details (step 59)
Select Institution Details
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4.3.4.3

|

Apply Cancel ‘

Enter Institution Name
Department Name:
#% FSFConfigUl
Systern Configuration
B~ System
- & Systern Feference Mumber
Fj Institution Details
- B Philips Service Agent
B Software Options Inztitution MName:

- & Register Permanent Key
& Edit Temporary Keys
- i Edit Softwars Options
i Shew Frahled Snftuware Ontinns

Click Apply - Ok

Return to step 59

Deparment Name

MR Philips Service Agent — PSA (step 60)
Select Philips Service Agent
Check:
Click: Pick...
Click: OK
Select: Production (Presets)

& FSFConfigUl

Systermn Configuration

= System
----- & Systern Reference Murmber
----- E' Institution Details
..... : .
B- Software Options
----- & Register Permanent Key
----- & Edit Temporary Keys
----- E Edit Software Options
----- E' Show Enabled Software Options
& Show Keys
B Show Software Options
=) Connectivity
DICOM Image Number Direction
Heln
Configure the Philips Service Agent on the
EWs
Pick a systern identifier: @\
* from license file 7
Cancel
001aa0c1h79f
" pick Metwork adapter
\ [

Apply ‘ ‘ Cancel ‘

ble Philips Service Agent

Agent [dentification
Identifier (MAC)

001aalc b9t

Enterprize Server Details

Fresets:

Frotocol

hitps

N ServerAddress: |192_58_49_50

Developrent Server Port

|443

Proxy Details

Froxy Address

Prowy Port

Usetmame |
Password |

Note

A Proxy Server / Nat-Routing at the Hospital may give cause for filling in 'Custom’ settings
(see below)
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Click: Apply > Ok*
Proxy settings

The Philips Service Agent needs to be able to communicate with the Enterprise Server. Depending on the
hospital network infrastructure a proxy server could be required to enable this communication. In this case
the following details are required also:

* Proxy address,

* Proxy port (e.g. 8080),

* Proxy Username (optional),

* Proxy Password (optional).

Testing the connection:

Testing whether a connection between the Philips Service Agent and the Enterprise Server could be made
over the network is done in the following way:

* Open a command prompt (Start -> Run... in the textbox enter ‘cmd’)

* In the commandbox enter "PortQry.exe -n ServerAddress -e 443 -nr-, where ServerAddress is
the ip address you entered in 'Enterprise Server Details'

* The response should look like this, all other responses point to a network problem:

Querying target system called:
ServerAddress

TCP port 443 (https service): LISTENING

Return to step 60
4344 MR Permanent Key (step 61)
Select Register Permanent Key
Enter Permanent Key, same as R2.6.3.x MR-Host:

Permanent Key

Swstern Reference Nurmber: 00000
Lock Type: 12101

PermanentKey:  [FHH-HHEH-REHEFEREE

Caomment: |

Click Apply > Ok

Return to step 61

4.3.45 MR Temporary Keys (step 62)

If applicable
Select Edit Temporary Keys
Enter Temporary Key(s), same as R2.6.3.x MR-Host
Click Activated Checkmarks

! The changes are immediately activated
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Temporary Keys

Systemn Feference Mumber.  oooon
Lock Type: 12101

Temporary Key Activated

|?9r23ymhwx—pwu2p—dkenk | v

|hpBw3—puf3xmvx2 p-cz89k | v

Click Apply - Ok

Close

Window via click on El

Return to step 62

Comment Status

Expires 12-DEC-2007

Expires 12-DEC-2007

4.3.4.6 MR Show Enabled Software Options
Select Show Enabled Software Options
to check settings:
Systermn Configuration Cancel
= Systemn
- System Reference Number
o B Institution Details Enahled Software Optians
= Software Options
-8 Register Permanent Key System Reference Number: 00000
& Edit Temporary Keys Lack Type: 12101
T Edit Software Options
T w Enah Software Option Expires
“® Show Keys Basic SW 12-DEC-2007
o B Show Software Options
. SMART-Scan spine 12-DEC-2007
=~ Connectivity
: DICOM Image Murmber Direction IHE Workflow 12-DEC-2007
4.4 APPLICATION USER ID’S
Application UserID Initial Menu / Action
Password"
Administrator password Application administrator to manage application user settings.
MRUser MRUser Application user based upon “MR User” profile.

Table 8 Passwords pre-installed application

4.5
45.1

users

USER CUSTOMIZATION

Language setup <EWS User> (step 64)

NOTES

See section 3.3.2 Installation of Additional Languages (step 46) p. 41, when required language is not
installed during step 43 Installation MR Application Software p. 64

login as

This procedure will change both Windows Ul as MR application Ul for <EWS User>
ViewForum language settings for application users are described in

MRUser or MRService

! See also section 6 Reference sheets

user documentation.
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Section 4

Select: Windows Start - Settings = Control panel
The Control Panel appears (see Figure 3-5).

B Control Panel

File Edit View Favorites Tools Help

@Bazk 0 lﬁ psaarch [ Foders | [25] -

Address [} Control Panel

ﬂ’ Control Panel Pick a category

G Switch to Classic Yiew

See also

=
_ & Appearance and Themes
-

9 Help and Support '__
o Cither Control Panel - Network and Internet Connections

Cptians -
% Add or Remove Programs

- ‘.’J} Sounds, Speech, and Audio Devices

\a Petformance and Maintenance

Printers and Other Hardware

. UserAccounts

Date, Time, Language, and Regional
Options

Accessibility Dptions

» Security Center

Figure 4-12 Control Panel Category View

Make sure “Category View” is selected.

Click: Date, Time, Language, and Regional Options
Select: Regional and Language Options
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Regional and Language Options [ 7] ] Change Regional Options

Regional Options  Languages

?/ You must logoff and logon again before the new Ul Language setfi

Test services and input languages =
Lil\.’igiﬁl?ﬂcehlz?s the languages and methods you can use fo enter Do you want to logoff now?
e
Supplemental language support
e
r
I
La
Wm/@
Rt
ot
e
ok | Cancel ﬂ:pbﬂ“
1. “Languages” tab
2. Select Language used in menus and dialogs
3. Click “App'y”
4. Click “Yes” (Do you want to logoff now?) > “OK”
e Close Window

Repeat procedure for other users

Return to step 64

45.2 Disable Windows CD Recording (step 63)

Loginas MRService
Start Windows Explorer
Right-Click on the DVD-RW drive (see Reference sheets)
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Select

Select
Disable
Click

Close

Properties:

File Edit View Favorites Tools Help

e Back @ - L@ |/’j Search |[1:: Folders ‘ V

Address |E| CiDocuments and SettingsWFSericelUsenStart Menu

Folders * g‘?e =
rograms
2 WINDOWS —I Y desktop.ini
e Data (D)
4 DVD Drive (E)
aH 0
Expand
Explore
Open
Search...

Sharing and Security...
Write these files to CD

W Scan for threats...

Eject

Copy

Properties

Tab “Recording”
Checkbox “Enable CD recording on the drive”

“OK":
DYD-RW Drive (G:) Properties EE

General I AutoPlay I Hardwaye |

Sharing | Norton Ghost

|y These settings determine haw the ‘Windows CD recording
software wites filez to this CD-R drive:

- Desktop CD recording

Select this check box to record COz by dragging files and
folders to the CO-R icon on your compLter

@HSBIE'E'D""r'éEBr'Hi'rié"é'h"i'ﬁi'é"a}'i'(ééé
Select a dive where Windows can store an image!’ of the C0
b bewritter, The image file maywse up to 1 GE of disk space

<@ Sustem [C:] 'l

Select a wite speed. Higher speeds take less time, but if they
cause enars, select & [owen speed.

Fastest 'l

rd Autamnatically eject the ED after wiiting

N\
( oK I) Cancel Apply
vl

Window

Return to step 63

4.5.3

Set Files and Folders view (step 65)

The files and Folders view settings have been adapted for the Administrator user already. For the MRUser ,

MRService and Remote user these settings must be changed as well.

Perform the following steps for MRUser, MRService and Remote user
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Logon as: MRUser
(for initial and final password: see Reference sheets)

Set Files and folders view

Select: View from Windows Explorer menu bar
Enable: Details

Select: View from menu bar
Enable: Status bar

Select: Tools from menu bar
Select: Folder Options

"Folder Options”

Select: tab: View

Enable: Show hidden files and folders

Disable: Hide extensions for known file types
Press: Button: Apply to all folders
Press: Yes to confirm
Press: OK to close folder options panel
Close: Windows Explorer

Logoff: MRUser
Logon as: MRService or Remote user
(for initial and final password: see Reference sheets)

Repeat the above steps.
Synchronize passwords on EWS and MR-Host
Users on MR-Host with an identical username as on EWS, need to have an identical password, to get

access to the OfflineShare Folder (see section 4.7.3 p. 108).
Default EWS and MR-Host already have the same user “MRUser” .

Return to step 65

454 Remove password expiry for (XP64) MRUser (step 66)

For security reasons, the XP64 password of the EWS users will expire after 90 days. This may not be
desired or user friendly for some customers and therefore it can be changed.

WARNING

Changing the password policy may impair security of the EWS system, therefore this should be done with
consent of the customer, making clear that any security risks are the responsibility of the customer.

Login as MRService (XP64)

Go to Start Menu = Settings = Control Panel - Administrative Tools > Computer Management
On the left panel select ‘Local Users and groups’

On the right panel double-click ‘Users’

Double-click ‘MRUser’

Select the checkbox ‘password never expires’

Click ‘Ok’ to confirm and log out.
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SIM EWS R2.6.3.1 Configuration and Customization Section 4

Return to step 66

455 Adjust Password Policies (XP64)

Logon as: MRService
Click Start > Run...
Enter secpol.msc
Click + Account Policies - Password Policy
Double-click Minimum password length

Changeto O
i Local Security Settings Minimum password le
File Action View Help Lacal Secuily Setling | Explain
El ENNE Minimum passwiord le
=

53 Security Settings

=8 Account Policies
Password Policy

: (& Account Lockout Policy
{} Local Policies

{1 Public Key Palicies

i 0 S afhinrn Dactriction Baliciae

Palicy | Security Setting ‘

%) Enforce passward history 24 passwaords remembered

[28] Masimum password age 90 days

Minimum password age 1 days Mo pagsword required.
(5 IMinimum password length 7 characters
[24]Password must meet complex,.. Disablad
24 Stare passwards using reversi.. Disabled

[ J::I characters

Figure 4-13 No password required

Double-click Maximum password age

Changeto O
s Local Security Settings
File Action View Help Local Securty Setting | Expla
& EXE Maimum passwon
[ Security Settings Falicy ‘ Security Setting ig‘
=-L8 Account Policies [88]Enforce password history 24 passwords remembered
\ (8 Password Palicy Maximum pa d age

Passwaord will not expire.

0 E days

Figure 4-14 Password expiration disabled

Close Window

45.6 Set password user Remote (XP64) (step 67)

The password for user Remote needs to be set, before it can be used for remote support
Logon as: Remote, password ViewForum1
Enter New password 2x
Register new password on Reference sheets.
Communicate new password with your service organisation

Return to step 67

45.7 Hide/unhide example application users (step 69)

In the EWS application software, there is one dedicated user defined for a typical EWS environment:
e MRuser (role MRUser)
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SIM EWS R2.6.3.1

Beside this user, there are typical example users:
e CT/MR user (role Physician)

e CVuser

e Surgery user

User accounts

users | Roles |/ Hospital |

MRUser

Physician

Radiographer

Referring physician
Senior radiographer
Surgical C-arm operator
Systen administrator

Figure 4-15 User roles

Loginas MRService
Any, or all off these users can be enabled/disabled via the following procedure:
To enable (unhide) example users:
Start: Extended MR Workspace
Login as: administrator (password: password or Password1*)
Select: Options - Edit user accounts from the menubar

On the user accounts panel:
Double click: on desired user (e.g.: RF user):

User accounts o

[0 X 2 o i 1 B 2 o

users || Roles || Hospital |

view | all roles ﬂ

administrator
CT/MR user

W ouser

ews (no passwd)
MRUser

RE ienera1 user

RF Wascular user —]
Surgery user
TSM user

Figure 4-16 Example users

On the user profiles panel:
Remove: password (empty password field)

! Factory Image installed EWS

Page 100 of 164 CSIP Level 1 (09.0) 4522 170 12901/level 1.2

This document and the information contained in it is proprietary and confidential information of Philips Medical Systems ("Philips”) and may not be reproduced,
copied in whole or in part, adapted, modified, disclosed to others, or disseminated without the prior written permission of the Philips Legal Department.

© 2009 Koninklijke Philips Electronics N.V.
ALL RIGHTS RESERVED




SIM EWS R2.6.3.1 Configuration and Customization Section 4

Select: a Log-on action (e.g. View default Worklist)
Press: OK and close panels
Close: Extended MR Workspace application
It is now possible to logon with the example user
To unhide more example users, the above steps must be repeated.

To disable (hide) users:
NOTE

After the SW (re)installation, the example user MRUser is default enabled.
This might be undesirable and can be corrected by following steps

Start: Extended MR Workspace
Login as: administrator
Select: Options - Edit user accounts from the menubar

On the user profiles panel of the selected user:
Select: Disabled (user hidden) as Log-on action:

User profiles

Logon | Workflow | Views | Permissions || Printer |

Name | MRUser 4l

Password | #wree

Again | e

Role ‘ MRUser ﬂ
Log-on afion ‘ Disabled (user hidden) .

Lock if inactive for 0 minutes
Language ‘ English ﬂ

0K | Cancel | opply |

Figure 4-17 Disable example user MRUser (example)

Press: OK and close panels
Close: Extended MR Workspace application

Return to step 69
4.5.8 Teaching files (Optional)

45.8.1 Introduction

In addition to the set of clinical demo DVDs that are delivered with the software, the EWS software contains
a small selection of clinical teaching cases (see section 4.3.1.2 EWS Configuration Main panel explained p.
77 where “Create teaching Database” checkbox needs to be enabled). These are available in the “test
repository” and need to be copied to the database to allow all viewing facilities. Also the Customer Service
test images can be found here. The teaching cases allow immediate viewing exercises even without a
modality being connected. In this way a user can quickly familiarize with the basic concepts and workflow
characteristics of Extended MR Workspace R2.6.3.1.

4582 Copy teaching Files to Image Database

Login as: MRUser (initial password: see Reference sheets)

Application main menu:
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Select: Data management ( Figure 4-18)

Options ~ Hulp

O

Use F2 1o loggle bebwen screens

Databasadsc Test Répasitory x|
| Patfemes ' e
| sl
{3 VF CRTNOMPA - Lat, Child 12y | aching a2 | M| 17-May-19%0
] VT CTICTA, VASC AOTH STENT | echion e 4 | W 21-0ut-1831
VF MR patieet Brain & Knoo Seachiog e d | M| 17-Ma-1865
m VF AF vazcular, biain eaching fia 1 | F 30 Jul= 1540
(7| VF sarvice Tast mages teachingfieS | 7 | Di-Fen-2003
] Status of backgmound tasks
i M| P | Transter | €0 |
ol Mt | Prograss | N | dowes | Taest: | Sbmittar | et tim 'Eml;mul.j
2,| s | Submmed oso VF RF vastuls, Brain Test Repastory | Teaching DB on NGTY Ligar NG1Y T4=Apr=2003 1435068 | @ o
|- _ | Swbmmed | 0/0 WF Service Tert Images Teat Aepostory | Teaching O on NGT1 | User NGI1 | 14-Apr-2003 14:35.06 | @ o
k3] | Compteted | 1324192 | VF T CTA, VASC AQTHSTENT | TestFepostory | Teaching DO on NGI | User NGIY | 14-Apr-2003 143508 | 0 ] Dongy
Empiuling | 27243 | VF MR pokent Brain & Knin Tst Ropostory | Toaching DB an NGIT | User NGTT | 14-Apr-2003 143508 | 0 (1] |
Complated | 474 WF CH Thbi PA « L8t Child 12y | Teot Repostany | Teaching DF on NGTT | Uear NGIY | 14=Apr-2001 143505 | 0 o l)onﬁ
|
4
v Copy a
Databasahisc | Twaching 08 on hall T
[Pattents o[s
3| VP CTCTA, VASC AQ TH STENT | teaching fie 4 | M | 21-Jul-1531
m VE CH Thon PA « Lal, Child 12y | Waching e 2 | M 17=May-1%%0
m VF MR pataet Brain & Knes leathingfied | M 17=Mar=1965
&
o0
£
LE3

Figure 4-18 EWS data management panel

Select: Split View

Open Test Repository in one of the split views:
Select: Test Repository in the Database selection bar
Select: All files in Test Repository

Open the Teaching Database in the other split view:
Select: Teaching Database in the Database selection bar

Copy all files from Test Repository to the Teaching Database:
Press: "Copy to" arrow (See Figure 4-18)

The files are copied to the EWS teaching database and are ready for use.

4.6 EWS CUSTOMIZATION SETTINGS

The “EWS Customization” can be found in the Viewing environment under “Options”. The settings that can
be adjusted depend on how you are logged in into the EWS (as a User or as an Administrator):

Loginas MRService (if needed)
Start: Extended MR Workspace
Login as: MRUser or as administrator
Select: Options from menu bar
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SIM EWS R2.6.3.1 Configuration and Customization Section 4

Now you can customize for example auto-push and auto-delete settings, print and display protocols, window
presets, toolbars and work lists here.

Some more specific information about some of the Customization settings can be found below.
Also see Extended MR Workspace R2.6.3.1 Instructions for Use.

4.6.1 Check OpenGL support settings (step 70)

Check “Use for computation of 3D Images” checkbox is set.

Loginas MRService (if needed)
Start: Extended MR Workspace

Login as: MRUser or as administrator
Select: Options from menu bar
Select: edit system settings:

ﬁﬁ] Edit user accounts...

'@j\ Edit system settings...

Select: Tab: Video Board Settings

Check/

Select: Video Board from the supported Boards list*
Check: *“Use for computation of 3D images”:

System settings

Colour scheme | Protections =~ Auto-delete | Language | Storage Video Board Settings

Video Board Settings

Video Board NWIDIA Quadro FX 4500 See Note!
/

Supported Boards 2| HVYIDIA Quadro FX 4500

@e for computation of 3D images

oK | cancel | Fpply |

Figure 4-19 Computation for 3D Images setting

Select: Apply > OK
NOTE

Make sure that:
The Supported Boards displays a video board.
The Unified back/depth buffer option is turned off (default), as described in 3.3.19 p. 62

Return to step 70

! Extended MR Workspace R2.6.3.1 is delivered with a Video card which supports OpenGL. Upgraded
ViewForums might not support OpenGL.
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Section 4 Configuration and Customization SIM EWS R2.6.3.1

4.6.2 Auto-push to PACS settings (step 71)

The auto-push function sends the delta information of a case to the destination node on the moment the
case is closed (e.g. when closing EWS or when switching to a new case). Although almost all nodes can be
configured as an auto-push node, it only makes sense to do so for an archive.

Workflow example when a PACS is configured as auto-push node:
case is retrieved from the PACS

case is diagnosed and captures are added

case is closed.

On this moment the newly added captures are sent to the PACS.

Customization of the auto-push setting can be done as follows:
Login as MRService (if needed)
Start: Extended MR Workspace
Login as: MRUser or as administrator
Select: Options from menu bar
Select: edit system settings
Select: Tab: Storage

System settings

Colour scheme | Protections | Auto-delete | Language | Storage | Video Board Settings |

[ Create new study when storing captured images

| frchive ﬂ Auto-push destination

Figure 4-20 Auto push

Return to step 71

4.7 FINAL CUSTOMIZATIONS
4.7.1 McAfee Virus scanner setup

Login MRService User + <Password> on EWS

Right-Click McAfee icon in System tray:

U

Click On-Access Scan Properties > All Processes > Detection Tab >
Exclusions.. 2> Add..

Select By file type
Enter DA?
Disable checkbox “On write”
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Leave

Click

4.7.2

checkbox “On read”:

»- Add Exclusion Tkem el |

—What to exchude
By namedlacation [can include wildeards = ar 2)

I Brawse... |

I™ Also exclude subfolders

& By file twpe [can include wildcards * or 71

IDA? Select... |

= Buyfile age:
Access type: inimurm age in days:

[Madified = =

£~ Files protected by ‘Windows File Pratection

—When to exclude
¥ Onread

ak. I Cancel Help

“0k” > “0k”

Barco Monitor Calibration (step 72)

The Operator console calibration needs to be repeated every 6 month'’s.

Login MRService + <Password> on EWS

Connect Barco Calibration Device on front USB-port.

Note

First-time connected, the Barco sensor is identified as New Hardware:

Click

“No not this time” — “Next”

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
Windows will seaich for current and updated software by

Inoking on your computer, on the hardware installation CD, of on
the Windows Update \Web site (with your permission)

Can Windows connect to Windows Update to search for
software?

™ Yes, this time only
" ‘Yes, now and every lime | connect a device

&

Click Next to continue.

T oo I e |
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Click

Click

Select

Click

Click

“Install from a list or specific location (Advanced)” — “Next”:

Found New Hardware Wizard

This wizard helps you instal softwars for:

USE Device

\.') If your hardware came with an installation CD
2 or floppy disk, insert it now.

‘What da you want the wizard to do?

O Install the

tall from a list or spec

location [Advanced)

Click Mext to continue.

[ <BackC([ Hew> D[ Cancel

“Browse..” — “Next’:

Found New Hardware Wizard

Please choose your search and installation options.

(@ i5earch far the best driver in these lacations

Use the check hoxes below to limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed

garch remavable media (floppy. CO-AOM...]

clude this locaion in the saarch
FA\B90Wideo ‘.

© Don't search, | will choose the driver ta install.

Chaose this option to select the device driver from a list. Windows does not guarantes that
the driver pou choose will be the best match fior your hardsare,

[ <Back ([ Hew> ) Cancdd |

“C:\Program Files\Barco\Medical LE\Drivers\gmb_usbdrivers”

“OK™:

Browse For Folder

Select the Folder that contains drivers For your hardware.

# |5 Documents and Settings ~
= I3 Program Files
= [2) Barco
= I3 Medical LE
15 displayfunctions

1864

(5 sensar i

To view any subfolders, dick a plus sign above.

C o]

“Next”:

Found New Hardware Wizard

Please choose your search and installation options.

(%) Search for the best diver in these locations,

Use the check boxes below to limit ar expand the default search, which includes local
paths and removable media. The best diver found will be installed.

[ Search removable media (floppy, CO-ROM...]

Include this location in the search:

C\Program Files\B arcoMedical LE \diivershamb_us [

(O Don't search, | will choose the driver to install

Choose this option to select the device driver from a list. ‘Windows does not guarantee that
the diiver you choose will be the best match for your hardware.

[ <Eack(_l_[ Meat > D[ Cancel
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Click “Continue Anyway” — “Finish”:

Hardware Installation

pE The software you are instaling for this hardare:
.

GretagMacheth Calibrator

has not passed Windows Logo testing to verify its compatibility with

this version of \windows. [Tell me why this testing is important)

Continuing your installation of this software may impair
or destabilize the comrect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

@nntinue Arguay | LOTOF letalaion |

Continue with the actual calibration.

Double-Click “Medical Le” Icon on Taskbar:

BARCE

Found New Hardware Wizard
Completing the Found New

Hardware Wizard

% GietagMacbeth Calibratar

Click Finish to claze the wizard

=D

The wizard has firished irstaling the softvare far:

i) Found New Hardware

‘our new hardware is installed and ready to use,

Istll‘lthn calibration of the display(s).
!

Click *“LCD”

® LCcD O CRT

Click to select LCD display hardware type

Click “NEXT”

Follow instructions on screen to perform calibration.
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Click .
To Close Barco tool (Note: calibration is lost when Barco Tool is nhot closed before
you logoff)

MediCal® LE

p | £ ) TEST PATTERNS...

D ) (ALIBRATE...

) Options..

MediCal LE: calibration is enabled
After calibration: m 10:14AM

Return to step 72

4.7.3 Map Offlineshare for Examcard Offline Editor (ECOLE) (step 73)

CAUTION

On MR-Host the EWS IP-name must be identical with the EWS computer name and vice
versa (see also section 3.3.18 Network Configuration Example p. 59)
On R2.6.3.x MR-Host:
For every <MR User> on MR-Host, configure ECOLE:
Go to Acquisition context
Right-click Examcard Hospital folder tab
Select Refresh EWS Nodes:
& Philg I
. @. Export Configuration As...
FEnBox
. Export ExamCard Database As...
@ smartspine

Import ExamCard Database 4
Select ExamCard Database s
Restore Database
Return to step 73
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4.7.4 Transfer of R2.6.3.4 MR-Host Configuration to EWS R2.6.3.1 (step 73)

CAUTION
Transfer Configurations are restricted to:

R2.5.3.x MR-Host - R2.5.3.1 EWS only
R2.6.1.x MR-Host - R2.6.1.0 EWS only
R2.6.3 SP1, SP2, SP3 MR-Host 2 EWS R2.6.3.0 only

R2.6.3.4 MR-Host 2 EWS R2.6.3.1 only

On R2.6.3.x MR-Host (Acquisition context):
Right-click Examcard folder tab
Select Export Configuration As...

@ Phiips @ Hospital | & B
E’Hospital S Export Configuration As...

Export ExamCard Database As...
O InBox .  ExamCard Datab X
o test Sn'lIDO : xamc aL . d e;) ase }
& ExamCard elect ExamCard Database

Restore Database
Refresh EWS Nodes

Browse to  Offlineshare drive on EWS:
Save As HEA

Save in; |_?_ offlineshare on Ews05' [1:] j N L
[ MypRecent Documents
‘J Desktop

K My Documents

4 My Computer

- L 4 Floppy &)
,_J < Spstem (L]
“ee Data D)
< FTP (E2)
e Swap 1]
< Site [G:)
e 118MB-KEES [H:]

hare on EwsD5 (1

> G
|2} Shared Documents
) My Network Places

File name: [ Save
Saveastyps | Config Files [* bin) Eal Cancel

Figure 4-21 Mapped offlineshare drive on EWS

Enter File name: MWS09 _r261 (example)
Select Save
On EWS R2.6.3.1:
Login as MRService
Start ECOLE

Click  start > Philips - Examcards Offline Editor:
fim Philips

| =1 Configuration Tools »

Sy I] Diagnostic Tools »
m ClearQuest I Installation Tools 4
Report_test_system_problem £ Enable Remote Access
@ Set Program Access and Defaults

. [ Extended MR Workspace
fSTVartVInstalilatmrn &] Netforum
Click File = Import Configuration...:
Offline ExamCard Editor { mws
File Help
Import Configuration...
Exit
Browse to “offlineshare”
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Select Configuration file > Open

[ offineshare

=) AchievadT
= 1261
[E=) rrwwes 10_r261

File pame: MiwS09_251

Files of type: | Configuration Files [*.bin]

£ Ev
j DOpen
j Cancel

Return to step 73

4.7.5
(step 73)

CAUTION

Transfer Examcards (Database):

R2.5.3 2 R2.6.3.1
R2.6.3.1 not=> R2.5.3

On R2.6.3.x MR-Host (Acquisition context):

Right-click “Hospital” Tab

Select “Export Examcard Database As..."

@ Phiips @ Hospital |

—

@Hospital Export Configuration As...

= InBox Export ExamCard Database As...
O Smart Lumbal Import ExamCard Database 4
=] Smart_Ceruicz Select ExamCard Database »
B Restore Database
Refresh EWS Nodes

Transfer of R2.6.3.x MR-Host Examcard Database to EWS R2.6.3.1
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Browse to Offlineshare folder on EWS R2.6.3.1

Enter File name

Cllick Save:
Save As [ 2] x]
Savwﬂﬂinashava on EntireNetwork v o [

File name: ecd_mwsld ‘ Save

Saveaslype: | Database Archive Files ['Zip) 5| [T

‘13:39 Export of Database Completed

On EWS R2.6.3.1:
Right-Click “Hospital” Tab
Select “Import Examcard Database”
Select Position of Database:

Hospital | @ Philios Hospital |
pitT Export ExamCard Database As... al

te Import ExamCard Database ld = Default Database
Select ExamCard Database _

Restore Database

Select Zipped Examcard database - Open
Open [7]x]
Lock in: [ & offineshare = £F B

g o

(J
4
L
..

File name: |ecd_mws03 ~ Open  [D

Files of type: | Database Archive Files *Zip) = Caricel

‘13:48 Importing Database. Please wait.

Return to step 73

4.7.6 Word Templates (Optional)

Some EWS applications such as Radiology Reporting and Cardiac Reporting make use of the Word
templates installed on the system. These templates can be modified with hospital specific information.
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These templates are located in the corresponding subdirectories of:
D:\MyPhilipsDocuments\Templates

The Extended MR Workspace R2.6.3.1 uses the templates listed in these sub-directories for creating
reports.

In case the factory defaults must be restored, these templates can be copied to the corresponding
subdirectories of:
C:\Program Files (x86)\PMS\ViewForum\Templates

4.8 EXTENDED DICOM SETTINGS (INFORMATIONAL)

The EWS DICOM capabilities are specified by The "DICOM Conformance statement" bulletin. There is also
a document available "How to read a DICOM Conformance Statement".

SCU (Service Class User) = Client

SCP (Service Class Provider) = Server

App.fmatmn Enbty “A ” Appncaﬂan Entl!j,.f “E "
Flimage, 2 . Store my Image “H” E
% @ © Oh your system
: Dune Successfully f;;;ﬂfﬁ;f
48.1 Application Entity

A major issue in networked distributed applications is how applications can contact each other.
Arrangements and agreements have to be made to address the counterpart about various topics before SOP
instances can be exchanged. In DICOM Network partners recognize each other via Application Entities. An
Application Entity is that part of a process that deals with the communication. It contains the Service User of
the process, containing functions to set-up connections and to transfer the information. An Application Entity
has a hame (Application Title) that has to be used when setting up the communication.

Example
The EWS will use this "AE title" to address the remote DICOM node. Refer to the DICOM Conformance
statement of the remote node for this name.

4.8.2 Transfer Syntax's

Transfer Syntax is an attribute of a Presentation Context (e.g. byte ordering, compression), one or more of
which are negotiated at the establishment of an Association between DICOM Application Entities.

Little Endian

Little Endian byte ordering is defined as follows:
In a binary number consisting of multiple bytes (e.g. a 32-bit unsigned integer value, the Group
Number, the Element Number, etc.), the least significant byte shall be encoded first; with the
remaining bytes encoded in increasing order of significance.
In a character string consisting of multiple 8-bit single byte codes, the characters will be
encoded in the order of occurrence in the string (left to right).

Implicit:
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DICOM defines default Transfer Syntax, the DICOM Implicit VR Little Endian Transfer Syntax that shall be
supported by every conformant DICOM Implementation.

Explicit:

This Transfer Syntax applies to the encoding of the entire DICOM Data Set. This implies that when a
DICOM Data Set is being encoded with the DICOM Little Endian Transfer Syntax some requirements
(according the DICOM standard) shall be met.
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NOTE

When Configuring a DSI as a DICOM node, the extended DICOM settings for this external DICOM node
must be changed:
For both SCU and SCP settings (see panels of Figure 4-22 and Figure 4-23) all Endian checkboxes must be
activated, except the “Explicit little Endian”, this one must be disabled.

Big Endian

Big Endian byte ordering is defined as follows:
In a binary number consisting of multiple bytes, the most significant byte shall be encoded first;
with the remaining bytes encoded in decreasing order of significance.
In a character string consisting of multiple 8-bit single byte codes, the characters will be
encoded in the order of occurrence in the string (left to right).

JPEG

DICOM provides a mechanism for supporting the use of JPEG Image Compression through the
Encapsulated Format

NOTE
The context where the usage of lossy compression of medical images is clinically acceptable is beyond the

scope of the DICOM Standard. The policies associated with the selection of appropriate compression
parameters (e.g. compression ratio) for JPEG lossy compression is also beyond the scope of this standard.

4.8.3 Transfer Settings

These settings are applicable to all transfers, import or export, which are initiated by this DICOM node as
SCU. If the DICOM node is unknown, then keep the default settings unchanged with 1 exception: Do not
allow the Private attributes; these must be switched off.

Check Level: Two checks may be enabled:
There are 4 options:
Allow all attributes
Allow only ViewForum Attributes
Allow only PMS attributes
Allow only DICOM attributes
There are 3 options:
No syntax checking
Check mandatoriness and type
Full syntax checking
Define the level of checking against the DICOM specification.
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As a result of these checks the following actions and / or logging can be selected:

Check Actions: the response on a failed check can be chosen:
Repair invalid attributes: try to repair any missing or superfluous attributes or syntax errors
(e.g., construct DICOM attributes from PIIM/EVIIM attributes).
Stop after invalid image or Skip invalid images: Defines what to do when invalid images
(with missing or superfluous DICOM attributes or syntax errors) are encountered. Possibilities
are to stop the transfer or to skip the invalid image and proceed with the next

These actions can be combined, which means that if the modification fails the image will be rejected.

Additional Logging
Logging of errors is always done. When setting up communication with a DICOM node for the first time, set
the following two logging options to "on"; after communication is established you may switch them to "off";

Log invalid attributes: log all missing or superfluous DICOM attributes or syntax errors to the
log file: D:\Log\Logging\evserver.log (en/of ViewForumEMR.log)

Log all DICOM messages: all DICOM command and data objects are logged into text files in
directory: D:\Log\Logging\DicomRetrieve (or DicomStore).

Examples of DICOM settings and the results

Allow Repair invalid invalid Result

private images images

attributes

Allow all On Stop after Stop transfer from this node at an image with an invalid
attributes invalid image attribute, which cannot be repaired.

Allow only On Stop after Stop transfer from this node at an image with an invalid
ViewForum invalid image attribute which cannot be repaired and filter non-
attributes ViewForum (EVIIM/PIIM/DICOM) attributes.

Allow only Off Skip invalid Skip images with an invalid attribute and filter non-PMS
PMS images (PIIM/DICOM) attributes.

attributes

Allow only On Skip invalid Skip images with an invalid attribute which cannot be
DICOM images repaired and filter non-DICOM attributes.

attributes
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7. Settings as SCU

SCU Store SOP Classes

CR Image

CT Image

CT Synthetic Image
U3s Multi Frame Image
MR Image

MR Synthetic Image
MM Image

U3 Single Frame Image
3C Image

24 Image

RF Image

x-ray Specialised
Volume

3D Volume Object
surface

Cardio

MRCardio Analysis

CX Image

CK Synthetic Image
D= Image
Presentation State
Perfusion

Perfusion Analysis
Enhanced MR
Spectroscopy

Raw Data

MG Image Presentation
MG Image Processing

Bt B N W WL L W

SCUFind SOP Classes
v Patient Root Query

v Study Root Query

Exit

SCU Move SOP Classes

v Patient Root Move

v Study Root Move

SCU Transfer Syntaxes
v Explicit Little Endian
v Explicit Big Endian
v
U3 JPEG Lossy Baseline

Transfer Settings

Check Level:
&2 | Allow all attributes
2| Mo syntax checking

Check Actions:
2| Skip invalid images
v Repair invalid images

Additional Logging:
Log invalid attributes
Log all DICOM messages

Additional settings:
MR Image dhit allowed
Add group length attributes

Figure 4-22 Extended DICOM SCU settings for External DICOM nodes

When configuring a Classic EasyVision as an external DICOM node:

Make sure that the presentation state of the SCU Store SOP classes is disabled.

SIM EWS R2.6.3.1

When Configuring a DSI as an external DICOM node:
Make sure that all Endian checkboxes are activated, except the “Explicit little Endian”, this one must be
disabled.
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Section 4

4. Settings as SCP

SCP Store

Store SOP Classes

[v CR Image

[w CT Image

[+ CT Synthetic Image
[+ US Multi Frame Image
[v MR Image

[+ MR Synthetic Image
[v MM Image

[v US Single Frame Image
[v SC Image

[v XA Image

[v" RF Image
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v Volume

[v 3D Volume Object

[+ Surface

v Cardio

[v MRCardio Analysis
[v CX Image

[v X Synthetic Image
[v DX Image

[+ Presentation State
v Perfusion

[v Perfusion Analysis

[+ Enhanced MR

[+ Spectroscopy

v Raw Data

[ MG Image Presentation
[ MG Image Processing

Unsupported SOP classes:

% Convert to 5C

Storage Commitment
[ Storage Commitment {push)

Commitment settings... |

SCP Print SOP Classes

[T Basic grayscale
| Basic color;
[ Presentation LUT

SCP Find SOP Classes
[+ Patient Root Query

[+ Study Root Query

SCP Move SOP Classes
[+ Patient Root Move

[+ Study Root Move

SCP Transfer Syntaxes
[ Explicit Little Endian

[+ Explicit Big Endian

[« Implicit Littie Endian

[ US JPEG Lossy Baseline

Transfer Settings
Check Lewvel:

8| Allow all atiributes
% Ho syntax checking

Check Actions:
% Skip invalid images
[ Repair invalid images

Additional logging:
[T Log invalid attributes
[T Log all DICOM messages

Additional settings:
[ MR Image 8hit allowed
[ Add group length attributes

Exit

Figure 4-23 Extended DICOM SCP settings for External DICOM nodes

When configuring a work list on aremote node (PACS):

Make sure that the SCP Find SOP Classes: Patient Root Query is disabled.

When configuring a Classic EasyVision as an external DICOM node:

Make sure that the presentation state of the SCP Store is disabled.

When Configquring a DSI as an external DICOM node:

Make sure that all Endian checkboxes are activated, except the “Explicit little Endian”, this one must be

disabled.
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SIM EWS R2.6.3.1

ll -~ Settings as SCU

SCU Store

Store SOP Classes

CR Image
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SCU Find SOP Classes

[v Patient Root Query

[v Study Root Query
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&/ Allow all attributes
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Check Actions:
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Additional Logging:
[ Log invalid attributes
[ Log all DICOM messages

Additional settings:
[ Add group length attributes

Exit

Figure 4-24 Extended DICOM SCU settings for the Extended MR Workspace R2.6.3.1 node
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- 3ettings as SCP
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[w US Multi Frame Image Ed) sl (A [
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ag q

[« MG Image Processing [ Log all DICOM messages
Additional settings:
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SCP Find SOP Classes

[+ Patient Root Query

[+ Study Root Query

Exit

Figure 4-25 Extended DICOM SCP settings for the Extended MR Workspace R2.6.3.1 node

484 Store SOP Classes

Select the SOP classes as described by the DICOM Conformance document of the concerned DICOM node.
If this document is not available then switch off all image types, which do not belong to the involved modality.

The "Unsupported SOP classes" setting determines what to do with images of a not supported SOP class.
This setting is only available in the SCP settings panel of the DICOM node and possible options are "Convert
to SC" and "Do not export".
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485 Find & Move SOP Classes

Three standard Query/Retrieve Information Models are defined for Extended MR Workspace R2.6.3.1. Each
Query/Retrieve Information Model is associated with a number of SOP Classes. The following two
hierarchical Query/Retrieve Information Models are defined:

Patient Root

Study Root

Patient Root

The Patient Root Query/Retrieve Information Model is based upon a four level hierarchy:
Patient

Study

Series

Image

The Patient level contains the identification and demographic information about the patient to which a study
belongs. Because more than one study of a patient can exist, the patient level is the highest level (when all
the information collected for a single patient is taken in account).

A Study is the result of a request for a certain type of examination. All the activities in a radiology
department centre on the correct handling of the study. At study level identification information is kept and it
can also contain references to information related to the same study in an administration system.

Below the study level all the Series of images are collected. The Series level identifies the modality type
creating the images; the date/time when the series was made, and details about the examination type and
equipment used.

The lowest level is the Image level. Each image contains acquisition and positioning information as well as
the image data itself. Depending on the type of modality, the image level contains data for one image
(single), two images (biplane system) or a collection of images taken in a single gathering of image data in a
relative short period of time (multi-frame images).

The use of multi-frame images saves duplication of information at the higher levels, but is only possible when
the relationship between the frames can be described in a simple manner. For example, the increments in
the movements of the system and time are equal for all the single frames.

Study Root
The Study Root Query/Retrieve model is identical to the Patient Root Query/Retrieve Model except the top
level is the study level. Attributes of patients are considered to be Attributes of studies.

4.8.6 Storage Commitment

Storage commitment is a DICOM mechanism to check if sent images are correctly stored in an archive.

The Extended MR Workspace R2.6.3.1 supports Storage commitment as SCU what means that Extended
MR Workspace R2.6.3.1 can ask a DICOM archive whether the sent images were correctly received. The
Storage commitment option has also been added to the SCP panel of the DICOM node. The conditions
under which the archive will send the storage commitment result are described in the DICOM Conformance
of the DICOM archive. The time between sending the storage commitment request and receiving the storage
commitment result can be several hours. To keep control over the system resources it is possible to
configure the expiration time of a commitment request in seconds. A value of -1 means infinite waiting time.

4.9 LAST CHECKS/CUSTOMIZATION

When the software has been installed and customized:
Reconfigure the XP64 printer an the routing address
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If the virusscanner is not connected to the internet: disable the auto-update function
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5 SERVICE AND MAINTENANCE
51 HAND-OVER PREPARATION
51.1 Introduction

This section describes the activities that can be performed to verify correct operation of Extended MR
Workspace R2.6.3.1 when the installation is completed. The actions described are meant to show the
customer (and yourself) that Extended MR Workspace R2.6.3.1 itself works fine and that the communication
with systems connected also is 0.k.

Please report the results of these actions on the Hand-over checklist supplied in Section 6 of this manual.

51.2 User Documentation / Information

¢ Hand over to the customer the User Documentation on CD-ROM, DVD-ROMs with Demo cases, Quick
Reference card and Quick Reference guide and explain what is what.

5.1.3 Completeness of delivery

Show that what is delivered is complete and conform the customer order / delivery papers. E.g. Type of
Extended MR Workspace R2.6.3.1, Software packages, Hardware options, Demo packages, etc.

514 Extended MR Workspace R2.6.3.1 Functionality

Show proper operation of basic Extended MR Workspace R2.6.3.1 functionality and customer settings.

5.15 Power On/Off

Show how to start and shut down Extended MR Workspace R2.6.3.1.

Show how to login to Windows XP x64

Show how to login to the Extended MR Workspace R2.6.3.1 application

NOTE
It is recommended to restart once every day.

5.1.6 Data Management

Show how to use Data Management (query, copy, delete, split view)

Load (test) images into the database.
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SIM EWS R2.6.3.1 Service and Maintenance Section 5

e Copy Images from / to CD-Recordable or DVD-recordable

NOTE
In some cases it is NOT possible to read DVDs (incl. burned DVDs) in the DVD Recorder. In this case place
the DVD in the DVD reader!

e Explain database protection mechanism.

NOTE
For making use of the Extended MR Workspace R2.6.3.1 AutoDelete function the power saving settings
must be disabled. For instructions how to disable the power saving settings see 3.3.13 Check Power settings
adapter connected with Hospital Network p. 55

51.7 Customization Environment

e Show Customization environment.
e Explain how to add and change user settings
e Explain how to change hospital settings

e Explain how to customize the toolbars

5.1.8 Applications

Show how to switch between the Viewing environment and Data Management / Worklist

Show how to start analysis packages

5.1.9 Network Communication
5.1.9.1 Communication with configured nodes

e Get/Send data sets from/to all systems connected to Extended MR Workspace R2.6.3.1.

¢ Inthe Extended MR Workspace R2.6.3.1 Data Management - background tasks see if the job is
executed.

e Check in Data Management facility if all images have arrived.

5.1.10 Printing

Print to all printers connected and check if the printout is correct.
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Section 5 Service and Maintenance SIM EWS R2.6.3.1

51.11 EWS R2.6.3.1 Maintenance Menu

e Explain relevant functions of the EWS R2.6.3.1 Maintenance Menu to hospital engineer/customer.

5.1.12 Application Training / Support

e Inform the customer about Application training and support possibilities.

5.1.13 Administer the EWS for Remote Support (RSN) (step 9)

The following RSN applications are supported:
e  Ping system,

e Port test,

e Telnet SSH2,

e  SecureFTP,

o Remote Desktop Sharing (lots/to)

To get this functionality it is needed to administer the EWS via the RSN website.

Create a new Site Survey for a new EWS via the Remote Service Network - Data Administrator Website.
Important is that for the EWS you have to configure Modality to MR and System Type to
781400-Extended MR WorkSpace.

1. Login to the RSN Data Admin Website and select Site Survey - Start New Site Survey:

PHILIPS

Remote Services Netwa

Rnlluut Uger | A

— ‘iew Active Sites
RSN Syst visw Pending Stes

Modify ActiveliConfigured Sites
Please selec Promote or Move Sites

MNote: data@

2. Inthe Site Survey Form:

Click on “Create New Site Survey”

Fill in the questions until you reach the Site Survey Form.

Fill in all the fields on the form.

Modify

- the Modality to MR

- the System Type to 781400-Extended MR WorkSpace.

- if required, the other fiels like Reference number, System Description,
System Configuration, Host name, SAP site number, etc.

Click on the “‘Generate Label’ button.

Click on the ‘Update System’ button.

7. Click on the “‘Send for Approval’ button.

APwnh e

ISRl
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3. Fillin the preferred System Label on the RSN with format Modality SSSSSS_RRRRRR_HostID,
where Modality is like MR,
SSSSSS is the serial number of SAP ID (preference for SAP ID).
RRRRRR is the System Reference Number for MRs

4. HostID is a custom string that can be attached to the end preferably something like MR30T_EWS,
where MR30T is the direct linked MR system, in this example an Achieva 3 T system. E.g.
MR_SAP number_17001_MR30T_EWS1.

Return to step 9
52 DELL SERVICE TAG & EXPRESS SERVICE CODE (STEP 13)

When system is up and running:
Reboot: Start > Shut Down - Restart
Press: F2 during initialising of the system to enter the system BIOS
Select: System - System Info

Note
write down the Service Tag and the Express Service Code on the Reference sheet of Section 6.

Return to step 13

5.3 DELL SERVICE TRANSFER TO COUNTRY OF DESTINATION (STEP 14)

PMS ships DELL products including a service agreement (Up sell services)
For warranty transfers from one region or country to another, up sell services shall be transferred.

Process:
5.3.1 Service transfer to a ‘Direct DELL Support’ Country

In case your country is serviced by a local DELL support organization, you need to complete the following
internet form for the service tags to be transferred:
http://www.dell.com/us/en/dhs/topics/sbtopic 016 ccare.htm

5.3.2 Service transfer to an ‘Indirect DELL Support’ Country

In case your country is serviced by a 3" party agent, licensed by DELL, you need to complete the following
internet form for the service tags to be transferred:
http://www.dell.com/downloads/global/support/emea_indirect tag transfer request form v1.0.doc

This form has to be sent by e-mail to: EDB_DELL Tag Transfer@Dell.com

The following countries need to transfer the service tags via this form:

Afghanistan, Albania, Algeria, Angola, Armenia, Azerbaijan, Bangladesh, Bahrain, Belarus, Benin, Bhutan,
Bosnia, Botswana, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Central African Republic, Chad,
Christmas Island, Comores, Congo, Cote D’ivoire, Croatia, Cyprus , Djibouti, DRC, Egypt, Equatorial Guinea,
Eritrea, Estonia, Ethiopia, Fiji, French Guyenne, Gabon, Gambia, Georgia, Ghana, Guadeloupe, Guam,
Guinea, Guinea-Bissau, Hungary, Iceland, Indonesia, Israel, Jordan, Kazakhstan, Kenya, Kiribati, Kosovo,
Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Libya, Lithuania, Macedonia, Madagascar,
Malawi, Mali, Malta, Maldives, Martinique, Marianas North, Mauritania, Mauritius, Mayotte, Moldova,
Mongolia, Morocco, Mozambique, Myanmar, Namibia, Nauru, Nepal, Niger, Nigeria, Nouvelle Calédonie,
Oman, Pakistan, Palau, Papua New Guinea, Philippines, Polynésie Francaise, Qatar, Réunion, Romania,
Russia, Rwanda, Rwanda, Samoa, Solomon Islands, Sao Tome, Saudi Arabia, Senegal, Serbia, Sri Lanka,
Montenegro, Seychelles, Sierra Leone, Slovenia, St Martin, Swaziland, Tajikistan, Tanzania, Tonga,Togo,
Tunisia, Turkey, Turkmenistan, Tuvalu, UAE, Uganda, Ukraine, Uzbekistan, Vanuatu, Vietnam, Yemen,
Zambia, Zimbabwe
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5.3.3 Identifying the DELL Service tag of the system
The DELL service tag number is attached to the systems' case. An example is shown below:
WWW.DELL.COM

servige Tag: DEVFEDJ
Express Barviea Code: 28653203458

Windows® 2000
DeélL ¥

F A

SO 80723 3
2 Produrt ey, BYVNR- B34FK-VQDOB- YMRHQ PHGFY

e RN

ha

7

Y86 2156
Cartifizate c1A

Figure 5-1 Example of a DELL Service Tag

5.34 Filling out the transfer form

Fill out the original customer information as shown below. Of course you should enter the service tag

applicable for your system. Next, fill in the hospital information below the “Transfer To Location
Information”

Original Customer Information

Email Address: mr.helpdesk@philips.com
Original Owner: Philips Healthcare Nederland B.V.
Service Tag: <Service Tag of the system>
Country of Original Purchase: Netherlands

Transfer To Location Information

Enter the Customer's data (including physical address of the equipment) into the corresponding fields in the
Transfer To location Information and Trade Compliance Information section.
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For multiple service tags, click the appropriate link below:

£3  Click here to enter a single service tag.
L3 Click here to enter up to 10 senice tags.

L2 Click here to enter up to 50 service tags.
* Indicates a reguired field.

Original Customer Information
# Email Address:

&= Qriginal Cwnetr:

= Service Tag: System Type:
| - Select one - -

& Country of Original Purchase:
|- Select one - ﬂ

Pleaze do nat mix service tags that originate in multtiple countries . Requests originating fram multiple 'Country
of Original Purchasze' not allowed and will be returned to you for re-submission.

Service Level:
|- =elect one - ﬂ

Qrder ar Imvoice Mumber:

Lookup #

Transfer To Location Information
= Email Address:

& First Marme:
& Last Mame:

= Campany:

Or individual's name it company does not apply.

&= Address:

Figure 5-2 Example of transfer form

Return to step 14
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5.3.5 How to request maintenance support from DELL

In case of maintenance support needed from DELL you must provide besides the Dell Service Tag number
(see Figure 5-1) the Dell Sales-Order number of those components that were added to the system by the
PMG Medical IT. This Dell Sales Order number can be found at the bottom of the Dell system (see Figure
5-3 Example of DELL Ordernumber).

Figure 5-3 Example of DELL Ordernumber

5.35.1 Special phone number for selected EMEA countries

Per January 1%, 2009, Dell has installed a so-called “OEM queue” for Philips Healthcare. This team is
providing assistance on all Dell Precision workstations (3x0 series, 6x0 series, T3x00 series and T7x00
series) installed in selected EMEA countries.

The phone number to dial is: +44 (0) 844 444 3354

All team members are trained on the Philips Healthcare-specific agreements and as such will be able to
provide more efficient and effective support when called upon for assistance.
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NOTE

The team takes all questions in English only.

The applicable EMEA countries are:

Austria, Belgium, Czech Republic, Denmark, Finland, France, Germany, Greece, Ireland, Italy, Luxembourg,
Monaco, The Netherlands, Norway, Poland, Portugal, Slovakia, South Africa, Spain, Sweden, Switzerland,
Vatican City, Italy and the United Kingdom.

NOTE

For the countries NOT listed above, this new procedure does NOT apply.
Your local Dell organization needs to be contacted in case of problems
with a Precision workstation.

4522 170 12901/Level 1.2 CSIP Level 1 (09.0) page 131 of 164

This document and the information contained in it is proprietary and confidential information of Philips Healthcare ("Philips") and may not be reproduced,
copied in whole or in part, adapted, modified, disclosed to others, or disseminated without the prior written permission of the Philips Legal Department.

© 2009 Koninklijke Philips Electronics N.V.
ALL RIGHTS RESERVED




Section 5 Service and Maintenance SIM EWS R2.6.3.1

54 SERVICE MENU ITEMS

Several service tools are available.

Loginas: MRService
Select: Start > Philips

In the following paragraphs the Configuration, Diagnostic and Installation tools will be discussed.

54.1 Configuration Tools

Loginas: MRService
Select: Start - Philips &> Configuration Tools
rm Philips »|f&@ Configuration Tools

YL

o
>
-1
=
o
b=}
&
=

Start EWS Configuration:
This starts the EWS Configuration tool. For more information about Configuration, see section 4.3.1.1 Start
EWS Configuration (VF) p. 76

Press: Configuration

Start MR Configuration:
This starts the MR Configuration tool. For more information about Configuration, see 4.3.4 Start MR
Configuration p. 90

Press: Configuration

Set Logging Level:
Press: Set Logging Level
To select whether or not the INFO log messages and/or the performance log messages must
be logged.
For more information about logfiles, see 5.5 Logging p. 136.
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Section 5

5.4.2 Diagnostic Tools
Loginas: MRService
Select: Start - Philips > Diagnostic Tools
T Philips
Eurs Diagnostic Tools
(@]
(|
g
Log Files
When selecting the Log Files entry the following

functions can be selected.
T philips ] Co '
% R fi Diagnostic Tools
v Gl - =

Windows XP F

For more information about logfiles, see Logging.

Utilities

When selecting the Utilities entry the following functions can be selected:

fan || .
fan Diagnostic Tools ™
) Ir fi

Utilies
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Start About:

This is a tool to display relevant version information of installed software of the EWS system. This
information is reported as a html file.

Press: About

Start Color test:
This is a tool to manually display different patterns to test correct functioning of the LCD or CRT monitor.
Press: Color test

Computer Service Tag display:
This functionality does not work (yet). Check the BIOS to obtain the Service Tag as described in 5.2.

Start HCU Visual test:
Tool to test the correct working of the Hard Copy Unit (HCU) card. For this, the printer test tool is needed!
Press: HCU Visual test

Start LCD test:
To test the correct geometry settings of the LCD monitor.

Press: LCD test
5.4.3 Installation Tools
5.4.3.1 Change Hostname (Step 41)

Login as: MRService
Select;: Start > Philips = Installation Tools

fan

]
fi Installation Tools

FeasUHUS

=
>
-
4
=]
=
-
=

Change Host Name:

This tool changes the hostname on 3 different locations:
e Computer name in XP
e License file
e EWS node in configuration

WARNING

EWS hostname should be identical with the name used on the MR-Host.

Press: Change Host Name
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Fill in:  The Host Name of the system
Press: OK

NOTE

A reboot is needed!

5.4.3.2 Export EWS configuration

This tool exports all configuration settings to a .zip file. Use this tool to create a back-up of the configuration
settings and to store it on a safe place.

For more information about Backup/Restore Application Configuration, see Ex/Import Configuration &
Database.
Press: Backup Application Configuration

5.4.3.3 To Fix up Firewall settings
This program sets-up the Windows XP x64 firewall.
Press: To Fixup Firewall settings

5.4.3.4 Import EWS configuration

Via this tool a previously saved back-up of the EWS configuration can be restored.

For more information about Backup/Restore Application Configuration, see Ex/Import Configuration &
Database.
Press: Import EWS configuration
5.4.35 Import ViewForum Configuration
Via this tool a previously saved back-up of a ViewForum configuration can be restored.
For more information about Backup/Restore Application Configuration, see Ex/Import Configuration &
Database.
Press: Import ViewForum configuration
5.4.3.6 Inspect License file
For more information about Inspect License file, see Software License Procedure.
Press: Inspect License file
5.4.3.7 Install License file
For more information about Install License file, see Software License Procedure.
Press: Install License file
5.4.3.8 Printer calibration

For more information about Printer Calibration, see Printer Calibration.
Press: Printer Calibration
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5.5 LOGGING

5.5.1 Archive VF Logfiles

Select: Start - Philips = Diagnostic Tools - Log Files - Archive VF Log Files

Archivelog... Q@@

Select types of log files to archive

v Application log files
V¥ DICOM log files

Browse ... Cancel

Figure 5-4 Archive Log panel

Check: Types of log files to archive (deactivate if necessary)
Press: Browse...

Browse to: Location where the log files should be saved to (e.g. USB-stick)
Press: Save

The log files are being saved, when completed a success message pops-up. The log files are saved as a zip
file, named: logs_"system name”.zip.

The log files are archived now.

5.5.2 Other Logfile options

Other actions to manipulate log files:
Select: Start > Philips = Diagnostic Tools - Log Files = Archive VF Log Files
Select: Create new MR logfile
To create a new MR logfile

or
Select: Remove DICOM Lodfiles
To delete the current DICOM related log files.
or
Select: Remove VF Lodfiles
To delete all current log files.
or
Select: View VF Log Files
To select and view a log file.
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5.6 SOFTWARE LICENSE PROCEDURE

5.6.1 Introduction

Extended MR Workspace R2.6.3.1 licenses cannot run on the former EasyVision system or on ViewForum
R4 or R5 systems, neither vice versa. As a consequence, a new license file is required.

NOTE

Every option is licensed for use on a specific machine and will therefore only run on that specific machine.

5.6.2 License File

We distinguish so-called permanent license keys and try & buy license keys that are distributed in an
electronic way: the license file.

There is one license file per Extended MR Workspace R2.6.3.1.

The license file contains:
MAC address of the onboard NIC EWS node
Name and Release identification of the option(s)
Expiration date per option
Encrypted string, being the actual license key, for each option

In case the customer orders an additional option, the new license file will contain all current license keys +
the new license key(s).
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This is an example showing how the contents of a license file ("00065bdcd745.DAT ") may look like:

e e e
# Filename : 00065bdcd745.DAT

# Product : Extended MR Workspace R2.6.3.1

# Hospital : DEMO Hospital

# City : NETHERLANDS

# Country : NL

# Funlocknbr : 678234

# Generation_date : 29-Aug-2006 09:02:23

# Generated_by : Operations

#

SERVER ServerName 00065bdcd745 2900
VENDOR easylicd

USE_SERVER

INCREMENT 3dAdvProjections easylicd 6.1 21-jul-2007 1 \
HOST ID=00065bdcd745 ck=171 SIGN=E5CECBCCA8FC

INCREMENT 3dAdvSegmentation easylicd 6.1 21-jul-2007 1 \
HOST1D=00065bdcd745 ck=179 SIGN=36B79420F762

INCREMENT 3dAutoPath easylicd 6.1 21-jul-2007 1 HOSTID=00065bdcd745 \
ck=153 SIGN=42AB7CFA4C76

INCREMENT 3dBasicSurface easylicd 6.1 21-jul-2007 1 \
HOST1D=00065bdcd745 ck=172 SIGN=551CDFEA2E52

INCREMENT 3dCoro easylicd 6.1 21-jul-2007 1 HOSTID=00065bdcd745 \
ck=154 SIGN=A1AAA4067F52

INCREMENT 3dEndoView easylicd 6.1 21-jul-2007 1 HOSTID=00065bdcd745 \
ck=174 SIGN=E983F92EC812

INCREMENT 3dVesselAnalysis easylicd 6.1 21-jul-2007 1 \
HOST ID=00065bdcd745 ck=162 SIGN=598DBB14A3E8

INCREMENT 3dVolume easylicd 6.1 21-jul-2007 1 HOSTID=00065bdcd745 \
ck=224 SI1GN=FE3E0256898E

INCREMENT 3dVolumelnspection easylicd 6.1 21-jul-2007 1 \
HOST ID=00065bdcd745 ck=142 SIGN=BE2FDO5CBAEA

INCREMENT Basic easylicd 6.1 21-jul-2007 1 HOSTID=00065bdcd745 ck=161 \
SIGN=D645C38CEDC2

5.6.3 License Key Types

Two types of license keys can be distinguished:

Permanent License Keys:
provide an indefinite time period for using an option.
are initially factory installed on the Extended MR Workspace R2.6.3.1 and are delivered on a
ush-stick or back-up floppy

Try & Buy License Keys:
provide the use of an Extended MR Workspace R2.6.3.1 application package for a limited
period (4 months) and can only be activated once
are active from the day of key-generation until they expire automatically after 4 months
are not initially factory installed on Extended MR Workspace R2.6.3.1
(they would be (partly) expired at the time of installation at customer site)
all Try &Buy packages are default added to an initial order
Contact the HI Logistics & Manufacturing department to get (a) Try & Buy option(s) activated.

56.4 License File and License Form distribution

License files (permanent keys only) for a new Extended MR Workspace R2.6.3.1 are already
installed and delivered with the system on a CD-ROM.

The latest version of a license file is always available on the InCenter site, from where it can be
downloaded.

When an option has been ordered, the License file is sent to the SSD / SSR. In case hardware
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is involved, the License file + the License form will be sent together with that hardware.

5.6.5 How to get the right License File

In this software license procedure the role of the SSD / SSR is crucial because the SSD / SSR knows which
systems were ordered and when, where and by whom systems will be installed.

When required the SSD / SSR can inform the MR Operations department at PMSN-Best to
activate a Demo key. Then a new License file is send to the SSD / SSR and can also be
downloaded from the PMS InCenter site.

The SSD / SSR is responsible to get this License file in time to the Service Engineer who will
install this file on the specified Extended MR Workspace R2.6.3.1 system.

5.6.6 Location of License files on Intranet

The license files can be obtained from
http://pww.wiskey.ms.philips.com/Wiskey/techNetLicenseFilesSearch.do
or via MRIncenter:
Select: tab: Service
Click: Service = Products and Solutions - Magnetic Resonance
Select: MR License Keys link in the MR Links section of the web page
Select: MR Best link in any of the Product groups

At least one search parameter is mandatory

- Use % wild card

- A query with a lot of parameters will give less to zero hits
- The query on InCenter is limited to the first 100 hits

SRN for MR License
Product data: MAC for VF License
Finger Print 12345

550 REF ]
S50 Order Acquisition number l—
PMG l—;[
Product Family | j
SubSystem Type | j
Location:
Hospital Mame l—
City l—
Country | j
Logitics data:
Production order number l—
Fun Loc l—
Zmat Nr l—
Zmat Description l—
Time Zane lﬂ
Asus Region l—;I
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Fill in: One or more search criteria
Press: Search Now

5.7 ACRONIS SYSTEM BACKUP AND RECOVERY

This section only contains some basic information. See the Acronis guide for more information.
CAUTION
This Backup & Restore procedure is for the system-partition only.

Restoring a system will result in ALL current data on the system disk being permanently lost
Do not restore a system unless all required data has been safely backed-up and is available for later use

5.7.1 Prerequisites

Acronis boot CD 4522 170 12971

DVD media, depending on the size of the data one or more CDs/DVDs may be required.
Must be logged in as MRService user or Administrator

Make sure the system is rebooted before creating a Acronis Image

5.7.2 Acronis Image on DVD

Acronis Images should be created on DVD media (DVD +R, DVD +RW).

Media Support
A standard CD/DVD R/W drive will be supplied with the Dell system. Refer to the website the CD/DVD R/W

supplier for supported media. Make sure the latest firmware is downloaded.

Firmware for DELL systems can be downloaded via: http://support.dell.com/support/downloads

NOTE
It is strongly recommended that high quality media be used to ensure data integrity and longevity
Rewritable media) must be erased prior to creating an Image (new media is immediately usable)
It is recommended that only new, dedicated media is used

Once the Image has been created, each DVD should be clearly labelled as per the following example:

EWSx_nn "Backup

Disk 2 of 3

Created: 01 July 2009

“Where “x” is the current EWS version (e.g. R2.6.3.1) and
“nn” is the backup number (e.g. 01).

To create an Image, proceed with 5.7.3. To restore an Image, proceed with: 5.7.4.
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5.7.3 Create an Acronis Image (step 75)

Step 1:
Backup configuration data from Data-partition on System-partition

Loginas: MRService
When not already done: reboot the system; when the system is up and running again login as MRService
Start: Windows Explorer
Browse to: C:\nmr\gyroscan\commands
Start Command Window (Start > Run... = type cmd > OK):

Drag- and —Drop: ews_backup_restore_config.pl into Command-window

Enter: backup to the command window input script

Address IB Ciinmrgyroscanicommands
Folders x  Mame - I Size | Type
2 activate_configuration 4 KB PLFile
- S () B s occenice 7KB PLFile
2 atsc J 2 aswinit 2KB PLFile
=I5 Documents and Settings 2 configrmoddyd 18 KB PLFile
I Adrinistrator Fep_di7l 1KE Windows Comm
&l Users Fdcomperm 52 KB Application
=) WFSenverUser 2 dotnet_patching S KB PLFile
= =) YFSemiceUser 2 ews_backup elstore_lconfig gKE PL F!Ie
3 Cookies J ew.supdatECfnflguratluns TKEB PL Fllle
Desktap &= osfin.prm B KB P F!Ie
= '! us\nm.pml 4 kB PM File
4 » 4|

ﬁC:\WINDOWS\S!_.'stem32\cmd.exe_l_

icrosoft Windows [Version 5.2.37%81
(C» Copyright 1985-2803 Microsof §pCorp.

z\Documents and Settings“\UFServicelszer>C:\nmr \gyroszcanscommandssews_bhackup_rest
re_config.pl backup

Wait:  until script is ready

Step 2:
Start the Acronis program via Windows:
Select: Start > Programs - Acronis > Acronis True Image Server OEM - Acronis True Image
Server OEM
Check: Do not show this message again
Select: No, Thanks

] Accesseries
fa Acranis
) ActivePer! 58,8 Build 873

BPDITANTY Pense read

Acremis Trm bagn Sarvur DEM allows o te.
= tetare mabe b Hak Eeetvnh et o i
- vy e ke rser s o Pother

cxuntinn, craae intsvmnial bockups.

Figure 5-5 Acronis (1-st) startup

When the Acronis program is started:
Click: Backup
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Pick a Catagary

9 Bachup Archees

Recovery
¢ the enlire hord digh contents o

fles

Manaqe Tasks

B Howio back up your dats
B How o restare your dete
@ Howta echadula backup

Wiew operaton

or Pick a Tool

Explara and Validata . Activala Acronic
" Bnckup Archivas B Startup Recovery

+ Manage Hard Digks

Click:
Check::
Click:
Acronls
True Image
Server DEM
[ SSystem (C) PriAct 744908 10,05 68 NTFS
Llpiskz
] EDainr) Pri 4766 GE 95,06 MB NTES
O Backup ) Pri 3907 GB 9240 GA NTFS
_)Acrc:nls
:M Frease chck Nextto condrug, Tatal size: 100568
@)t b Dl | || @) (<o ([ tio> J) oncel |
Browse to: DVD+RW Drive
Enter: BackupFor
Click: Next >
Click: Tools = Options
Click: Compression level
Enable: Maximum
Click: Archive splitting > Fixed Size
Enter. 45GB
Click: OK - Next >
Page 142 of 164 CSIP Level 1 (09.0) 4522 170 12901/level 1.2

This document and the information contained in it is proprietary and confidential information of Philips Medical Systems ("Philips”) and may not be reproduced,
copied in whole or in part, adapted, modified, disclosed to others, or disseminated without the prior written permission of the Philips Legal Department.

© 2009 Koninklijke Philips Electronics N.V.
ALL RIGHTS RESERVED




SIM EWS R2.6.3.1

Service and Maintenance

R

Enter:
Click:

Follow

Click

eturn to ste

Create Backup Wizard [ 2] x]

Backup Archive Location

X = > . DVD-RW Drive (F:

esktop HL-DT-5T DVD+-Rw GSA-H73N B103
FTP Connections
My Documents
My Computer

M 3% Floppy (&)

e System (C)

< Data (00

% DWD-RWY Drive (F) CO-RYY I
< Backup
2 Shared Documents

My Network Places

< ¥
File namé€__ F\BackupFol

R ——

i
el L
e L

s
b

I e

e
T

e

b e b B i i ae ]

Bt e i s e e e

T |

s

Create Backup Wizard [ 2] x]

Select either to run this hackup creafion task using default options or configure the opfions for
this task on the next steps of the wizard,

(3) Use default options
O Setthe options manually
Description

You cs = optians for this task. To change the default options. open the menu

itergTools -> Options Ynd make all necessary changes.

S
Files of fype: Backup Archives (*tilb) ]
@) Help < B Next> Cancsl Q) Help [ <Bac] Mextﬂ Cancel
Comments

Next = Proceed

Create Backup Wizard

Archive Comments

Itis sometimes useful to add camments ta the archives you create. Comprehensive
comments can help yvou to find the appropriate archive much faster.

Backup System-parition EWSI)

@) Help [ <Back(][ Wex> JD cancel |

ate Backup Wizard

Acronis Acronis True Image Server OEM is ready to procead with physical
data archiving, Here is a complete list of operations to be
True Image performed
Server OEM
Create Full Backup Archive
From: Disk 1
To CD-Rwy Drive (dewv=1.0,0)
\BackupFortib
Comprassion: axirnum
File Split: 4500 GE
Description:
"2008-07-03

Backup System-partition EV/S01"

Operation 1 of 2
Creating parition image

Hard disk: 1

Drive letter. C.

File systarn: NTFS
Wolume label System
Size: 7443 GB

Operation 2 of 2

Saving partition structure
R ronis Hord disk:
Computa with confidence

wew.acrania.com Flease click Proceedto start

< Ba Proceed Cancel

Q) Help

instructions to insert DVD’s into DVD-RW drive.

[x] M

100640003 Please insert the first media

Flease insert a disc, and then click OKwhen reachy: or click
Cancelto stop the operation.

“ou can use an empty disc or a discwith backup archive, which
was previously created by Acronis True Image Server OEM. if
there is enough fiee space left on the disc.

volume
100640004: Please insert the next volume
Please remowve the burned disc and mark it as Volume 1, and

then insert the next blank disc. Click OKwhen ready or Cancel
to stop the,

Cancel

Information [ x]

o The operation was successfully completed

Operations = Exit

75
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5.7.4 Restore an Acronis Image
WARNING

This procedure WILL restore the entire System disk of the computer
Any changes made on the computer since the original Acronis Image was made will be LOST

An Acronis Image can be restored (recovered) as follows:

Insert into DVD-ROM drive:
Acronis boot CD 4522 170 12971 (Delivered with the system)
Insert into DVD+RW drive:
The DVD containing Acronis Image, file with highest Volume number
or if the image is stored on a USB device or external hard disk:
attach the device now.
Restart computer and boot from Acronis CD.
Wait while the Acronis program loads.
The Acronis wizard pops-up:
Select: Recovery > Next >

s Hackup

€ Back up yous hley. lokders or e enlire hord drak.

e L D i el
o B 2k e ey

sione imdradual

Pt 2 Hamt ot s

Browse to Acronis Image file
Select Next > (2x):

Restore Data Wizard

Backup Archive Selection

SOWS one of the folowng revicraticn hpnee.

14 Finsioi g or parbons]

€] DE:;;FC .. BackupFor2 tib o v
":‘* annsdtions Backup archive name: BackupFor tib B
#(J My Documents Backup archive type: image
= j My Computer The selected backup seguence number: 2

3 Floppy )

< System (C)

< Data (0 Date: Friclay, June 19, 2009 2:48:36 Phd

# 5 CD Drive (E) Size: 7.726 GB

=5 Actanis Media
JackupFor tih

Mo description is available for this backup archive.

[ e 1
[+ s Backup (I

e 72GE_uKees (1) it
D Shared Documents . .
#%J Wy Netwaork Places < 1 o)
2451 B/ 7450 GB NTFS
Eile name: |F\Eackume2hh "l
Files of type: Backup Archivas (i) v|
g) Help < Bal Dext > ancel
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Check:

System (C) partition

Select: Next >
Check: “No I do not want to resize partitions”
Select: Next >
Restore Data Wizard re D d
Partition or Disk to Restore Restored Parbibions Hesiong
Select & pariion or o hard disk drive to restore et
Please select a partition or a whole hard disk drive to restare.
IR
Partition Flags Capacity Free Space Type
[] Disk 1
Syster (C) Pri,Act 74.50 GB 50.74 GB MTFS
= MBR and Track 0 MBR and Track 0 Select this itam if pansons to thair oeiginal i
wera backed up. This op 14 schi,
removahle media
) Halp “cgack { peas | concel |
Qlﬂe\p <Ea:k$ ext > > Cancel
Select: System (C) > Next >
Enable: Active
Select Next >
Restore Data zard Restore Da zard
Restored Partibion Location Restored Partibion Type
Seded a target parition or unalloceted space for®ien Choose the restored partition type
R i s o T
pmﬁmmwnmumwwuwmmmmmnwm Fioas ssleci ¥ tiored porbon ps:
fot restaring the image are disabled s wel
! Y
Fertihon Flags  Capscty  FreeSpace  Type
Digk 1 (Logical
< S Description
The actve paiion i the pariiton the computer baats fram. Gnly ane porition can be
actve of a ime. The acive paris in aparaiing sy d dotn files Hihe
P T66GE  9208GBNTFS paian as artve ¥
@)t (ool tos Dcorea || | Qo < goor (T tio1» ) Doce |
Select: Next >
Enable: “No | do not”
Select: Next >:
Restore D ard

Restored Partibion Siee

Pleose speciy the site and locabion. You con chonge i with the mouse m the grophicel wew

(7]x]

[ ]
or haed disk. diive from the backup =

or enler e exoact values n the lexd boves. Yo pasiiticn or el dinve from the backup archeve Doy

L | P

%ig"c:écr]rm | (7, Iwant 1o 1o Ancthins pation or hadd dink dinve,

Manimum pamtion size. 745 GB Madrniam panison size. 745 GB
Eres space bafoee 0 bntas = smmd il o hiavwe chi i the i hard digk

reody
Emrtition sie TASGE
Fron space gter |7 841 MB &
W) Help cgack ( meas || Yancel W) Help T‘m:el
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Select: Next > = Proceed

Remove: DVD Volume n from DVD+RW drive
Insert: DVD Volume 1 into DVD+RW drive
Select: Retry

Restore Data Wizard [ 7]x]
Choose Restore Options Acronis ﬁ"'“ﬂ" |MM;OWMD&E"‘;I:‘WWMWNWNLM
True Image s
ar modify them manualk Serv - W_thww —
Disk Parition Fecovery irom Archive
From ble *FABackipFoi bb®
Select either to run this restoration task using default options or configure the options for this
task an the next steps of the wizard: Operaton 1 of 2 (Rebool requined)
Deleting partibion
Hard disk 1
Diefvi listiar G
Filia 1 NTFS
() Setthe options manually Vlulum'znl Sysanm
Sire 460 GB
Description
. Opaation 2 of 2
“ou can use default options for this task. To change the default options, open menu Tools Rastaring panition sactor by sacior
= Options and make all necessary changes Haud digk: 1
Drive latier: =
File system NTFS
Yolume label Sysiem
Sira: T450GCB
Flense chok Proceed o stert.
T ¢ iTm_:e_eE'i ) cercel |
k1|
Ql Help [ < Back q Mext > i Cancel ] i = Rk 1
= i
_me« Cancel |

When System asks for
Remove: DVD Volume 1 into DVD+RW drive
Insert: DVD Volume 2 into DVD+RW drive
Select: Retry
Repeat these steps when required.
When ready, press OK - Remove media from both DVD-drives - Close Acronis Application, to restart
EWS.

NOTE
When the system stops responding and does NOT restart automatically:

Press Power button until EWS is powered off, wait 10 seconds and press Power button to
switch the system on again

Continue with section 5.7.4.1 p. 146

5.7.4.1 Restore configuration data from System-partition to Data-Partition

Loginas MRService
Start Windows Explorer
Browse to C:\nmr\gyroscan\commands
Start Command Window (Start > Run... = type cmd - OK):

Drag
-and - ews_backup_restore_config.pl into Command-window
Drop
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Enter in command window input parameter for script restore <Enter>
Enter Y on the question to remove the patient database and format the d: drive

Address |l§ Cinmngyroscanicommands
Folders >x | Mame = Size | Type
2 activate_configuration 4 KB FPLFile
= Bl - acsenice 7KB PLFile
=) atse J 2 aswinit 2 KB PLFile
El | Documents and 3ettings 2 configmoddyvd 18 KB PLFile
1) Administrator Fcp_dil7l 1KE “Windows Comir
I All Users [ dcomperm 52 KB Application
=) WFServerlUser 2 dotnet_patching 5 KB PLFile
B 5 YFSeniceUser 2 ews_backup_restore_config S KB PLFile
=) Cookies 2 egfsupdateconfigurations 7EE PL FII.E
=) Desktop Usﬁu.pm &6 KB PM File
- = X > [#osinm.prm 4 KB PM File
1<} 4&1_‘ 4
on CAWINDOWSAsystemcmd.exe Hi=E3

=n>ews_backup_restore_config.pl restore
his procedure will vrestore the backup of the ews configuration.

All user applications must have been stopped *T77.
Do wou want to remove the patient database and format the d: drive {y-n-edle=ex|
it 1.

his may take a some time...._
Qutput written to C:sbackup_ews configuration“restore_configuration.log.
[8C]1 ControlService FAILED 1662:

he serwvice has not heen started.

ISERUICE_MAME: MR Loggingserver
2 18 WIN32_OWN_PROCESS
STATE 3 STOP_PEMDING
Engl;PHBLE HOT_PAUSABLE. IGHORES_SHUTDOWM>>
I

WIN32_EXIT_CODE - |
SERUICE_EHIT GCODE = @ <Bx8>
CHECKFPO = BxB@
NHITAHINT = Bx8

ISERUICE_NAME: MSSQLSERUER
I¥YPE H 13 WIN32_OWN_PROCESS
STATE H TOP_PENDIHNG

{STOPPABLE. PAUSABLE. ACCEPTS_SHUTDOWHN>

WINM32_EXIT_CODE = 8 C(BxB>
SERUICE_EXIT_CODE : B <{(Bx8>
CHECKFPOINT = Bl

WAIT_HINT 2 Bxeab@

SUCCESS: The process with PID 1464 has been terminated.

he type of the file system iz MNTFS.

nickFormatting 188886M

olume dismounted.- All opened handles to this volume are now invalid.
reating file system structures.

ormat complete .

182486308 KB total disk space.

182337436 KB are available.

eturn = 22

processed diwr: D:wofflineshare
processed file: D:i~offlineshare~fred-bin
orocessed file: D:“offlineshare~UoM._bin
iprocessed file: D:~offlineshare~UoMichigan.Zip
ISERUICE_MAME: MR Loggingseruver
IYPE = 18 WIN32_OWN_PROCESS
STATE = 2 START_PENDING
<STOPPABLE, HOT_PAUSABLE. IGHORES_SHUTDOUN>>
WINM32_EXIT_CODE B (8x8>
SERUVICE_EXIT_CODE : @ <{BxB>
CHECKPOINT = BxB@
WAIT_HINT = Bx8
PID : 2928
FLAGS H
ISERUVICE_NAME: MSSQLSERUER
TYPE : 18 WIN32 ONN_PROCESS
STATE = 2 START_PEN
<{HOT STOPPHBLE HOT_PAUSABLE. IGHORES_SHUTDOWH>>
WIN32_EXIT_CODE 8 <8xa>
SERVICE_EXIT _CODE := B8 <{(Bx8>
GHECKPOINT = Bxa
WAIT_HINT = Bx7d8
: 2488

tient database wit
uration Tools—>EUWS cunflguratlon.

Wait until script is ready

Execute EWS configuration:
Click: Start = Philips = Configuration Tools - EWS Configuration:

On the configuration main panel:
Click: Execute...
Click Proceed

NOTE
When an error occurs, a second Execute... is required.
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When finished, click Exit (and Confirm) to exit the configuration application.

5.8 PRINTER CALIBRATION

5.8.1 Introduction

After the EWS printers are configured (Only after initial installation EWS), density calibration has to be done
for each printer.

Prerequisites:

All required printers and media should be configured in the Extended MR Workspace R2.6.3.1 configuration.
DICOM Printer is setup properly with respect to its configuration and calibration (this must be done by the
Printer engineer e.g. Kodak engineer).

Chemical composition of the developer must be correct.

Calibrated densitometer, which is operating correctly.

Light meter (Cd/m?) for ambient light measurement.

NOTE

Color printers can NOT be (color 'density’) calibrated within Extended MR Workspace R2.6.3.1.

5.8.1.1 Start Calibration Tool

Close Extended MR Workspace R2.6.3.1 application before starting the calibration
make sure the printer is switched on and is able to print
Go to the Start > Philips - Installation Tools = Printer Calibration.

The Printer calibration application is started.

5.8.2 Density Calibration procedure
e Click with the right mouse button on 'printer' and select the printer that you want to calibrate.

e Click on the 'Printer Gamma Correction' icon in the icon bar:

The Calibration window appears:
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Mada B 107G £ lm—.

W ®E m ® ™ ® W ® W W W & T W W W W W w0

ot Lemsinnce folbee7) | 200,000 Pefeched Ambient Lght (etnez) | 19,000 Sve | Uncalteaied fre | Venty et

e Atthe bottom of the screen the light box Luminance and Reflected Ambient light values are displayed.
Usually the defaults can be used when the light box is installed in a room with hardly no sunlight =
normal conditions.

When the light conditions differ from the normal conditions (e.g. when the light box is installed in a room
with a lot of sunlight) the light box Luminance and Reflected Ambient light measurements have to be
performed and entered at the bottom of the Printer Calibration screen.

¢ Click with the right mouse button on 'media’ and select the media that you want to calibrate.

e Click on the ‘Uncalibrated Print’ button. A calibration sheet will be printed with four identical images, as
shown below.
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e Choose one of the four images (e.g. left bottom image) and use a densitometer to measure the 16
densities from that image.

e Enter the 16 values in the row 'Measured densities', starting with the most ‘darkest’ value =B0. See
image below.

e Click on 'Save' to store the calibration.

e Select ‘Specific media’ or ‘All media’

NOTE

Receiving an error message after selecting ‘All media’ means that this calibration cannot be applied for all
media. In this case ‘Specific media’ must be chosen and the above steps must be repeated for all other
media types.

e Click on 'Save' to store and exit the panel.
5.8.2.1 Verification of the Density Calibration

You may verify the Printer Calibration results as follows:

e If not already done:

—  Click with the right mouse button on 'printer' and select the printer that you want to calibrate.
—  Start Printer Gamma Correction. See figure below:

e Click on ‘Verify Print’. Print Verify will print a verification print in 2x2 exactly as that printed by the
application.

e Measure the 16 densities from the same image on the film as used in the calibration procedure in
paragraph 1.2 (Do NOT enter any values!).
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NOTE

The measured values should be within 5% of the values of "target density" in the Printer Calibration tool. If
values are not within the limits, perform the calibration procedure again (be sure that the densitometer is
operating correctly and assure the chemical composition of the developer is correct).

e Click exit to close density calibration.

e Continue with paragraph 5.8.3.

5.8.3 Pixel size Calibration procedure

Prerequisites:
Calibrated metal ruler.

e Click with the right mouse button on 'printer' and select the printer that you want to calibrate.

e Click on the 'Printer Pixel Size' icon in the icon bar:

The 'Printer Pixel Size Calibration' panel will appear:

+*. Printer pixel size calibration

Media E} 14x17B_GE& [ calibrated
. |
Units Z| mm
Measured Target

[Uncalibrated] [Calibrated]
Length X (horizontal) | 100.00 | 100.00
Length ¥ (vertical) | 100.00 | 100.00
Resolution (dotsfunit) | 12.82
Save Media
[+ Specific (this medium only)
" All media with matching sizes and resolution
" All media with matching resolution

Save | Uncalibrated Print Venfy Prant

Exit |

e Click with the right mouse button on 'Media' and select the media that you want to calibrate.
e Click with the right mouse button on 'Units' and select the desired type.

e Click on 'Uncalibrated Print’. A calibration sheet will be printed, which looks like:
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e Measure the horizontal length (=X) and vertical length (=Y) on the film as accurately as possible with a
ruler. Enter the lengths in mm or inches in their respective fields. The field resolution displays the
number of pixels per mm or per inches.

e Select either 'Specific' or 'Matching Sizes' in the Save Media dialog box:
e Specific in which only the selected media will be calibrated;

e All Media with matching sizes and resolution

e All Media with matching resolution

e Click on 'Save'.

584 Verification of the Pixel Size Calibration

e Click on ‘Verify Print’. Print Verify will print a verification print in “true size”

e Measure the horizontal length (=X) and vertical length (=Y) on the film as accurately as possible with a
ruler.

o If the lengths meet the target values:

e Click on 'Exit' to leave the 'Printer Pixel Size' panel

e Click on the 'Exit" icon to leave the 'Printer’ calibration

e Click OK

e If lengths do NOT meet the target values:

¢ Repeat the procedure as described in chapter 1.3 until the pixel size calibration is correct

e If ‘Specific’ media was selected and / or another printer has to be calibrated: repeat the procedure from
chapter 1.2 and onwards for all other media.

e Exit Printer Calibration.
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5.9 DISASTER RECOVERY

59.1 Disaster scenario’s

Crash Of System-disk (C:\ drive). Refer to paragraph: 5.9.2 p. 153.
Crash Of Data-disk (D:\ drive). Refer to paragraph: 5.9.3 p. 153.

5.9.2 Recovery Scenario 1: Crash of system disk

In this case it is possible to restore the system with all settings (configuration and customization), and keep
the image database that was available.

Procedure:

e Replace or repair the System disk on the system.

e Re-install the system by restoring a Acronis Image (see section 5.7.4 Restore an Acronis Image p. 144)

When that is not feasible:

e Follow instructions Table 1, column “R2.6.3.1 to R2.6.3.1 Re-installation”, starting step 24.

5.9.3 Recovery Scenario 2: Crash of Data disk

In this case it is possible to restore the system with all settings (configuration and customization), but the
database with patient images is lost.

Procedure:
e Replace or repair the Data disk on the system.

e Login as MRService User

e Initialize and format new 2™ disk as described in section 3.3.10 p. 50 Initialize 2-nd Disk (step 33),
starting “Right-click Unallocated space”

e Run script, to (re) create Folders on the Data-partion:

Click: Start = Installation Tools - Re-create Backup partition RSI directories:
] Diagnostic Tools 4

(E Setrooram Access and Defauts & Change Hostame

L2 Windows Catalog () User Documentation EWS-MRI * =] Export EWS configuration

£ Enable Remote Access = Fixup Firewall Settings
g & Programs " 8 Exameards Offtine Editor 1 Import EWS conliguration
] < Documents * B Extended MR Workspace %) Import ViewForum Configuration
- Settings » 2] NetForum &) Inspect License File

f5) Install License File

3
L 51 Printer Calibration
J, Help and Support P Re-create Backup partition RSI directories
iR
4 (&) shutDown..
& Start

e Continue with section 5.7.4.1 p. 146, “Restore configuration data from System-patrtition to Data-
Partition”, to restore configuration data, saved during backup procedure 5.7.3 Create an Acronis Image
p. 141:

e Perform 4.3.1.1 Start EWS Configuration (VF) p. 76.
e Execute EWS Configuration (VF) p. 90 - failure, again
e Execute EWS Configuration (VF) p. 90.
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5.10 WINDOWS FAULTFINDING AND REPAIR

This chapter will mention some basic Windows Faultfinding and Repair tasks. For more administration
knowledge a Windows XP x64 course is preferred. For more information see also the windows help.

NOTE
For performing most actions in this chapter you have to be logged in with administrator privileges, like
MRService.
5.10.1 File System Error-Checking (Scandisk)

If you suspect damage to the file system or Harddisk (For instance after a crash of the Operating System),
using scandisk to detect and repair a faulty file system may be necessary. To invoke scandisk on a Disk
Partition:

e Go to windows Explorer

e Right click the partition to be checked, select “properties”

e Select the 'tools' tab

e Click 'Check now..."

e Select 'Automatically repair file system errors'

e Click 'Start'

o |If the selected drive is in still in use by the operating system, you may be asked to schedule the scan for
the next restart of the system. If this is asked, restart the system for the scan to execute.

e Wait for the scan to finish
e Exit Scan Disk

5.10.2 Disk Defragmentation

Degradation of system performance may be caused by disk fragmentation. Therefore it is advised to
defragment the file system (may be a 'quick fix') when performance problems are encountered.

Start > Programs > Accessories &> System Tools - Disk Defragmenter

Select a disk.

NOTE

Only defragment the disk with the windows installation and program files on it, defragmenting the image
database disk is not necessary.

Press Defragment

Close Computer Management window
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5.10.3 Windows Event logging

If you suspect damage to hardware (for instance when the CD/DVD drive is giving read errors when trying to
install software), use the Windows Event Viewer to detect what is the cause of the hardware failure. To start
the Windows Event Viewer:

e Goto start

e Right click on My Computer

e Select ‘Manage’

e Click 'Event Viewer'

e Select 'Application'

e Scan the list for ‘Error’ messages that appear frequently. Especially hardware and Extended MR
Workspace R2.6.3.1 software related error messages.

e Select ‘Security'
e Scan the list for strange Audit messages that might point to security vulnerability.
e Select 'System'

e Scan the list for ‘Error’ messages that appear frequently. Especially Extended MR Workspace R2.6.3.1
services related error messages.

e Exit Computer Management.

5.104 Driver Rollback

If a new hardware driver is installed which results in a malfunctioning of the system, the 'Driver Rollback’
functionality may be used to restore the previous (working) hardware driver.

e Click Start, right-click My Computer, and then click Properties.

In the Systems Properties sheet, click the Hardware tab and then click Device Manager.

In the Device Manager expand the device of which a Driver needs to be restored and press ENTER.

NOTE

If a yellow circle with a black exclamation point icon appears next to the device name, this means that the
device driver is not compatible with the actual device installed!

¢ Inthe Property sheet click the Driver tab and then click the Roll Back Driver button.

e A message displays, asking if you are sure you would like to roll back the previous driver.
e Click Yes.

e You will notice that the name of the display adapter will change back to the previous driver.
e Click Close.

e If you are prompted to restart the computer, click Yes.

e If you are not prompted to restart the computer, close all open windows and log off.
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5.10.5 Windows XP x64 restore Points

The Windows XP x64 operating system will by default monitor your hard drives, and create so-called
'Restore Points'. These restore points will enable you to restore a previous system configuration. In the case
of a malfunctioning system, going 'back’ to a restore point may quickly and easily solve your problem.

As a default, Windows XP x64 will automatically create a restore point every 24 hours. It will keep restore
points available for 90 days after they are created.

WARNING

Please be careful using system restore on the Image database disk. It may cause a loss of images in the
database.

5.10.5.1 Create a Restore Point

Windows XP x64 automatically creates system restore points, but you can create your own before making
major changes to the system as installing device drivers, windows updates or new programs. To create a
restore point:

e Click Start > Programs - Accessories = System Tools, and then click System Restore.
¢ Inthe System Restore dialog box, click Create a restore point, and then click Next.

e Type a description for your restore point, such as "Before Office XP", and then click Create.

5.10.5.2 Restoring a Restore point

If you encounter a system problem, you can restore a previous system state:

e Click Start > Programs - Accessories - System Tools, and then click System Restore.
¢ Inthe System Restore dialog box, click 'Restore my computer to an earlier time', and then click Next.

e The system will try to restore to an earlier point in time. After this action the system needs a reboot.

5.11 VP1000 DIAGNOSTIC TOOLS (OPTIONAL)
Installation:
Go to: The Unsupported directory of the ViewForum Application software DVD
Select: The file: VolumePro1000_Diagnostics.exe
Open: The file by double clicking
Go to: C:\Program Files\VolumePro1000\diagnostics
Check: If the file VpDiag.exe is present
Open: The Command tool (Run = type: cmd)
Run: VpDiag.exe
NOTE

With the VpDiag.exe the HW function of the VP1000 card are tested
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NOTE

During the installation also an entry is made: Start 2 VolumePro1000 - cvRReli. This Entry does NOT
work!

Available commands

The following is a list of available commands with a brief description of the command. Type "Help command"
for usage information for a given command:

ErrorMsg: Display the specified message and set the global error flag.
StatusMsg: Display the specified message.

RunTest: Run selected test.

RunAllTests: Run all test cases on all boards.

ListTests: Print a list of all tests.

RunScript:  Run selected script.

MemoryTest: Specify the condor memory test to be performed.
SelectDevice: Select device.

?.  Print this message.

Help: Print this message.

Quit: Quit program.

Exit: Exit program.

History: Command history controls.

SoftReset:  Perform soft reset.

HardReset: Perform hard reset.

ScriptEcho:  Set/reset script echo flag.

DisplayTime: Display the current data/time

5.12 COMMUNICATION WITH PHILIPS HEALTHCARE
5.12.1 Ordering procedure
For communication about orders and software licenses, please contact:
Dept.: MR Logistics
USA:
Marie Luce de Kuijer +31 40 27 65843
Tamara Chikovani
APAC:
Jan-Willem van de Mond +31 40 27 64323
EMEA:
Marianne Bronkhorst (DACH, France, +31 40 27 62514
Adria and UK&lI)
Kees Brugge (Iberia, Benelux) +31 40 27 62141
LATAM:
Kees Brugge +31 40 27 62141
Address: P.O. 10.000

5680 DA Best
The Netherlands

Building: QA-llI
E-mail: mr-orderdesk-usa@philips.com
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mr-orderdesk-apac@philips.com
mr-orderdesk-emea@philips.com
mr-orderdesk-mcr-latam@philips.com

In case of questions or problems, please contact the MR HELPDESK:
Address: Philips Healthcare

MR Helpdesk, Building QY1-1

P.O. Box 10000

5680 DA Best, The Netherlands

Telephone:  +31-402764777

Fax: +31-402762745
E-mail: mr.helpdesk@philips.com
5.12.2 FAQ Database and FPR view

Via Knova it is possible to search for more information about Known Bugs and/or details of Field Problem
Reports.

URL: http://pww.eureka.aai.ms.philips.com/KanisaSupportCenter/php/home.do
Select: Product: Magnetic Resonance

Document Types: Factory Tips

Search string: EWS

5.12.3 Problem Reporting

If a structural problem with the system arises which can be attributed to an error in the system, this problem
should be reported to the MR Helpdesk via:

e The “Customer Feedback Management System”, for North America ONLY (Philips Global Sales and
Service), using link https://cfwebportal.healthcare.philips.com

e A Field Problem Report via E-mail, for OTHER than Philips Global Sales and Service North America
e Use PRForm-2 available on the Intranet.

e URL: https://incenter.medical.philips.com/

e Click on “Field problem Reporting, FPR view”
e Fillin PRForm-2 including:

e Complete and detailed description of the problem.

e Relevant configuration information (computer type (Dell T5500/T7400/690/670).
SW-Release R2.6.3.1, presence of non-standard hardware e.g. Video board, System reference
number, SSD reference number, Hospital, Sender, City etc.)

To facilitate rapid processing of the Field Problem Report, the following items may be included:
e If an EWS performance problem needs to be analysed:
Enable the performance logging:
e Select: Start -> Philips -> Configuration Tools -> Set logging level
e Check: Performance log messages:
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Select meszage types to log

[ IMNFO log meszages

¥ Peformance log messages

Apply

Logging repository selection ... [II[EIES|

Cancel

Figure 5-6 Performance log messages

e Select: Apply

Restart the VF system monitor:

e Run: services.msc

e Select: ViewForum system monitor

e Select: Re

start
Services

File Action View Help
ERNE u LS

%y Senices (Local) [ Services (Local)

YiewForum system monitor

Stop the service
Restart the service

Name
%ViewForum License Manager

i Forum m monitar

ce Start

S \NC ServerYersion 4
&Y olume Shadow Copy Stop
4 WahClient Pause
8 Windows Audio Resume

8 \Windows FirewallInternet Co

Figure 5-7 Restart VF System Monitor service

Try to reproduce the performance issues and describe in detail what the actions are and
when the problem occurs, e.g. use screenshots to make clear where the problem occurs.
Write down the exact date and time the problem is visible so that it can be traced in the

lodfiles.

e Zipped (MR and VF) log files:

Preparation:
e Exit from the EWS application software and MRUser account

e Login:
VF logfiles:

MRService + password

e Select: Start > Diagnostic Tools - Logfiles > Archive VF logfiles
e Select: Browse and select the location to store the zipped log file (e.g. memory stick)
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- Archivelog... M=l E1
Select types of log files ta archive

¥ Application log filss

¥ DICOM log fles

Browse | Cancel |

MR Logfiles:
Start WXP Explorer

e Version Check Report:

Select destination for Log file archive file

Savein | <= System [C:]

. backup_ews_configuration
J backup_ews_configuration old
dell
') Documents and Settings
metad
nrnr
') Prograrn Files
') Prograrm Files (#86)

RECYCLER

Systermn Yolume Information
‘) Temp
) WIMDIOWS

File: namne:

Save as type: |Zip archive file [*.zip)

HE
CHE
j Save
j Cancel

Figure 5-8 Archive VF-logfies

Browse to: D:\log folder

Select the MR logfiles you want to compress
R-mouse click and select: Send To -> Compressed (zipped) Folder
Rename the zipped file to: MR_logs.zip
Copy the zipped file onto memory stick

e On the Computer Desktop:
Double-click on the About icon.

e A Version Check Report will open in an IE window
e Select: File -> Save As and browse again to the memory stick to save this report

e Screen shots if needed:

e Press <Print Screen> button
e Start Microsoft Paint application.
e Press <Ctrl> <V> to paste screenshot
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Screen shots if needed

* Press<=Print Screen=button
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|For Help, click Help Topics on the Help Menu. A

Click Edit >Copy to...
Enter filename

Select Save as type: 256 Color Bitmap (*.bmp;*.dib)
Click: Save
Encrypted zipped patient cases (in DICOM format)

A copy of the configuration files (see section 4.2.1 p. 69)

If relevant: films, CD-Recordables, drawings on paper, etc.

- Browse to USB memory stick

e Startup the

If an EWS performance problem was analysed:
e Restore the Performance logging setting to the unchecked setting:

Logging repository selection ... [ i=1E3

Select message types to Logging reposito

™ INFO log messages

[™ Performance log messages

Apply | Cancel |

EWS Application software.
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6 REFERENCE SHEETS

Hospital Network

Proxy Server, IP-address and
portnumber )
DNS-suffix
Administrator password or Passwordl
MRService ViewForuml
Remote ViewForuml
MRUser MRUser
HospitalAdmin ViewAdminl
administrator password Can be used to create customized users
MRUser MRUser m:;e password equal to MRUser on MR-
Computer name phewsxxx
Speed/Duplex, onboard NIC Auto
IP Address, onboard NIC Automatically obtained
Subnet, onboard NIC 255.255.255.0
Default Gateway, onboard NIC | Automatically obtained
DNS-server 1, onboard NIC Automatically obtained
DNS-server 2, onboard NIC Automatically obtained
IP Address, 2" NIC Automatically obtained 192.168.73.11
(Direct Link)
Country/Region -
Time zone
EWS R2.6.3.1 system name EWS1
MAC address -
IP node name EWS1
IP address 127.0.0.1 127.0.0.1
Application entity title EWS1
Monitor type -
Image Database
Image database name Database on EWS1
Free space 1000 MB
Space to use -
Peripheral settings
DVD Recordable drive DVD Recordable on EWS1
DVD Reader drive CD/DVD Rom on EWS1
DICOM Printer
Paper r|nter
Try&Buy license Expire date
Radiology Reporting
MR Cardio Specialist
Coro 3D
Merge View
Premium perf. option

! Factory Image installed EWS

<<Important>> For Security and Intellectual Property reasons, file this sheet in a secure place. <<Important>>
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............................................................................................................................................................................................................................................................................................... Hand-Over Checklist
- JoK?2» [ [Remarks ]

Introduction
Complete Delivery ?
DELL Service Transfer

Installation

Hardware Installation OK
Voltage adapted to local?
System start-up normal?

Refer to Reference Sheet from SIM

Setting to work

» Monitor Calibration
* Printer Calibration
Printer 1:

Printer 2:

Printer 3:

Printer 4:

Printer 5:

» IDCC Calibration
* Remote Support

» Backup

» Network Topology

Handover Procedure
» Completeness

» Power On/Off

* Data Management
 Customization

* Applications

» Network Communication
* Printing

» Maintenance Menu

* Training/Support

* Remote Support

<<Important>> For Security and Intellectual Property reasons, file this sheet in a secure place. <<Important>>
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